S-Version

32-bit version for
Windows 98
Windows NT V4
Windows 2000

Including
Soundcard Driver and Analysis Toolkit
Option

Book 1:
User Guide
License Agreement

By opening the sealed license envelope, you are agreeing to the following license:

NATIONAL INSTRUMENTS grants you a non-exclusive license to use this Software on one computer at a time. You do not obtain title to the Software or any copyrights or proprietary rights in the Licensed Software. You may not transfer, sub-license, rent, lease, convey, copy, modify, translate, convert to another programming language, decompile or disassemble the Licensed Software for any purpose, except as expressly provided for in this license. You may not copy the Documentation. You may copy the Licensed Software for backup purposes only, in support of your use of the Software in accordance with the terms and conditions of this license.

NATIONAL INSTRUMENTS warrant, for a period of ninety days after your receipt of the product, 1) the disks on which the Software is distributed to be free from defects in materials and workmanship, and 2) that the software will perform substantially in accordance with the Documentation. If the product fails to comply with the warranty set forth above, NATIONAL INSTRUMENTS entire liability and your exclusive remedy will be replacement of the disks or NATIONAL INSTRUMENTS reasonable effort to make the product meet the warranty set forth above. If NATIONAL INSTRUMENTS is unable to make the Product conform to the above warranty, then you may return the complete package to NATIONAL INSTRUMENTS or its dealer, and NATIONAL INSTRUMENTS, at its option, may refund all or a fair portion of the price you paid for this package.

Although NATIONAL INSTRUMENTS has tested the Software and reviewed the Documentation, NATIONAL INSTRUMENTS MAKE NO WARRANTY OR REPRESENTATION, EITHER EXPRESS OR IMPLIED, WITH RESPECT TO THIS SOFTWARE OR DOCUMENTATION, THEIR QUALITY, PERFORMANCE, MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. AS A RESULT, THIS SOFTWARE AND DOCUMENTATION ARE LICENSED “AS IS,” AND YOU, THE LICENSEE, ARE ASSUMING THE ENTIRE RISK AS TO THEIR QUALITY AND PERFORMANCE.

IN NO EVENT WILL NATIONAL INSTRUMENTS BE LIABLE FOR DIRECT, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE OR DOCUMENTATION, even if advised of the possibility of such damages. In particular, NATIONAL INSTRUMENTS shall have no liability for any programs or data stored or used with the Software, including the costs of recovering such programs or data.

DASYLab® is a trademark of the NATIONAL INSTRUMENTS SERVICES GmbH & Co. KG.

Copyright © 1993-2001 by National Instruments Services GmbH. All rights reserved.

National Instruments Services GmbH & Co. KG
Postfach 401264,
D - 41182 Mönchengladbach, Germany

The DASYLab® software and information in this document are subject to change without notice.
Year 2000 Compliance Statement

DASYLab 6.0 is Year-2000-compliant. It conforms to the British Standards Institution BSI DISC PD-2000-1 'A Definition of Year 2000 Conformity Requirements' document. Specifically, DASYLab will:

- Work correctly for the following the transition from December 31, 1999 to January 1, 2000
- Recognize that 2000 is a leap year;
- Work correctly for all dates in the range January 1, 1980 through December 31, 2037, but not before, and not after
- Read and store dates correctly using its private (.DDF) data format, and store appropriately for other date formats
Warning:

(1) National Instruments products are not designed with components and testing for a level of reliability suitable for use in or in connection with surgical implants or as critical components in any life support systems whose failure to perform can reasonably be expected to cause significant injury to a human.

(2) In any application, including the above, reliability of operation of the software products can be impaired by adverse factors, including but not limited to fluctuations in electrical power supply, computer hardware malfunctions, computer operating system software fitness, fitness of compilers and development software used to develop an application, installation errors, software and hardware compatibility problems, malfunctions or failures of electronic monitoring or control devices, transient failures of electronic systems (hardware and/or software), unanticipated uses or misuses, or errors on the part of the user or applications designer (adverse factors such as these are hereafter collectively termed "system failures").

Any application where a system failure would create a risk of harm to property or persons (including the risk of bodily injury and death) should not be reliant solely upon one form of electronic system due to the risk of system failure.

To avoid damage, injury, or death, the user or application designer must take reasonably prudent steps to protect against system failures, including but not limited to back-up or shut down mechanisms.

Because each end-user system is customized and differs from NATIONAL INSTRUMENTS' testing platforms and because a user or application designer may use NATIONAL INSTRUMENTS products in combination with other products in a manner not evaluated or contemplated by NATIONAL INSTRUMENTS, the user or application designer is ultimately responsible for verifying and validating the suitability of NATIONAL INSTRUMENTS products whenever NATIONAL INSTRUMENTS products are incorporated in a system or application, including, without limitation, the appropriate design, process and safety level of such system or application.
## Contents

**BOOK 1: USER GUIDE**

- License Agreement i
- Year 2000 Compliance Statement ii
- Risky Applications iii

### CHAPTER 1: INTRODUCTION

1. Welcome to DASYLab! 1-1
2. About your DASYLab Documentation 1-2
   1.1. What's Included 2-2
   1.2. Contents 2-3
   1.3. Typographic Conventions 2-4
3. What is DASYLab? 1-5
4. Installation 1-9
   3.1. System Requirements 1-9
   3.2. Setting Up DASYLab 1-10
   3.3. Hints for PC Hardware Configuration 1-12
5. DASYLab Versions 1-13
6. New in DASYLab Version 6.0 1-16
   5.1. Packaging 1-16
   5.2. General 1-16
   5.3. New Modules 1-18
   5.4. New Add-On Modules 1-19
   5.5. New Actions 1-19
   5.6. New Global Variables 1-19
   5.7. New Global Strings 1-19
   5.8. Module Changes 1-20

### CHAPTER 2: GETTING STARTED

1. Basic Techniques 2-1
2. Starting DASYLab 2-4
   2.1. Starting DASYLab with a New Worksheet 2-4
   2.2. Starting DASYLab with an existing Worksheet 2-4
3. Experiment Setup and Time Bases 2-5
4. Using the DASYLab Help System 2-5
5. Creating your First DASYLab Worksheet 2-6

### CHAPTER 3: CREATING AN EXPERIMENT SETUP

1. The Elements of a Worksheet 3-1
   1.1. Modules 3-1
   1.2. Data Channels, Junction Points 3-3
2. The DASYLab Screen 3-8
   2.1. The Worksheet Window 3-8
   2.2. The Display Tree View 3-11
   2.3. The Control Sequencer Window 3-12
   2.4. The Layout Window 3-15
| 2.5.  | VITool Toolbox                                      | 3-18 |
| 2.6.  | Title Bar                                           | 3-19 |
| 2.7.  | Menu Bar                                            | 3-19 |
| 2.8.  | Module Bar                                          | 3-21 |
| 2.9.  | Function Bar                                        | 3-22 |
| 2.10. | Status Bar                                          | 3-25 |
| 2.11. | Display Windows                                     | 3-25 |
| 3.    | Module Groups Overview                              | 3-27 |

CHAPTER 4: MAIN MENU

| 1.    | Worksheet Window Menu                               | 4-1  |
| 1.1.  | File Menu                                           | 4-1  |
| 1.2.  | Edit Menu                                           | 4-9  |
| 1.3.  | Module Menu                                         | 4-17 |
| 1.4.  | Experiment Menu                                     | 4-22 |
| 1.5.  | View Menu Commands                                  | 4-36 |
| 1.6.  | Options Menu                                        | 4-42 |
| 1.7.  | Window Menu                                         | 4-63 |
| 2.    | Control Sequencer Menus                             | 4-64 |
| 2.1.  | File Menu                                           | 4-65 |
| 2.2.  | Edit Menu                                           | 4-68 |
| 2.3.  | Experiment Menu                                     | 4-68 |
| 2.4.  | View Menu                                           | 4-68 |
| 2.5.  | Options Menu                                        | 4-68 |
| 3.    | Tree View Menus                                     | 4-68 |
| 3.1.  | File Menu                                           | 4-68 |
| 3.2.  | Edit Menu                                           | 4-68 |
| 3.3.  | Experiment Menu                                     | 4-68 |
| 3.4.  | View Menu                                           | 4-68 |
| 3.5.  | Options Menu                                        | 4-68 |
| 3.6.  | Window Menu                                         | 4-69 |
| 4.    | Layout Window Menus                                  | 4-69 |
| 4.1.  | File Menu                                           | 4-69 |
| 4.2.  | Edit Menu                                           | 4-70 |
| 4.3.  | Object Menu                                         | 4-72 |
| 4.4.  | Experiment Menu                                     | 4-77 |
| 4.5.  | View Menu                                           | 4-77 |
| 4.6.  | Options Menu                                        | 4-78 |
| 4.7.  | Window Menu                                         | 4-80 |
| 5.    | Help Menu                                           | 4-80 |
| 5.1.  | Index                                               | 4-80 |
| 5.2.  | Hardware                                            | 4-82 |
| 5.3.  | Glossary                                            | 4-82 |
| 5.4.  | Using Help                                          | 4-82 |
| 5.5.  | System Information…                                 | 4-82 |
| 5.6.  | About DASYLab…                                      | 4-82 |
6. Customizing the Main Menu: External Programs

### CHAPTER 5: FILES AND FILE FORMATS / DDE / NETWORK

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Files and File Formats</td>
<td>5-1</td>
</tr>
<tr>
<td>1.1</td>
<td>Worksheet Files (.DSB)</td>
<td>5-1</td>
</tr>
<tr>
<td>1.2</td>
<td>Control Sequencer Files (*.DSQ)</td>
<td>5-2</td>
</tr>
<tr>
<td>1.3</td>
<td>Module Bar Files (.DML)</td>
<td>5-2</td>
</tr>
<tr>
<td>1.4</td>
<td>Layout File (.LAY)</td>
<td>5-3</td>
</tr>
<tr>
<td>1.5</td>
<td>Serial Port Settings (.SIN/.SOU)</td>
<td>5-3</td>
</tr>
<tr>
<td>1.6</td>
<td>Initialization File (DASYLAB.INI)</td>
<td>5-3</td>
</tr>
<tr>
<td>1.7</td>
<td>Files with Reference Points (.DPF)</td>
<td>5-3</td>
</tr>
<tr>
<td>1.8</td>
<td>Data Files</td>
<td>5-4</td>
</tr>
<tr>
<td>1.9</td>
<td>DASYLab Data Format (.DDF/.DDB)</td>
<td>5-5</td>
</tr>
<tr>
<td>1.10</td>
<td>Vector File (*.VEC)</td>
<td>5-10</td>
</tr>
<tr>
<td>1.11</td>
<td>FGEN File (*.TXT)</td>
<td>5-10</td>
</tr>
<tr>
<td>2</td>
<td>DASYLab-Net: Communication with Other DASYLab Programs</td>
<td>5-11</td>
</tr>
<tr>
<td>2.1</td>
<td>TCP/IP Network Protocol</td>
<td>5-12</td>
</tr>
<tr>
<td>2.2</td>
<td>Bibliography</td>
<td>5-13</td>
</tr>
<tr>
<td>3</td>
<td>DDE: Communication with Other Applications</td>
<td>5-13</td>
</tr>
<tr>
<td>3.1</td>
<td>DASYLab as DDE Input</td>
<td>5-14</td>
</tr>
</tbody>
</table>

### CHAPTER 6: TIPS & TRICKS

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Demo Worksheets</td>
<td>6-1</td>
</tr>
<tr>
<td>2</td>
<td>DASYLab by Keyboard</td>
<td>6-1</td>
</tr>
<tr>
<td>3</td>
<td>DASYLab Hotkeys</td>
<td>6-2</td>
</tr>
<tr>
<td>4</td>
<td>How to Start and Stop an Experiment</td>
<td>6-2</td>
</tr>
<tr>
<td>4.1</td>
<td>Start/Stop/Pause/Resume an Experiment</td>
<td>6-3</td>
</tr>
<tr>
<td>4.2</td>
<td>Controlling an Experiment Manually</td>
<td>6-3</td>
</tr>
<tr>
<td>4.3</td>
<td>Automatic Program/Experiment Start</td>
<td>6-3</td>
</tr>
<tr>
<td>5</td>
<td>Exchanging Worksheets</td>
<td>6-6</td>
</tr>
<tr>
<td>6</td>
<td>Display Company Logo</td>
<td>6-7</td>
</tr>
</tbody>
</table>

### APPENDICES

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>What’s Included in Your DASYLab Package</td>
<td>A-1</td>
</tr>
<tr>
<td>B</td>
<td>Internal Data Flow and Precision Information</td>
<td>B-1</td>
</tr>
<tr>
<td>C</td>
<td>ASCII Table</td>
<td>C-1</td>
</tr>
<tr>
<td>D</td>
<td>Error Messages and Troubleshooting</td>
<td>D-1</td>
</tr>
<tr>
<td>E</td>
<td>Product Support</td>
<td>E-1</td>
</tr>
</tbody>
</table>

### INDEX
Chapter 1: Introduction

1. Welcome to DASYLab!

You have acquired an easy to use software product that provides an enormous range of functions and options for your data acquisition tasks. Install this electronic laboratory on your computer and start experimenting; you will quickly discover many of DASYLab’s powerful features.

Use DASYLab’s Online Help system to display information about the operation that you are about to carry out on the screen. It may be unnecessary for you to thoroughly study this printed manual.

If you are new to DASYLab, we recommend that you read through the Step-by-Step Instructions in the online Help system, or read this introductory chapter plus Chapters 2 and 3. You will then know enough to start off with DASYLab on your own.

If you have upgraded from a previous version of DASYLab, please review Chapter 1 – Section 6 for information about new and changed features.

Later, this User Guide can help you find your way through DASYLab even when you are not at your computer. It can serve as a reference book and it will provide background information that might seem out of place in the immediacy of the online Help system.

The NATIONAL INSTRUMENTS team will continue to develop DASYLab as software that matches its users’ requirements and preferences.

NATIONAL INSTRUMENTS SERVICES GmbH
Postfach 401264
D-41182 Mönchengladbach
Germany
2. About your DASYLab Documentation

2.1. What’s Included

The DASYLab documentation consists of the following:

- The context-sensitive online Help system provides quick on-screen reference to procedures and commands you may need while working with DASYLab. In addition, hardware help is provided to describe the installation, setup, and use of your specific data acquisition device.
- This printed User Guide contains a comprehensive description of all of DASYLab’s functions and their uses. It serves as a reference book, providing background information.
- The Hardware Information Manual provides a description of the interface between the data acquisition hardware and DASYLab. This manual may not be provided with all packages. If not, review the README file and any hardware specific online help that is installed.
- README.rtf, an information file that is copied to your hard disk when you set up DASYLab, provides information that was updated after this User Guide was printed. You can easily read (or print) this file using Windows Write.

We strongly recommend that you read the README file before you start working with the software.
2.2. Contents

The DASYLab User Guide is divided into the following parts:

Chapter 1: A general introduction to the software. It explains the basic concepts and provides setup information. It includes an overview of the new features and changes in this version.

Chapter 2: Operating fundamentals. This chapter explains the skills you need to work with DASYLab, how you start the program, and how you can use the online Help system. You can then follow a tutorial.

Chapter 3: A systematic survey of the elements you will use when working with DASYLab.

Chapter 4: A description of all of DASYLab menu commands and functions (except those from the Module menu). The chapter’s structure corresponds to the DASYLab menu system.

Chapter 5: Background information about file formats and data exchange between Windows applications.

Chapter 6: Additional hints and background information structured along particular tasks or problems that may arise during your work with DASYLab.

Appendices: Lists of program specifications and error messages, a glossary, the License Agreement and a comprehensive Index of Topics covering Chapters 1 to 7.

Please do not forget to register online at www.dasylab.net or www.dasylab.de, or, send us your Registration Card.

The DASYLab Module Reference Guide includes detailed descriptions for each module.

The optional Hardware Information Manual contains a description of your device with information concerning setup and operation with DASYLab.
2.3. Typographic Conventions

We have used visual cues and standard text formats in this User Guide to help you locate and interpret information easily.

Text Formats

File names and directory names are printed in ALL CAPITALS.

All references to menus, menu commands and to the options available in dialog boxes are printed in this sans serif typeface.

All references to keyboard keys and command entries are printed in this text format. These are usually commands that you must type at the DOS Prompt or in DASYLab or Windows text boxes exactly as you find them printed in this manual. It does not matter whether you type upper or lowercase letters.

Keyboard Formats

Key combinations and key sequences:

- \texttt{KEY1+KEY2} means to press and hold down the first key while you press the second.

- \texttt{KEY1, KEY2} means to press and release the keys one at a time.

Symbols

We have used the following symbols throughout this User’s Guide to identify important information to guide you to information on a related topic:

\begin{itemize}
    \item \textbf{Serious Warning!} Neglecting the hints indicated by this symbol may result in severe program errors or even damage to your hardware.
    \item \textbf{Warning.} Neglecting the hints indicated by this symbol may result in DASYLab not operating properly; data may be misinterpreted or not calculated correctly. This symbol will remind you to check that parameters are set correctly, or to check settings that must match.
    \item \textbf{When you have read a passage about a subject, this symbol may indicate that explanations on a related subject can be obtained elsewhere in this User Guide, or that similar commands, options, etc. might be of interest in the current context.}
\end{itemize}
3. **What is DASYLab?**

**Data Acquisition and Analysis under Windows**

DASYLab is a data acquisition, process control, and analysis system which takes full advantage of the features and the graphical interface provided by Microsoft® Windows™.

The most important design requirements for DASYLab were the integration of the important measuring and control devices on the market, a truly intuitive operating environment which offers extensive help functions, a maximum signal processing speed, and the most effective graphical display of results.

**Intuitive Operation**

Using DASYLab, a measuring, process control, or simulation task can be set up directly on your screen by selecting and connecting modular elements that can then be freely arranged. Even highly specialized tasks can be solved immediately on the screen, interactively and without difficulty. It is no longer necessary to find your way through lengthy and rigid menu structures.

**Large Variety of Measuring, Control, and Analysis Functions**

Among the module functions provided are A/D and D/A converters, Pre/Post and Start/Stop Triggers, digital I/O, mathematical functions from fundamental arithmetic to integral and differential calculus, statistics, digital filters of several types, frequency analysis including various evaluation windows, signal generators for simulation purposes, scopes for the graphic display of results, logical connectors like AND, OR, NOR, etc., counters, a chart recorder, file I/O, timer, digital display, bar graph, analog meter and more.

**Measuring Technology under Windows**

With DASYLab it is now possible to achieve high signal input/output rates using the full power of the PC. Special buffers with large, selectable, memory address ranges enable continuous data transfer from the data acquisition device through to the software. DASYLab uses extremely sophisticated drivers to obtain real-time logging at a rate of up to 800 kHz and real-time on-screen signal display at a rate of up to 70 kHz (depending on the type of data acquisition device and graphics board installed).

**Flexible Worksheet Setup**

In spite of its complexity and high performance, DASYLab can be used easily. The worksheet displayed on screen can be edited at any time. New modules can be inserted; others can be moved to a different position or deleted altogether. Dialog boxes prompt for all the necessary parameters to be set for an experiment.
Use the Black Box module to take combinations of worksheet elements repeatedly required in your experiments, and integrate them into a Black Box module, which you can then insert into worksheets as ready-to-use units. This will save you time and simplify your worksheets.

**Integrated Autorouter Utility**

While you are connecting the module inputs and outputs using the mouse, these connections are displayed as direct lines, but as soon as the mouse button is released the integrated autorouter optimizes all these connections. This prevents data channel lines being drawn through or behind existing module symbols or too close to other lines.

In the same way, the integrated autorouter rearranges the display whenever a module symbol has been moved. It thus creates a readable worksheet diagram ready for documentation purposes.

**Ample Resources**

The maximum worksheet size is 2000 by 2000 pixels, and a worksheet can contain up to 256 modules. For most modules up to 16 inputs and/or outputs can be configured.

The virtual working area at the user’s disposal is much larger than what can actually be presented in the active window on screen. When dealing with more extensive applications, where the complete arrangement of module symbols will not fit on the screen, you can scroll through the screen window vertically and horizontally. In addition, an overview command, several tagging functions, and the ability to hide the worksheet diagram help you to keep track of the setup and experiment.

**Function Bar and Module Bar**

Icon bars that provide commands and functions that might be repeatedly required when experiments are set up and carried out enhance DASYLab’s user-friendliness considerably.

You can define the Module Bar on the left of the screen to reflect your preferences. You can assign module functions that you need most often in your individual tasks to the buttons on the Module Bar. Once configured, these settings can be saved and reused for other worksheets or experiments. Various configurations adapted to the individual requirements of different tasks are easily reused.
Display of Results

Readings can be displayed graphically or numerically using specially assigned modules. This can be done effectively by making use of scope modules. Each one provides a resizable window in which data from several channels can be displayed; a system of suitable coordinates (linear, logarithmic, polar, waterfall), and different color codes (for multiple signals) can be selected.

Scaleable analog instruments, bar graphs and LED indicators are especially helpful when it comes to process control and testing. As these elements can be freely placed and combined, all the instruments necessary for any process can be integrated completely.

Storing the Setup

The complete experiment setup, including all the currently selected parameters, window positions, and additional information can be saved to a file and opened again later. Multiple ready-to-use standard setups for different tasks can be developed. The corresponding data acquisition process itself can even be started automatically at a specified time, when your computer restarts or when Windows starts.

Storing Data and Data Exchange

The acquired data and process results can also be saved to files so that they can be retrieved for further processing at a later time. They can be analyzed in detail, or used for simulation and training.

Use DDE (Dynamic Data Exchange) to transfer data directly to other Windows applications supporting the DDE protocol. For example: Excel and applications with DDE capabilities may be used to start DASYLab and control it while running an experiment.

Process Control Applications

External systems can be controlled by employing appropriate modules for digital I/O or D/A conversion. DASYLab provides a wide range of powerful modules for binary operations (AND / OR / NOT etc.), counters, and PID control functions.

Precise time-related process control operations depending on complex signals can be realized with DASYLab. Output frequencies, slopes, duration, dependencies on certain input source conditions, etc., can be determined for several channels by the user.

Simulation – for Testing and Training Purposes

Pure simulations, even without a data acquisition device, offer excellent opportunities to test measuring or process control experiments that have been developed on the PC. In these cases, a signal generator module, or several of them, is substituted for the measuring device. By combining signal generator modules
with mathematical modules, complex stimuli can be generated. For example, a sine or rectangle signal might be overlaid by a noise signal or by further sine, rectangle, or saw tooth signals. Even signals that have previously been saved to files may be retrieved and used again as stimuli using the file I/O module.

You can use DASYLab in training courses, as trainees can directly observe the effects and results of data acquisition and process control systems.

**Publication**

All the resources provided by Windows are at your disposal for publication purposes. Not only the measured results, but also the entire experiment setup can be published comprehensively and professionally. DASYLab can supply the worksheet diagram itself, or the graphic display of the measuring results, directly to Windows WordPad, Microsoft Word, or PageMaker. DASYLab provides integrated publishing tools to print the worksheet, graphic or numerical data displays, captions and explanatory text passages.

**Custom Functions**

As a service to customers who have to cope with highly specialized tasks, NATIONAL INSTRUMENTS SERVICES will develop custom function modules and other software modifications on request to meet individual demands. For instance, specified mathematical operations or options concerning the graphic presentation can be implemented or modified as required, and further data exchange interfaces can also be supplied.

An Extensions Tool Kit is available for experienced C programmers who wish to design their own modules. Contact your dealer for more information.

**Integrated Help System**

In most situations, it is not necessary to refer to the complete manual, since almost any problem can be solved using the online help system.

The context-sensitive help system provides the user with detailed instruction on hardware settings and software options, and it also supplies background information on measuring technology topics like FFT/spectral analysis.

**Conclusions**

In combination with one of the established PC measuring and process control devices, the DASYLab system is a powerful tool for data acquisition, process control and simulation.
4. Installation

4.1. System Requirements

DASYLab works with most personal computers available today. The minimum software and hardware requirements your PC needs to run DASYLab successfully are listed below. To get the best performance from the software, especially when more than one Windows applications is to be run, we recommend additional hardware resources.

Minimum Requirements

- A personal computer with a Pentium class processor, a standard keyboard, a mouse or similar pointing device
- 64 MB memory (RAM) for Windows 98, 128 MB for NT/2000
- 40 MB of free hard disk space
- CD-ROM Drive for installation or a 3.5 inch diskette drive
- A monitor and a VGA display adapter, 1024 x 768 resolution
- Windows 98 or Windows NT/2000 (Windows 3.x is not supported by this version of the software)

Recommended Configuration

- Pentium II class or better PC
- Additional memory (RAM) (the amount of memory determines the display capability of the Chart Recorder and Y/t Chart modules)
- Hard drive space to install optional components, such as DataSockets
- High resolution color monitor
- Super VGA display adapter supported by Windows
- Software, keyboard, mouse, hard disk, CD-ROM drive, and interfaces as described above
- Serial interface (RS232)

All printers and plotters supported by Windows can be used with DASYLab. No data acquisition hardware is required to run DASYLab. To acquire input or output analog signals one of the A/D or D/A devices that are supported by DASYLab must be installed. Please refer to the Hardware Installation Manual or the online help for details about the installation of your hardware.
4.2. Setting Up DASYLab

Preparations
1. Make sure that your DASYLab package is complete. In addition to this printed document, it should contain a CD-ROM disk, the Reference Manual, optionally, the Hardware Installation Manual, and the registration card.

2. Review the Software license. Note that DASYLab is licensed for use on a single computer, unless you have specifically purchased a multiple user license.

3. Make sure that there is at least 40 MB of free space on the hard disk where you are installing DASYLab.

4. You must be running Windows. DASYLab will not install from the DOS prompt.

5. Insert the CD-ROM into your CD-ROM drive.

If you received the CD-ROM as the installation media, and your computer does not have a CD-ROM drive, you can use another computer (with a CD-ROM drive and a diskette drive) to make diskettes. Insert the CD-ROM, and follow the installation/make diskettes prompts. You will need blank, formatted 3½” diskettes.

Starting the CD-ROM Installation
1. Insert the CD-ROM disk into your drive.
   1a. If your system supports Autostart, the CD menu will appear.
   1b. If your system does not support Autostart, run START.EXE

2. Choose your language, English (Continue) or German.

3. The CD menu will offer you several choices. In addition to installation, you can review the product specifications, view a short tutorial, or run the demo version of the program.

4. Select Installation

5. Choose the version of the software to install (full)

6. Select Install to run Setup.

Starting the Diskette Installation
1. Open the Control Panel.

2. Select Add/Delete Programs, and click Install to start the wizard.

3. Windows will search for the installation diskette. Select Finish to start the DASYLab installation program.
Setup Summary

The installation program will ...

... Give you the choice of standard or custom install. If reinstalling, you will be able to modify, repair, or remove the software. For most customers, the standard installation is appropriate. Custom install gives you the ability to add or remove standard components, such as optional drivers.

... Ask for the serial number which was provided for a new or upgraded installation (use your current number to re-install)

... Give you the opportunity to specify the directory and other installation options

... Allow you to specify the data acquisition driver to install.

... Check if the specified directory exists, and create it if necessary.

... Check if there is enough free space on your hard disk. If not, you will be asked to enter another drive or to cancel setup.

... Copy all the DASYLab program files to the drive and directory.

... Create a DASYLab program group in the Windows Program Manager. If the group already exists, it will be opened.

... Create various program items within that group.

... Add the appropriate hardware driver command lines to the [386Enh] section of the SYSTEM.INI file if you specified a DASYLab driver with a virtual device driver (Windows 98)

... Add appropriate items to the Windows Registry

... Optionally, install DataSocket Client and Server software

Completing Setup

If your data acquisition device does not require a virtual device driver, you can exit the installation procedure and use DASYLab immediately.

If you have installed a DASYLab version that includes a virtual device driver, Windows may need to be restarted so that the changes made to your system can take effect.

If you choose Exit Installation to use your original Windows configuration, DASYLab is ready to be used, but can only access any newly installed device drivers (if required) after you exit Windows and restart it. If you choose Restart Windows, the program will exit Windows completely and restart it.

With some data acquisition devices it may be necessary to modify the configuration of Windows. Please refer to the documentation that comes with your hardware, or to the Software Installation section pertaining to your hardware in the Hardware Installation Manual.
4.3. Hints for PC Hardware Configuration

PC’s used for data acquisition systems must fulfill other requirements than computers used as office systems or for games.

This means there are different considerations when installing a measurement system. The following hints will help if your PC hardware has hardware problems. Often these problems are related to the following components or functions:

- **Power Management**
  The Power Management System of some PCs sometimes obstructs the measurement. Please completely disable the Power Management option in the PC BIOS. You may also have to disable the "Support of Advanced Power Management" in System/Device Manager/Hardware Components.

- **Windows Time Zone Settings**
  Please disable the Time Zone property "Automatically adjust clock for daylight savings changes" in the Window’s Date/Time Properties. If DASYLab is running when the operating system changes the clock time, it pauses until the user clicks on the Dialog Box to acknowledge the change. In addition DASYLab will not have the correct start time for the Experiment. DASYLab only checks the PC clock time at experiment start.

- **Graphic Card Drivers**
  New drivers from some Graphics Card manufacturers are often optimized for maximum speed (e.g. to reach high performance in PC games). The driver overrides and obstructs the measurement running in the background. When in doubt, do not use the driver of the card manufacturer but use the original Standard VGA or SuperVGA driver shipped with Windows by Microsoft. Sometimes, there is a newer driver available from your graphics card manufacturer that fixes problems. Please check with your manufacturer for the latest drivers.

- **Printers**
  Several printer drivers may disturb the data acquisition. If you experience any problems, use a printer that is supported by the original Standard Printer Driver of Microsoft. Often these standard drivers support a complete family of drivers. For example, you can control the HP LaserJet family with the 'HP LaserJet Series II' driver from Microsoft.

- **Resource Conflicts**
  Please pay attention to resource conflicts between the hardware components of your PC. Often the data acquisition hardware uses the same IRQ or DMA addresses as Sound Cards, Network adapters and other devices. In case of doubt, remove the Sound Card from your
system or, if it is fixed in a notebook, disable it in the BIOS. Simply removing the driver (!) in Windows 98 will not solve the problem.

5. DASYLab Versions

DASYLab V6.0 is available in several versions. The table below lists the features available with each version. Please contact your dealer or distributor for more information about DASYLab.

This User Guide includes information about optional features. To determine which version you have, select About DASYLab from the Help Menu and click on the Options button.

Optional features may vary by country. Check with your dealer or distributor for details.

The DASYLab Limited, LE or Lite version provides only the most basic functions of DASYLab and is limited to 32 Analog Input channels (1 main board, 1 extension or expansion board) and a maximum of 64 data channels. One VITool Layout Window is allowed. Add-On modules and optional features, such as the Sequence Generator and the Microstar DAP Power DLL are not available with this version.

The DASYLab Basic version has all of the properties of the Full version, and includes a full set of modules for data acquisition and processing, although some modules or groups of modules are not available. One VITool Layout Window is allowed. The Analysis Toolkit and optional features, such as the Sequence Generator are not available with this version. The Driver and Extension toolkits are supported.

The DASYLab Full version gives you all functionality of this easy to use software and adds the Control Sequencer, Signal Analysis Modules and Action/Event based modules that enhance program control. The full VITool is included, with 200 Layout Windows. It can be supplemented with all available options, the Analysis Toolkit and hardware. Check with your dealer or distributor if you have any questions.

The DASYLab-Net option adds the Net Input and Output modules to the DASYLab+ Full version. The Analysis Toolkit option adds specialty features for advanced FFT signal analysis (Transfer Function, Octave Analysis, nth Harmonic), statistical modules for fatigue analysis and classification, and the Setpoint/Sequence Generator.

DASYLab 16- and 32-bit Version Differences

This version of the software is only available as a 32-bit product. DASYLab 32-bit version takes advantage of the features available with Windows 32-bit operating systems: Windows 98 and Windows NT/2000. It provides some functions that aren’t supported by the 16-bit version. The 32-bit version will not run under Windows 3.1 or 3.11, even if Win32s is loaded. Due to problems with some drivers, Windows ME is not supported.
To convert 16-bit program worksheets to V6.0, you must use DASYLab V5.0 16-bit to save the worksheet as worksheet ASCII format, *.DSA. You can read this format with DASYLab V6.0. You will need to copy both the *.DSA and the *.DMX files if you need to move them from their original folder. You can contact your distributor to obtain a V5.0 serial number to allow you to install the older version.
The chart below shows the versions and which modules are provided with each version.

<table>
<thead>
<tr>
<th>Group</th>
<th>Module</th>
<th>LE</th>
<th>Basic</th>
<th>Full</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input/Output</td>
<td>Analog Input</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Analog Output</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Digital Input</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Digital Output</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Counter Input</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Frequency Output</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>RS232 Input</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>IEEE488 Input</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>IEEE488 Output</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>DDE Input</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>DDE Output</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>IVI Devices</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td>Trigger</td>
<td>Combi Trigger</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Pre/Post Triggering</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Start/Stop Triggering</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Trigger on Demand</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Sample Trigger</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Relay</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td>Mathematics</td>
<td>Formula Interpreter</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Trigonometry</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Scaling</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Different/Integration</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Logical Operations</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Slope Limitation</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Bit Logic</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Gray Code</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Flip-Flop</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Reference Curve</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td>Statistics</td>
<td>Statistical Values</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Position In Signal</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Histogram</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Regression</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Rainflow</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Two Channel Counting</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Counter</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Minimum/Maximum</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Pulse Width Analysis</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Check Reference Curve</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td>Control</td>
<td>Generator</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Stop</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Switch</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Coded Switch</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Slider</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>PID Control</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Two-Point Control</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Time Delay</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>TTL Pulse Generator</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Latch</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Global Variable Read</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Global Variable Write</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Sequence (optional)</td>
<td>×</td>
<td>×</td>
<td>✫</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Group</th>
<th>Module</th>
<th>LE</th>
<th>Basic</th>
<th>Full</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal Analysis</td>
<td>Filter</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Correlation</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Data Window</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>FFT</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Polar/Cartesian</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>FFT Filter</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>FFT Max</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Octave Analysis</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Nh Harmonic</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td>Display</td>
<td>Y/X Chart</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>X/Y Chart</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Chart Recorder</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Analog Meter</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Digital Meter</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Bar Graph</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Status Lamp</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>List Display</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td>Files</td>
<td>Read Data</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Write Data</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Backup Data</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>ODBC In</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>ODBC Out</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td>Data Reduction</td>
<td>Average</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Block Average</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Separate</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Merge/Expand</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Cut Out</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Time Slice</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Circular Buffer</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td>Network</td>
<td>Net In</td>
<td>×</td>
<td>×</td>
<td>✫</td>
</tr>
<tr>
<td></td>
<td>Net Out</td>
<td>×</td>
<td>×</td>
<td>✫</td>
</tr>
<tr>
<td></td>
<td>Message In</td>
<td>×</td>
<td>×</td>
<td>✫</td>
</tr>
<tr>
<td></td>
<td>Message Out</td>
<td>×</td>
<td>×</td>
<td>✫</td>
</tr>
<tr>
<td></td>
<td>DataSocket In</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>DataSocket Out</td>
<td>➼</td>
<td>➼</td>
<td>➼</td>
</tr>
<tr>
<td>Special</td>
<td>Black Box</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Ex/Import Black Box</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Event Driven Actions</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Message</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Send E-Mail</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Time Base</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td></td>
<td>Signal Adaptation</td>
<td>×</td>
<td>×</td>
<td>➼</td>
</tr>
<tr>
<td>Add-On 1 (Option)</td>
<td>Transfer Function</td>
<td>×</td>
<td>×</td>
<td>✫</td>
</tr>
<tr>
<td></td>
<td>Convolution</td>
<td>×</td>
<td>×</td>
<td>✫</td>
</tr>
<tr>
<td></td>
<td>Block Weighting</td>
<td>×</td>
<td>×</td>
<td>✫</td>
</tr>
<tr>
<td></td>
<td>Universal Filter</td>
<td>×</td>
<td>×</td>
<td>✫</td>
</tr>
<tr>
<td></td>
<td>Save Universal File</td>
<td>×</td>
<td>×</td>
<td>✫</td>
</tr>
<tr>
<td>Optional Modules</td>
<td>SIMATIC S5</td>
<td>×</td>
<td>×</td>
<td>✫</td>
</tr>
<tr>
<td></td>
<td>SIPART Control</td>
<td>×</td>
<td>×</td>
<td>✫</td>
</tr>
<tr>
<td></td>
<td>Fuzzy Logic</td>
<td>×</td>
<td>×</td>
<td>✫</td>
</tr>
<tr>
<td></td>
<td>Can-BUS</td>
<td>×</td>
<td>×</td>
<td>✫</td>
</tr>
<tr>
<td></td>
<td>InterBus</td>
<td>×</td>
<td>×</td>
<td>✫</td>
</tr>
<tr>
<td></td>
<td>DAP Power DLL</td>
<td>×</td>
<td>×</td>
<td>✫</td>
</tr>
</tbody>
</table>

☆ - Optional Feature available
✶ - Network Version only
6. **New in DASYLab Version 6.0**

Below, you will find an overview of the most important additions and changes for the current DASYLab Version. Please also read the README file for additional changes made after this book was printed.

6.1. **Packaging**

DASYLab V6.0 has modified the various packages and option bundling.

DASYLab LE or Lite: now includes one VITool Layout Window, allowing you to create a custom report or user display. Use the menu commands or Key Actions to control the display or to print the layout window.

DASYLab Basic now includes more modules as well as a VITool Layout Window. Basic does NOT include Action and Action-enabled modules (such as ODBC, Message, or Email), nor does it include the Signal Analysis group.

The DASYLab+ or Plus version has been discontinued and replaced by the DASYLab Full version, available worldwide. It includes all standard modules, including the Signal Analysis modules and all Action and Action-enabled modules. In addition, it includes the full VITool with 200 Layout Windows, and the new, powerful Control Sequencer.

The Frequency Analysis, Rainflow, and Sequence Generator options have been combined into one Signal Analysis Toolkit package.

6.2. **General**

**Control Sequencer Window**

To control a large application consisting of more than one DASYLab worksheets calling each other, DASYLab offers a new tool. The new Control Sequencer Window (analogous to the Worksheet, Display and VITool windows) is accessible via Toolbar button or Menu command. The contents of the window are stored in a new type of file, the Control Sequencer file (suffix *.DSQ.).

The window shows a tree display of the control sequence. You can add any number of worksheets into the Control Sequencer File whose name is shown as the root of the tree.

You can define multiple actions for each worksheet to define the worksheet flow. You can load and save *.DSQ files using the main menu Files commands: New, Open, Save and Save As....

**Flowchart and Modules Documentation**

Two new documentation features are available. When you open the context menu by right mouse clicking on the module, you will see a Module Documentation command. The command opens a dialog box that shows the module name,
the short description and an edit area. Up to 256 characters can be used to more fully describe the use of the module in this worksheet.

The worksheet can also be documented with Text Areas, permanently visible on the background of the flowchart. Open the context menu by right mouse clicking on an empty part of the background. It contains the commands to Edit, Create, Delete or Modify the Documentation Properties of the worksheet text areas. You can enter up to 256 characters of text. You can create up to 256 areas, which can be placed everywhere in the flowchart, including within Black Boxes.

**Time Bases**

You can now use different Time Bases to synchronize data flow.

Use the Experiment-> Time Base Setup... menu command or click on the function bar button. All of the time base settings can be configured from this dialog box. Each available Time Base has a tab on the top of the dialog box, where you can select the corresponding time base setup.

**Exit Windows**

While a measurement is running, DASYLab will not allow Windows to suspend the system when using Windows Advanced Power Management. If the measurement isn’t running, DASYLab will close and allow Windows to shut down normally.

**Actions Overview Window**

You can list Event Driven Actions by using the Option Menu command List of Actions.... All Event Driven Actions defined in the flowchart are displayed. You can copy the list to the clipboard, or save it to a file.

**Online Display: FIFO Status in the flowchart**

The Animation function in the View menu has an additional command: FIFO Status. The View: Animation menu command (displayed the progress in processing data blocks in the modules) now contains two sub-commands Block Status (the old animation function) and FIFO Status (the new command). This new features allows you to easily monitor the FIFO buffer load for each module. The load is shown as a red bar, replacing the output symbols of the respective modules. The indicator bar grows with the load in steps of 10 %.

**Save worksheet as HTML**

You can now save DASYLab worksheets in HTML format (*.HTM). As with the *.TXT file format, it saves all components and settings as a readable text file, but it uses the HyperText Markup Language for structured text. Hyperlinks are inserted to allow you to move around the file easily. DASYLab is not able to reload these files, and no graphics or pictures are included.

**Number of Key Events**

The number of Key events allowed is now 64.
New Global Option
You can disable the Show warning if flowchart is changed Option to suppress the message and the dialog box to save the flowchart, if there is has been changed.

Switch to Runtime
This new option menu command switches the worksheet into the Runtime mode. DASYLab will show the running flowchart such as it would run in the DASYLab Runtime version. You cannot leave the Runtime mode. You must close DASYLab and re-open it. This new option allows you test how your worksheet will look and run in the Runtime mode.

VITool Additions and Changes

VITool Grid Element
New Grid Element to setup 16x16 tables with text, global string and variable entries (not channel data).

Editing Layout Windows
The list of all layouts is shown in the function bar as a drop down list box. The selection of a display module link now shows the module type. A Properties button is available in the Toolbox to quickly display object and page properties.

Changes to Objects/Elements
The Single line and multi line text object can be shown with selectable background color and (3D) frame.

6.3. New Modules
See the Module Reference Guide for details of each new module.

<table>
<thead>
<tr>
<th>Module</th>
<th>Module Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Variable Read</td>
<td>Control</td>
</tr>
<tr>
<td>Global Variable Write</td>
<td>Control</td>
</tr>
<tr>
<td>Channel Sort</td>
<td>Statistics</td>
</tr>
<tr>
<td>IVI Function Generator</td>
<td>Input/Output</td>
</tr>
<tr>
<td>IVI DMM</td>
<td>Input/Output</td>
</tr>
</tbody>
</table>
6.4. New Add-On Modules

<table>
<thead>
<tr>
<th>Module</th>
<th>Module Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nth Harmonic Maximum</td>
<td>Signal Analysis</td>
</tr>
<tr>
<td>Optional: Analysis Toolkit</td>
<td></td>
</tr>
<tr>
<td>Universal Filter</td>
<td>Signal Analysis</td>
</tr>
<tr>
<td>Optional: Analysis Toolkit</td>
<td></td>
</tr>
</tbody>
</table>

6.5. New Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset</td>
<td>Generator Module</td>
</tr>
<tr>
<td>Set Variable Range</td>
<td>Global Module</td>
</tr>
<tr>
<td>Set String Range</td>
<td>Global Module</td>
</tr>
<tr>
<td>Reset Message List</td>
<td>Message Module</td>
</tr>
</tbody>
</table>

6.6. New Global Variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>{ACTUAL_YEAR}</code></td>
<td>Actual Year</td>
</tr>
<tr>
<td><code>{ACTUAL_MONTH}</code></td>
<td>Actual Month</td>
</tr>
<tr>
<td><code>{ACTUAL_HOUR}</code></td>
<td>Actual Hour</td>
</tr>
<tr>
<td><code>{ACTUAL_MINUTE}</code></td>
<td>Actual Minute</td>
</tr>
<tr>
<td><code>{ACTUAL_SECOND}</code></td>
<td>Actual Second</td>
</tr>
<tr>
<td><code>{WEEK_DAY}</code></td>
<td>Actual Day of the Week</td>
</tr>
<tr>
<td><code>{DRV_DATA_LOST}</code></td>
<td>Data Loss in driver</td>
</tr>
<tr>
<td><code>{ELAPSED_TIME}</code></td>
<td>Elapsed time of measurement in seconds</td>
</tr>
</tbody>
</table>

6.7. New Global Strings

<table>
<thead>
<tr>
<th>String</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>{FULL_FLOWCHART}</code></td>
<td>File name of the flowchart with complete path (previously FLOW_CHART)</td>
</tr>
<tr>
<td><code>{FLOWCHART}</code></td>
<td>File name of the flowchart without path (previously with complete path)</td>
</tr>
</tbody>
</table>
6.8. Module Changes

Chart Recorder Module
The Chart Recorder includes a new Event Search tool to analyze a signal form for special events. The dialog to control that search can be called up using the menu command Display->Event Search of the Recorder Display Window.

Counter Module
In the Time with Input High or Low mode, the Restart after Edge option resets the counter if a falling or rising edge occurs.

Time Delay Module
You now can define the delay in seconds, in addition to samples or blocks.

Digital Meter Module
The Digital Meter has a new display option to show the data in a time format. The time format is hh:mm:ss.mmm. The number of digits can be defined individually for each channel.

E-Mail Module
The Send e-Mail module can now use Global Strings in the different input areas (Address, CC BCC, etc.)

Delay Module
You can define the duration in seconds, in addition to Blocks or Samples.

List Module
The list module has a new time channel format for long-term measurements: Date/Time.

Regression Module
The Regression Module now allows you to use Polynomial Regression (up to an order of 20), to build equalization curves to measured signal forms.

RS232 Interface (RS232 Input- and RS232 Output Modules)
When inserting a serial module into the flowchart you can select whether a module is created as a default module (with the usual default settings in all parameters) or as a predefined module with parameters configured for a special RS232 device. Configured modules can be selected from a list box. They are created using the new Experiment:-> Serial Devices menu command (see Setup Serial Devices).
Separate Module
You can use a Global Variable to set the number of values. The Global Variable is read when the experiment starts, and cannot be changed while running.

Slider Module
You can use the TAB key to switch between the control areas and the numerical edit areas. The Use Value At Experiment Start option allows you to set the slider to a specific value each time the experiment starts.

6.8.1 Global Strings/Variables

RS232 Input module
You can set a Global Variable to show a Timeout event. It is set to 0 on Experiment start. It will be set to 5 (TTL High) on Timeout. You can reset it to 0 after a defined time period. The Reset Timeout Notification period has to be smaller than the length of the Timeout period.

Set Global Strings/Variables: Button Extended...
The new Extended… button opens a new dialog for additional settings. You can define mathematical or logical operations to be performed with Global Variables (such as compare, link of variables etc.). You can also define variable and string names. Note that the actual variable or variable is stored by number, and if the name changes (e.g. you switch the name from variable 1 to 10), any references will still be to the original variable (e.g. 1).

6.8.2 VI-Tool

Message module
The graphical link to the Message Module in a VITool Layout Window now shows a scroll bar to allow access to earlier messages, which were previously scrolled off the top if the display area wasn’t big enough.
Chapter 2: Getting Started

1. Basic Techniques

Chapters 2 and 3 are designed to give you a quick first look at the program and to let you start experimenting with it.

This chapter discusses the following subjects:

- How to start DASYLab.
- How to obtain online help while working with DASYLab.
- How to create your first worksheet and become familiar with DASYLab’s basic functions.

You should be familiar with the basic techniques needed to operate your PC, DOS commands (such as those concerning drives, directory changes and file management), mouse operations and Windows fundamentals (like using menus or window features, etc.).

If you require additional information, please refer to your Windows User’s Guide and the documentation that comes with the corresponding software and devices. The online tutorial supplied with Windows helps you to learn basic mouse techniques.

DASYLab uses features common to most Windows applications:

- A menu structure with pull-down lists
- Scroll within windows using vertical and horizontal scroll bars on the right and the lower window borders
- Drag elements across the working area by selecting the element and moving the mouse with the left mouse button pressed
- Dialog boxes provide option buttons, list boxes and text boxes to select options and to enter parameters

Worksheet Window Right Mouse Functions

The right mouse button has multiple functions within DASYLab, which are explained here and in Chapter 3.

When the mouse cursor is on a module in the worksheet, you can display a context-sensitive pop up menu by pressing the right mouse button. The following menu items are displayed:

- Delete Module
- Delete Input Channels (if module has any input channels connected)
- Delete Output Channels (if module has any output channels connected)
- Cut (if module is selected)
Getting Started

- Copy (if module is selected)
- Search Module
- Module Documentation (extended description of selected module)
- Properties (Module dialog box for selected module)
- If the mouse cursor is over a free area of the worksheet (the worksheet background), the pop up menu has the following entries:
  - Colors
  - Paste (insert previously copied or cut worksheet components at the position of pointer)
  - Properties (general worksheet settings)

To select the window mode:
- Control Sequencer
- Display
- Worksheet
- Layout

Worksheet Documentation Tool:
- Edit Documentation (enables the documentation tool)
- Create Documentation
- Delete Documentation
- Documentation Properties

Delete a Data Channel - Two separate clicks (not a double-click!) with the right mouse button on the connection line between a module output and another module’s input deletes that data channel

**Control Sequencer Right Mouse Functions**

Click with the right mouse button on the background to open the popup context menu to switch to the other window modes (Worksheet, Layout, Display).

Right click on a flowchart junction to open a menu with the commands:
- New (Flowchart or Action)
- Comment Flowchart
- Set Start Flowchart (The start flowchart is marked by an added “start”)
- Load Flowchart
- Delete Flowchart (with an additional security request)

For Action junctions the commands below are available:
- New Action
- Edit Action
- Delete Action
VITool Layout Window Right Mouse Functions

If the mouse cursor is on an object in a VITool Layout Window, you can display a context-sensitive pop up menu with the following items:

- Cut
- Copy
- Delete
- Up
- To Front
- Down
- To Background Properties (Graphic Object)

If the mouse cursor is on a free area of the Layout Window, the pop up menu has the following entries:

- Paste
- Object (to insert a new object)
- Zoom
- Full Screen
- Delete Layout page
- Switch to...
  - Worksheet
  - Displays
  - Control Sequencer
  - Global Layout Properties
  - Page Layout Properties

Display Window Right Mouse Functions

Display Windows: If the mouse cursor is on a display window, the pop up provides the window menu options (useful if the Menu Bar is hidden).

Right Mouse Functions if the pointer is on Module, Function or Status Bar

- Module, Function or Status Bar (32-bit Version only): You can use the right mouse button to activate or deactivate the Module, Function or Status Bar. Activated bars are marked with a checkmark. The Module Bar display can be defined by user (number of rows/columns).
- Configure the Module Bar - Click on a Module Bar icon with the right mouse button to assign any of the modules available in DASYLab to that button
- You can change the relative size of the Module Bar by choosing from the selection of settings for the configuration of the Module Bar (1x40, 2x20, 4x10, etc.).

Configuring Hardware Module Input/Output Channels

Double-click the icon of an active channel on the Channel Selection Bar with the right mouse button to deactivate that channel.
2. Starting DASYLab

2.1. Starting DASYLab with a New Worksheet

From the Windows Start Menu
Click on the Windows Start button. Select Programs, then the DASYLab program group. Select the DASYLab icon from that group to start the program.

From the Windows Program Manager
Double-click the DASYLab Icon displayed in the DASYLab program group of the Windows Program Manager. When you installed DASYLab on your hard disk, a new program group (“DASYLab”) was automatically created.

2.2. Starting DASYLab with an existing Worksheet

From the Windows Program Manager

- If you prefer to keep a program startup option without a worksheet, first copy the DASYLab icon. Select the icon, and press the F8 function key, or choose Copy from the File menu.
- Select either of the two icons (one mouse click), and press the ALT+ENTER keys or choose Properties from the File menu.
- Type the complete worksheet file name (including drive, directory, and extension) after the DASYLab command in the Command Line box. For example:
  "C:\Program Files\DASYLAB 5.6\DASYLAB.EXE" D:\TESTS\TEST1.DSB
- In the Description box, type a description that identifies the worksheet that will be loaded onto the work area.
- Press ENTER
- Use this method to set up several icons to automatically open various worksheets.

You will find additional information on Automatic Program Start options in Chapter 6 of this User Guide.
3. **Experiment Setup and Time Bases**

General parameters for data acquisition and measurement control are set in the Experiment Setup dialog. You can set the

- Global Sampling rate per channel
- Global block size
- Global settings for Analog Output and Digital Output
- Global clocking for the driver
- Disk Streaming options
- Driver specific settings, including driver buffer, acquisition mode, etc.

See Chapter 4: 1.4.9, Experiment Setup... on page 4-25 for more details.

In addition to the Global Sampling Rate, DASYLab supports special drivers that may also be able to generate their own clock. The NI-DAQ driver for National Instruments devices is one such special driver.

The Time Base Setup, in the Experiment Menu, allows you to review each of the available time bases, and to configure them in one place. Various modules which can generate data, such as the Switch or Slider Modules, have a user settable option to choose the time base, allowing you to synchronize the output with hardware generated data.

4. **Using the DASYLab Help System**

*Click on this Button to call up the DASYLab Online Help or choose Help from the Main Menu and select Index or one of the other available options.*

You can usually obtain information on the function you are currently using by pressing the F1 function key or by clicking the Help button found in many dialog boxes. Then, either specific information on the current function, command or dialog box, or the Help Index will be displayed.

*You can obtain information on how to use the Windows Help system itself by pressing the F1 function key while using a Help window or by choosing Using Help from the Help menu.*
5. Creating your First DASYLab Worksheet

Follow this tutorial to create a simple worksheet and to learn about the basic elements and functions of DASYLab.

To start the program, double-click the DASYLab icon in the DASYLab Program Group of the Windows Program Manager.

The DASYLab screen will appear, displaying the Title Bar and the Main Menu Bar, the Function Bar below them, and the Module Bar on the left of the window. (These elements of the DASYLab screen are described in Chapter 3.)

Press the F1 function key (or the Help button while working in a dialog box) to obtain online help. If you prefer to follow these instructions on screen, press F1 now, and choose Creating your First Worksheet from the Help Index page.

On the left hand side of the DASYLab screen you can see the Module Bar. It displays a selection of icons that represent modules frequently required in worksheets.

![Generator module icon]

*Place the mouse pointer on this Module Bar icon. It represents a Generator module. Click the icon with the left mouse button. The name of the module the mouse pointer is pointing at is displayed in a small window above the module icons.*

![Y/t Chart module icon]

*In the same way, choose the Y/t Chart module by clicking its icon on the Module Bar with the left mouse button. You have now integrated these two modules into your worksheet; their symbols appear in the work area.*

Any module can be installed either by clicking the corresponding icon on the Module Bar, or by choosing it from the Modules menu. While the Module Bar can only offer a limited selection of icons, the Modules menu provides the complete list of available modules.

When you install a module from the Display group of the Modules menu (for example, a Y/t Chart module), an additional icon will appear at the bottom of the screen.

The two modules in the worksheet must now be connected by data channels so that data can be transferred between them.

To connect them, simply move the mouse pointer to the Y/t Chart module symbol, press the left mouse button, and drag the module symbol to the Generator module symbol (keeping the mouse button pressed down) until the output (O) and input (I) symbols touch. When you release the mouse button, DASYLab will automatically connect the two modules and route the wires.

You can also connect two modules without moving the module symbols – you’ll do that in a few minutes.

The data channel is now complete; the output of the first module is connected to the input of the second. The experiment can begin.
At the top of the DASYLab screen, below the Main Menu Bar, you can see the Function Bar. It contains icons that provide easy access to frequently used functions. When the mouse pointer is pointing at a Function Bar icon, a QuickInfo tag with the name of that function will appear. Just click the icon representing that function.

Use the left mouse button to click this icon on the Function Bar – the first one on the left or press F5. This will start the experiment, and soon the Generator module will generate a signal.

The signals and results of measuring processes can be displayed graphically using modules from the Display group. They consist of two elements each: the worksheet symbol, which is integrated into the worksheet and connected to the other modules by data channels, and the Display Window, which initially appears minimized as an icon at the bottom of the computer screen, and which you must separately restore (or “open”) to see the display during an experiment.

Open the Y/t Chart Display Window using the left mouse button, either by clicking this Function Bar icon (it represents the Show Display Windows command from the View menu) or by double-clicking on the display window icon at the bottom of the desktop.

The Y/t Chart Display Window appears, and you can observe the signal generated by the Generator module as it is shown on the display.

Before you perform the next steps, please drag the Y/t Chart Display Window to a position above this Help window, so that it does not hide any elements of your worksheet. It may be necessary to adjust its height first. You can drag a window by clicking its Title Bar with the left mouse button and moving it to its new location with the mouse button pressed down.

By alternately clicking this Function Bar icon with the left mouse button you can pause the running experiment or resume it at the same stage at which you interrupted it. Pressing CTRL+F6 on your keyboard has the same effect.

Click the right mouse button on the Y/t Chart Display Window screen: the Color dialog box appears. Select a new color for the display background by clicking the colors on the palette and pressing OK.

Now stop the experiment. You can either click this icon on the Function Bar or press CTRL+F5 on your keyboard.

If you cannot see the Y/t Chart module symbol (in the work area) because it is hidden behind the display window, drag the window to one side or reduce it to an icon by clicking the Minimize button (the down arrow in the upper right-hand corner of the display window).

Use the right mouse button to double-click the Y/t Chart module symbol on the worksheet to open a dialog box. Select Delete Module and press OK to delete the Y/t Chart module from your worksheet.
Now add the **Bar Graph** module to your worksheet by clicking its icon on the Module Bar with the **left** mouse button. The module symbol appears in the work area, and the icon representing the corresponding display window will appear on the lower edge of the desktop.

Connect the input of the **Bar Graph** module symbol with the output of the **Generator** module symbol as described above.

- Open the **Bar Graph** display window either by clicking this Function Bar icon or by double-clicking the display window icon at the bottom of the desktop.
- Start the experiment again; the **Generator** signal will appear in the **Bar Graph** display window.
- Stop the experiment,

And click the Module Bar icon representing the **Digital Meter** module. The module symbol appears on the worksheet next to the **Bar Graph** module symbol, and the corresponding display window icon appears at the bottom of the desktop.

Move the **Digital Meter** module symbol around the worksheet by clicking and holding the **left** mouse button while you drag it to various locations. For example, drag it below the **Bar Graph** module symbol. **DASYLab** will arrange the blocks evenly according to the grid settings defined in the **Window Setup** dialog box from the **Options** menu.

The quickest way to connect the **Digital Meter** module to the **Generator** module is to “tap” the existing data channel between the **Generator** module and the **Bar Graph** module. To create a branch, use the **left** mouse button to click anywhere on the data channel between the two module symbols. The mouse pointer takes the shape of a hand holding a plug. Place the tip of the plug precisely onto the input symbol (I) of the **Digital Meter** module symbol, and click the **left** mouse button again. This establishes the connection, and the Autorouter automatically finds the correct path for the new data channel segment.

You can now start, pause, and resume the experiment. Practice changing the color of the display by double-clicking the **Digital Meter** icon at the bottom of the screen, to change the color of the display as described above.

The default signal generated by the **Generator** module is a square wave. Double-click the **Generator** module symbol with the **left** mouse button. You can select various settings in the dialog box to define the signal to be generated. Refer to the Module Reference Guide or press the **F1** function key to obtain information on the parameters.

Click the **Sine** button in the **Wave Form** box, and then click the **OK** button. The **Display** modules will display the selected signal type.
The **Y/t Chart** module can be used now to visualize the sine wave. Since you previously deleted the **Y/t Chart**, click on the Module Bar to bring the **Y/t Chart** back onto the worksheet. (If your experiment is still running, you must first stop it before making changes in the experiment setup.)

Create another data channel branch to connect the **Y/t Chart** module symbol, and then start the experiment again.

You should **Save** your first worksheet now, so that you can use it to try out some more of **DASYLab**’s options later on.

First, stop the current experiment,

And then click this Function Bar icon with the **left** mouse button. It represents the **Save** command from the **File** menu.

A dialog box appears. In it, the **File Name** box displays a list of demo worksheet files that were copied to the **DASYLab** directory during the setup procedure. These files will give you examples of the wide range of measuring and data acquisition tasks that can be solved by **DASYLab**. You can open, run, modify and re-run them all later. Their **File Info** box contains a description of each worksheet.

Type a file name of your choice (using no more than eight characters) in the **File Name** box; for example, type **TUTOR1**. Choose the **OK** button, and your worksheet will be saved as **TUTOR1.DSB** in the **DASYLab** directory. (**DASYLab** automatically adds its standard extension .DSB.) The **DASYLab** window Title Bar now shows the file name.

To open this (or any other) worksheet file later, click the **File Open** icon on the Function Bar with the **left** mouse button. This icon is a shortcut to the **Open** command on the **File** menu.

Congratulations! You have successfully finished the **DASYLab** basic lesson and are now ready to begin working with **DASYLab**!

The next time you have a question or need help, you can

- Read these instructions again
- Find the answers in other chapters of the **DASYLab** documentation
- Use Online Help. You can obtain Online Help by pressing the **F1** function key whenever you need help; or use the **Search** function in the **Help** window

Unless you prefer to continue experimenting with **DASYLab**, exit the program now by double-clicking the **Control Menu** box in the upper left corner of the **DASYLab** window, or by pressing **ALT+F4** on your keyboard.
Chapter 3: Creating an Experiment Setup

This chapter describes DASYLab’s basic elements and functions used to set up a data acquisition experiment.

Read these pages at your computer so that you can try out all the functions provided by DASYLab. This chapter can also be used as a reference.

This chapter addresses the following topics:

- The elements of an experiment setup
- The elements of the DASYLab screen and how to use them effectively
- A brief overview of the module groups
- A systematic approach to a data acquisition task to be solved on screen.
- An overview of the VITool Layout windows

1. The Elements of a Worksheet

The worksheet graphically displays the complete experiment setup or measurement procedure, including all the modules and data channels. The maximum size of a worksheet in pixels is 2000 (vertically) by 2000 (horizontally). It is independent of the screen resolution.

1.1. Modules

A module represents a functional element in the DASYLab experiment setup (worksheet). A worksheet can contain up to 256 modules.

The functions symbolized by the modules comprise all the operations required for an experiment:

- Data acquisition (by a data acquisition board) or signal generation (simulated by a software generator)
- Data analysis, evaluation and processing (mathematics, statistics, control, trigger and other functions)
- Presentation on screen (display instruments) or export for documentation purposes (printer, metafile, etc.).

Most modules can be configured with up to 16 inputs and outputs.

A module can be installed on the worksheet by choosing it from the Module menu or by clicking the icon on the Module Bar.

You can find detailed information about the Module menu functions in Module Reference Guide. The Module Bar is described in detail on page 3-21 in this chapter.

Icons in the Module Bar appear slightly different from the worksheet symbols. Additionally, modules from the Display module group have a display window symbol.
Module Bar Icons
On the Module Bar, the modules are represented as simplified icons at a slightly reduced scale. The name of the module selected by the mouse is displayed above the Module Bar.

- Click the Module Bar icon with the left mouse button to add that module as a symbol to the worksheet, where it takes the first available free space. The exact position depends on the Spacing value entered in the Window Setup box of the Options menu.
- Click any Module Bar icon with the right mouse button to assign any of the available DASYLab modules to that position in the Module Bar (see page 3-21 in this chapter for a complete description of the Module Bar and techniques to customize it.)
- The Module Bar can only display a limited selection of the modules available in DASYLab. The exact size of the Module Bar depends on the screen resolution of your PC. All the available modules can be accessed from the Module menu. Please refer to Module Reference Guide of this manual for complete module documentation.

Worksheet Symbols
In the worksheet, modules are represented as complete symbols. These symbols display each module's name and the input and output channels you have selected for it.

- Use the left mouse button to double-click on the symbol to open the dialog box to configure the module.
- Use the right mouse button to double-click on the symbol to open the dialog box to delete the module from the worksheet or to delete its input or output data channels.
- Click and hold the left mouse button to drag and drop the symbol to any position on the worksheet (depending on the Spacing value entered in the Window Setup box of the Options menu).

When positioning modules manually in the worksheet, leave enough space between the module symbols for data channels to be created later. If you try to connect two modules and there is not enough space to arrange the data channels, an error message will appear: “Connection is not possible.”

- The modules from the Display module group provide an additional display window, which initially appears minimized at the bottom of the screen.

Module Manipulation by Keyboard
The modules on the worksheet can be manipulated in various ways. The module symbols on the worksheet can be dragged about, connected by data channels, configured, or deleted. The last two of these manipulations can also be done using the keyboard.
First, select the module. Only one module in the worksheet can be selected and manipulated at a time. When a module is selected, the Module Name Title Bar is highlighted in an inverse color.

- To select a module, click it once with the left mouse button, or press the **TAB** key on the keyboard until that module is selected.
- When you press the **ALT+ENTER** keys, the module configuration dialog box appears. Press the **TAB** or **SHIFT+TAB** keys to move from one field or button to another; select items by pressing the arrow keys, the **SPACE** and **ENTER** key.
- **Note:** Channel selection can only be done using the mouse.
- To copy setting for the selected channel to the other activated channels, use the **F7/F8** function keys. This procedure can only be done using the keyboard.
- To delete the selected module from the worksheet, or to delete all the input and/or output channels of that module, press the **DEL** key. In the dialog box that then appears, select the desired option, or choose **Cancel**, and press **ENTER**.

### 1.2. Data Channels, Junction Points

A data channel is the connection between the output of a module and the input of another module. Data is transferred between the respective modules via these connections.

A branch is a data channel segment that branches off from another data channel at a junction point.

Branches allow you to connect the output of one module to the inputs of several other modules.

By creating branches each module output can be connected to up to 16 inputs of other modules.

In the worksheet, lines like these represent data channels, branches and junction points:

- Data channel (wire)
- Branches and junction points
- No connections

You can choose the colors of the wires using the **Colors** command from the Options menu. Different colors can be specified for the wire cores and the wire sleeves.

When you connect the modules, the Options Autorouter menu function allows the following.

- When the Autorouter is active, **DASYLab** automatically finds the correct paths for the data channels. **DASYLab** ensures that the data chan-
Creating an Experiment Setup

Channels do not run across modules or hide other data channels. A control window in the Status Bar displays the progress of the autorouting operation.

- When the Autorouter is not active, you determine the paths of the data channels manually.

Channel FIFO Status while measurement is running

In addition to the Animation options (View Menu), there are three ways to monitor the flow of data between modules while the measurement is running. This is a useful set of features for ensuring that the worksheet logic is working as designed.

- Use the left mouse button to click on a data line. This simple display shows the data value and block size.

- Press on the Shift key and click on the data line with the left mouse button. This auto scaling chart displays all of the data in a block.

- Press the Control key and click on the data line with left mouse button to display the status of the data channel during measurement.
1.2.1 Creating Data Channels or Branches

The Quick Way

To connect a module, simply drag it against the module to which it is to be connected until the output (O) and input (I) symbols touch. When you release the mouse button, DASYLab will automatically connect the two modules and route the wires (whether the Autorouter option is active or not).

This procedure works with modules with any number of input or output channels, and it is very useful when connecting modules with multiple inputs and outputs.

It works when both modules are configured differently, when different channel numbers have been selected, and when some of their inputs or outputs are already connected to other (i.e., a third) modules.

For example, you can activate four output channels of a Generator module, then connect two of them to Display modules, and the remaining two to modules from the Signal Analysis group.

Once a connection has been established between two modules, no further connections (between the other – still unconnected – outputs and inputs of these two) can be created in this simple way. You must then proceed as described below.

With the Autorouter Option ON

Click the left mouse button once at the point where you wish the data channel to begin – the output symbol (O) of a module or – for a branch – any position on the wire. The mouse pointer then changes into a plug symbol.

Then place the tip of that plug symbol on the input symbol (I) of another module. Note that the input of the second module must be open. While you do this, a thin black line is drawn from the starting point of the connection.

Click the left mouse button again, on the input symbol at the end of the connection, to establish the connection.

- **Undo last Step:** use ALT+BACKSPACE to remove the last connection and restore the worksheet.
- **To cancel the process,** click the left mouse button once anywhere outside the input symbol.

With the Autorouter Option OFF

Click the left mouse button once at the point where you want the data channel to begin – the output symbol (O) of a module or – for a branch – any position on any wire. The mouse pointer then changes into a branch symbol.

Draw the new data channel by moving the mouse. While creating each segment, you can lengthen or shorten it only in the vertical or horizontal direction indicated by the branch symbol. You need not move the mouse pointer exactly along the future track of the channel.
Click the left mouse button again to freeze the length of the data channel segment you have just created and switch to the other axis (horizontal or vertical) for the next segment.

When the data channel hits a module, you must guide it around it.

When the tip of the new data channel is aligned with the input symbol of the desired module input, click on the input symbol to complete the data channel connection.

- To undo the last segment, click the right mouse button once.
- To cancel the process, double-click the left mouse button anywhere.
- To undo the last data channel connection, use the ALT+Backspace key combination.

**To Create a Branch**

When the output of a module is to supply data to more than one input of a module, simply create a branch. Click the left mouse button once anywhere on the data channel where you want the channel to branch off. Create the connection to the module input as described above.

**1.2.2 Rearranging Data Channels or Branches**

**To Rearrange a Data Channel**

First delete the data channel by clicking the channel twice with the right mouse button, and then create it again on a different track.

*Note that the deletion of a data channel segment may delete further segments and/or branches.*

**To Rearrange A Junction Point On A Data Channel**

Use the left mouse button to click once at the junction point that you want to move. The mouse pointer then changes into a branch symbol.

Drag the small box that now represents the junction point to its new position on the data channel.

Establish the new position by clicking the left mouse button again. All the data channels affected will be automatically rearranged.

Note that you can only drag the junction point either vertically or horizontally along a data channel. If you want to move it around a corner you must first drag it right to the corner, click the left mouse button, and then move it in the other direction in a second step.

**1.2.3 Deleting Data Channels or Segments**

**The Quick Way**

Use two separate right mouse button clicks (not a double-click!) on the data channel to be deleted:

- At the first click, the section that is to be deleted will change its color.
At the second click it will be deleted. To cancel the process, click anywhere on the screen but on the same section the second time. The data channel will then resume its previous color.

-Or-

Use the right mouse button to double-click at the end of the connection (i.e., the input symbol of the second module). Confirm the deletion in the dialog box that appears, or choose Cancel. If you accidentally double-click the beginning of the connection (i.e., the output symbol of the first module), you will be asked to confirm the deletion of that module (instead of the data channel). Click the Cancel button in the dialog box.

**To Delete ALL the Input and/or Output Channels of a Module**

Use the right mouse button to double-click on the module symbol. To use your keyboard, select the module first by repeatedly pressing TAB until the module’s Title Bar is highlighted, then press DEL.

In the dialog box, click the desired option, then choose OK, or press ENTER on your keyboard.

Please note that any confirmed deletion will always be executed in compliance with the other elements of the worksheet. This means that if, for example, you delete a channel section that divides up into branches in its further course, and all those further branches will be deleted too.
2. The DASYLab Screen

2.1. The Worksheet Window

Work Area: Worksheet Window

The work area is where you create the virtual DASYLab experiment setup (the worksheet). It consists of the module symbols and the data channels connecting them.

You can install modules in the worksheet either by choosing them from the Modules menu or by clicking the corresponding icons on the Module Bar.

Data channels must then connect these modules. Every module input must be connected before you can start the worksheet. You do not have to connect every module output.
A worksheet can contain up to 256 modules. The maximum size of a worksheet
in pixels is 2000 (vertically) by 2000 (horizontally) regardless of the screen reso-
lution.

The size of the worksheet segment that is actually displayed in the workspace
on your screen depends on your display adapter. The area available for a work-
sheet is much larger than can be displayed on screen at one time.

- You can drag any module to any position on the entire worksheet. Click it
  once with the left mouse button, and then move it with the mouse button
  held down. If you touch the window frame, the window will automatically
  move on across the worksheet in that direction.
- Use the scroll bars to pan horizontally and vertically around the worksheet.
- You can also use the SPACE bar. The cursor will change into a MOVE cur-
sor within the worksheet area. You can now pan the worksheet just by us-
ing the mouse. Press the SPACE bar again to switch to normal mode.
- You can drag any module symbol to any location in the worksheet by plac-
ing the mouse pointer on it, and pressing and holding down the left mouse
  button while moving the mouse. If you touch the window border while do-
ing this, the worksheet display will scroll until you release the mouse but-
  ton, placing the module symbol at the new location.

**To Change the Appearance of the Worksheet**

- To change the grid, type of grid, or grid spacing of the DASYLab work-
sheet, choose the Window Setup option from the Options menu.
- To change the colors of the DASYLab worksheet, choose the Colors op-
tion from the Options menu.
- To change the colors of the DASYLab window frame, Menu Bar, etc.,
  choose the Color option from the Windows Control Panel.
- Shortcut menu: you can right-click over the worksheet work area to display
  a contextual menu. You can change colors, switch to other modes, or dis-
  play properties for this view.

**To Display More of Your Worksheet**

- Remove the Function Bar and/or the Module Bar from the DASYLab win-
dow. Choose these options from the View menu, or press ALT, V, F or ALT,
  V, M.
- To view the complete worksheet in a separate window, choose the Overview
  option from the View menu, or click the corresponding icon in the Func-
tion Bar. However, you cannot edit or change it there. The display is auto-
matically scaled to the size of the worksheet.
- To enlarge the window to its maximum size, click the Maximize button in
  the upper right-hand corner of the DASYLab window, or choose Maximize
  from the Windows Control menu. The worksheet will fill the entire screen.
  Other Windows applications, such as the Program Manager, run in the
background. After you enlarge the window, the Restore button replaces the Maximize button. Click the Restore button to return the window to its previous size.

**Worksheet Documentation Area**

You can insert information about the worksheet into text boxes that are shown on the background of the worksheet. Use the right mouse button to click on an empty area of the worksheet background and open a context menu that allows you to Edit, Create and Delete text boxes. You can insert up to 256 characters of text, change the font, or modify the background color/style.
2.2. The Display Tree View

Work Area: Tree View/ Display View

The measurement setup is displayed in a structure similar to the Windows Explorer (32-bit version only). All elements of the worksheet are shown, starting with the layout pages, the modules and black boxes, and finishing with global setup, including global strings and variables. When you click on one of the tree elements, the next branch opens or the appropriate Dialog box opens.

Shortcut menu: you can right-click over the worksheet work area to display a contextual menu. You can change colors, switch to other modes, or display properties for this view.
2.3. The Control Sequencer Window

To control a multi-step application consisting of more than one DASYLab worksheets calling each other, DASYLab offers a new tool, shown as a new display window (analogous to the worksheet, display and VITool windows), called the Control Sequencer Window. The contents of the window is stored in a new type of file, the Control Sequencer file (saved with the suffix *.DSQ.)

The window shows a tree display of the control sequence. You can add any number of worksheets into the Control Sequencer File, whose name is shown as root of the tree.

You can also multiple actions for each inserted worksheet to control the flow of the worksheets.

In the Control Sequencer window you can load and save *.DSQ files using the main menu file commands: New, Open, Save and Save As....

To insert flowcharts or actions you need to use the pop-up context menu that appears when you right mouse click on one of the junction points on the screen. Depending on the junction (flowchart or action) the pop-up menu offers several commands to add, delete or to edit the object.

The Sequence file is a binary file type. You cannot edit it with ASCII Editor programs such as Notepad.
Work Area: Control Sequencer View

The window shows a tree display of the control sequence. You can add any number of worksheets into the Control Sequencer File. The Control Sequencer filename is shown as the root of the tree.

Also you can define several actions for each inserted worksheet to control the flow of the worksheets.

In the Control Sequencer window you can load and save *.DSQ files using the main menu file commands: New, Open, Save and Save As....

To insert worksheets, simply right mouse click on the root symbol to open the context menu. The new flowchart command opens the standard explorer window dialog box to select any flowchart. If there is a flowchart already inserted, the context menu offers additional items to handle flowcharts and actions (insert, delete...).

Control Sequencer Flowchart Junction

You can add any number of worksheets into the Control Sequencer File. The inserted flowchart is shown as new flowchart junction.

Double-click on the junction or select the Comment Flowchart context menu command to add or edit a description of the junction.

Control Sequencer Action Junction

You can add any number of actions to each flowchart in the Control Sequencer File. The inserted actions are shown as new branch of a flowchart junction.

Each action will be processed if the defined condition is fulfilled. The conditions depend on the settings of global variables or strings or are global events such as Start/Stop of measurement. All global actions are allowed.

Double-click on the junction or use the Edit Action context menu command to modify the action

Sequencer Action Dialog

You can edit the actions assigned to each flowchart in the control sequence file. The Action selection field offers all global actions. The dialog box may change depending on the action you have selected. Functions that control changing values are always assigned to global Variables (Event Parameter: Variable No setting.).

<table>
<thead>
<tr>
<th>Function</th>
<th>The action is initiated...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rising Edge:</td>
<td>When the variable changes from TTL Low (value 0) to TTL High (value 5).</td>
</tr>
<tr>
<td>Falling Edge:</td>
<td>When the variable changes from TTL High (5) to TTL Low (0).</td>
</tr>
<tr>
<td>Threshold Overflow:</td>
<td>When the variable rises above the specified threshold value.</td>
</tr>
</tbody>
</table>
### Creating an Experiment Setup

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Action Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold Underflow:</td>
<td>When the variable falls below the specified threshold value.</td>
</tr>
<tr>
<td>TTL High Level:</td>
<td>When the variable is TTL High (5).</td>
</tr>
<tr>
<td>TTL Low Level:</td>
<td>When the variable is TTL Low (0).</td>
</tr>
<tr>
<td>Input larger than Threshold:</td>
<td>As long as the variable value is larger than the threshold value.</td>
</tr>
<tr>
<td>Input smaller than Threshold:</td>
<td>As long as the variable value is smaller than the threshold value.</td>
</tr>
<tr>
<td>Start/Stop of Measurement:</td>
<td>At the beginning and/or at the end of the measurement.</td>
</tr>
<tr>
<td>Global String has changed:</td>
<td>If the named global string has changed during measurement.</td>
</tr>
<tr>
<td>Input value has changed(+/- 0.0)</td>
<td>If the variable value has changed</td>
</tr>
<tr>
<td>Value is reached (+/- 0.001%)</td>
<td>If the variable reaches the defined value.</td>
</tr>
<tr>
<td>Always:</td>
<td>The action is constantly initiated.</td>
</tr>
<tr>
<td>Never:</td>
<td>The action is never initiated (NOP).</td>
</tr>
</tbody>
</table>

*Global variables and strings are always saved with the corresponding flowchart. In exactly the same way, the Global Variables and Strings used in the event-driven actions in the sequence window are stored in the worksheet file of the corresponding flowchart where the action is defined in the sequence. If the variables or strings are to be used in other flowcharts you must save them using the actions Write String/Variable to INI file and Read String/Variable from INI file to save and reload the values separately.*

You will find more information about Event driven Actions parameters in the Action Module description.

### Control Sequencer File

The Control Sequencer file stores all settings made in the tree. You can add any number of worksheets into the Control Sequencer File.

You can define several actions for each inserted worksheet to control the worksheet flow.

The Control Sequencer files (*.DSQ) can be loaded and saved using the main menu file commands: New, Open, Save and Save As....

### Sequencer Comment Dialog

This dialog is used to add an additional description to each flowchart in the sequence file. The description is linked in the Control Sequencer mode to the name of the corresponding flowchart.
2.4. The Layout Window

The DASYLab Visualization tool (VITool) allows you to connect a bitmapped graphical object with the active Elements of the Layout Window, so you can generate a practical on-line display of relevant data values. You can use technical worksheets or pictures as background and place the Display Windows of DASYLab on the screen. Status Lamps, for example, are symbols of running engines, Digital Meters show rpm, and Bar Graphs can look like thermometers - all to give you quick information about the temperature of a vessel or the status of other parts of the plant.

You can create up to 200 Layout Windows for each worksheet window using the main menu option window. The size of the working area can be specified in one of several DIN formats or adapted to the screen size. The zoom function allows you to scale parts of the screen for better handling.

Full size mode allows you to hide all functional elements such as the Function Bar, Title Bar, etc. This mode is very useful for Online Presentation where you want to display only the custom designed display, not the program elements.
Work Area Layout Window

The work area is where you create a Layout belonging to the DASYLab experiment setup (the Worksheet). The size of the worksheet segment that is actually displayed on your screen varies depending on your display adapter. In any case, the area available for a worksheet is much larger than can be displayed on screen at a time. You can use the scroll bars to pan horizontally and vertically around in the worksheet. You can also use the SPACE bar. The cursor will change into a MOVE cursor within the worksheet area. You can now pan the layout just by using the mouse. Press the SPACE bar again to switch to normal mode.

You can create objects in the work area either by choosing them from the Object menu or by clicking the corresponding icons on the Tool Box. These objects are placed onto the worksheet by drawing a frame with the mouse. Linked objects are connected to Display Modules of the Worksheet. You can scale or move objects on the worksheets.

Shortcut menu: you can right-click over the worksheet work area to display a contextual menu. You can select objects to add to your layout, switch to other modes, or display properties for this view or the layout page.

New Layout

Window Menu Command: New Layout

Use this command to create a new Layout window. Up to 200 Layout sheets can be created with 512 Layout objects. The name of worksheet and the first nine Layout windows are displayed below the menu commands. If there are more than ten windows you can use the more command to see them.

Properties of the Layout Page

Double-click with the left mouse button on an empty part of the Layout Window, or, use the Properties Object Menu Command to view the Properties Dialog Box.

Tool Box

When a Layout window is active, the Tool Box will also be shown. Select a tool by clicking on the Symbols.

The following tools are available:

- Selection Tool
- Line
- Rectangle (filled or not filled)
- Ellipse (filled or not filled),
- Bitmap,
- Text Line,
- Text Block,
- Linked Text
Creating a new Layout Object

Select an object type using the menu or the ToolBox. Draw a frame of the desired size. You must create a frame when using a Text Object. The object will be inserted into the frame. To set the object’s properties double click with the left mouse button on the object to open the Properties Dialog Box.

The size and position of objects may be changed using the mouse or by using the keyboard. To move the object just use the arrow keys, to resize the objects use CTRL+ arrow key. The degree of movement and scaling depends on the settings in VITool page setup.

Types of Objects:

- **Drawing Elements**: You can create Lines, filled and unfilled Rectangles or Ellipses. You can import Bitmaps.
- **Visualization**: You can create Linked Elements that import strings (Linked Text) or Graphs (Linked Graph) into your Layout Window.
- **Text Elements**: Text frames with Line or Block Text can also be integrated into your Layout. The text itself can be edited in the Properties dialog box.

Working with Layout Objects

A single mouse click will select the object. Now you can resize or move it. Backspace will delete the selected object.

A single mouse click with the right mouse button on an object opens a pop up menu. (You cannot change objects while the measurement is running.) Double mouse click on the object to open the Properties dialog box for that object.

Creating an Object

Select an object type using the menu or the ToolBox. Draw a frame of the desired size. You must create a frame for a Text Object. The object will be inserted into the frame. Open the Properties dialog box by double clicking the left mouse button on the object.

Passive Elements

In the DASYLab Layout Window there are some objects that are created on the worksheet although they don’t have a direct connection to modules on the worksheet. These passive elements are simple graphical objects such as lines, circles, ellipses (filled or unfilled), or text. Position, size and color are freely selectable for each element. You can modify other properties for each element, too. Passive elements are useful to create an attractive layout page design. Block text with scalable font size is useful to display information about the layout (for example, the measurement parameters).
You can also specify the text line object: Using field placeholders, you can insert the current time, date or other system information.

**Active Elements**

Another group of objects shows the unique features of the VITool. These active connected objects create a direct link with modules on the DASYLab worksheet. Information that is displayed in the display window of the visualization module can be integrated into the Layout Window and can be dynamically updated as the data changes. The VITool is a perfect instrument to create an online data acquisition and visualization setup that reflects your ideas and creativity. Available active elements are linked with graphical and text objects.

Linked graphical objects import graphical information from the display windows of visualization modules into a Layout Window. You can show the curves of Y/t, X/Y or Recorder module as well as the display of Analog, Digital Meter or Lamp and Bar Graph or you can display an alert message from the Message module.

A special feature links an object to the Switch module: You can show the state of the switch and operate the module from the Layout Window. This allows you to interact with the measurement when the Layout Window is in full screen mode.

**Graphics**

The DASYLab VITool allows you to import bitmapped graphics objects and use them as background in the Layout Window. You can use plant flowcharts and other pictures as background in the Layout Window and you can place other passive or active elements over them. For example, status displays placed over machines show activated engines, a Digital Meter shows their rotational speed, Bar Graphs shaped as thermometers quickly inform you of the temperature of several parts of a plant. You can even insert your own logo into the layout. Only the reference address of the picture files (*.BMP and *.WMF format only) are saved with the worksheet or with the layout file. The original picture file must be separately saved in the correct directory to be displayed in the Layout Window.

> You cannot use pictures and drawings created by CAD programs. You must first convert the files into .BMP or .WMF format using appropriate conversion software.

### 2.5. VITool Toolbox

The Layout Window Toolbox allows you to quickly select a Layout Window Drawing Object.
2.6. Title Bar

The Title Bar is the upper border of the DASYLab window and shows the name of the application (DASYLab) and the file name of the current worksheet. If the current worksheet has not yet been saved, “Untitled” appears as a placeholder.

2.7. Menu Bar

Below the Title Bar, the Menu Bar lists the Main Menu Options. Each menu contains a list of commands or actions. You can open each of these lists by clicking the Main Menu Option on the Menu Bar with the left mouse button, or by pressing the ALT key and then typing the letter that is underlined in the Main Menu Option.

In the picture above, you can see the list of Options menu commands. You can then choose an option from that list by clicking it, or by typing the letter that is underlined in the menu item without pressing the ALT key, or by using the arrow keys on your keyboard and pressing ENTER. The display field in the left half of the Status Bar will often contain information describing the current menu item.

In the picture, the Wire Sleeve option from the Colors submenu is selected (highlighted). Click it, or press the ENTER key, to carry out that command.

The following Windows menu conventions provide additional information about the menu items.

- An ellipsis (…) following a command indicates that a dialog box appears when you choose that command. There, further options must be selected before the command can actually be carried out. For example:
Creating an Experiment Setup

Output Setup… (Experiment menu)

- A triangle (▶) next to a command indicates that a cascading menu appears when you choose that command. That submenu contains further commands. For example:
  Module Bar ▶ (Edit menu)

- A check mark (✔) next to a command means that the command is already in effect. After selecting that command again, the command is no longer in effect, and the check mark disappears. For example:
  ✔ Auto Start (Experiment menu)

- Dimmed commands cannot be used at the current time. For example, another command must be chosen first to enable that command. For example:
  Stop (Experiment menu)
  Stop is only available after Start is chosen, and vice versa.

- A key combination next to a command is a shortcut for the command. To use your keyboard instead of your mouse, the key combination has the same effect as clicking, or choosing, the command from the menu list. For example:
  Pause CTRL+F6 (Experiment menu)

*The icons on the Module Bar and on the Function Bar also represent menu functions. Clicking these icons with the left mouse button is the easiest and quickest way of choosing a menu command.*
2.8. Module Bar

The Module Bar, at the left of the DASYLab window, displays a selection of frequently required modules in icon form. The size of the Module Bar depends on the screen resolution of the computer's display.

Use the left mouse button to click on the icon that symbolizes the module you want to add to your worksheet.

There are only a limited number of spaces on the Module Bar; therefore not every available module can be displayed on the Module Bar. You can customize the Module Bar to display only the modules that are needed most frequently.

**Module Type Display**

The name of the module the mouse pointer is pointing at is displayed in a small window above the module icons.

**Module Bar Configuration**

You can select which modules are displayed as icons on the Module Bar.

Click on a square in the Module Bar with the right mouse button to assign any of the modules available in DASYLab to that square. A dialog box appears presenting the complete list of modules including their Module Bar icons.

- Scroll through the list using the scroll bar or the arrow keys on your keyboard.
- To quickly select a module in this list, type the first letter of its name to move to the first matching module. Type the letter again to move to the next module that starts with that letter.
- Click the Help button to obtain information on the selected module.
- Choose OK, or press ENTER, to install the selected module on the Module Bar. The Module Bar will now display the new icon.

**Saving a Module Bar Configuration**

You can customize several Module Bars for individual experiments.

- All of the Module Bar settings are automatically saved together with information about the window size and position when you exit the
Creating an Experiment Setup

program. When you start DASYLab the next time, you will find the same work environment as before.

- In addition the settings are saved with the worksheet file when you choose the Save or Save As… commands from the File menu.
- You can individually save your customized Module Bars to files and open them when you work with similar tasks or you can open the Default Module Bar provided by DASYLab.

Use the Module Bar command in the Edit menu:

- New provides a blank Module Bar to be configured individually.
- Open… opens a saved Module Bar configuration onto the DASYLab screen.
- Save As… saves the current Module Bar configuration to a file under a name of your choice.
- Default opens the default Module Bar configuration onto the DASYLab screen.
- Basic Displays a limited number of modules, suitable for beginners
- Intermediate Displays more modules, appropriate for experienced users
- Advanced Displays modules appropriate for “power users.”

For details about these menu functions refer to Chapter 4 of this manual.

Removing the Module Bar

To enlarge the display area for your worksheet, you can remove the Module Bar from the screen. The visible worksheet then extends to the left border of the DASYLab window.

Use the Module Bar command from the View menu to hide and to redisplay the Module Bar. A check mark (✓) indicates that the Module Bar is displayed.

After you have hidden the Module Bar, you can still install modules by using Module menu commands. To install a Signal Generator module, for example, select Control from the Module menu, then choose Generator, or press the ALT, M, C, and G keys.

2.9. Function Bar

The Function Bar, below the Main Menu Bar of the DASYLab window, displays a selection of icons that provide easy access to menu functions often used dur-
ing experiments. Use the **left** mouse button to click on the icon that represents the desired command.

When the mouse pointer is pointing at a Function Bar icon, a tag with the name of that function will appear. (You will find **QuickInfo** in all of the module windows that provide a Function Bar.)

**Function Bar Configuration**

The configuration of the Function Bar is fixed. You cannot change it by removing or adding any icons.

The following table contains a list of the icons included and the menu commands they represent. For further details about the menu functions themselves refer to Chapter 4 of this manual.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Command</th>
<th>Menu</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Play" /></td>
<td>Start experiment</td>
<td>Start</td>
<td>Experiment</td>
<td>F5</td>
</tr>
<tr>
<td><img src="image" alt="Pause" /></td>
<td>Pause/Resume experiment (toggle)</td>
<td>Pause</td>
<td>Experiment</td>
<td>CTRL+F6</td>
</tr>
<tr>
<td><img src="image" alt="Stop" /></td>
<td>Stop experiment</td>
<td>Stop</td>
<td>Experiment</td>
<td>CTRL+F6</td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Clear worksheet to create a new worksheet</td>
<td>New</td>
<td>File</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Open worksheet file</td>
<td>Open...</td>
<td>File</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Save worksheet to file</td>
<td>Save</td>
<td>File</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Clock" /></td>
<td>Set up different time bases</td>
<td>Time Base</td>
<td>Experiment</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Settings" /></td>
<td>Set general experiment parameters (dialog box)</td>
<td>Experiment Setup</td>
<td>Experiment</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Settings" /></td>
<td>Set hardware-specific parameters (dialog box)</td>
<td>Hardware Setup</td>
<td>Experiment</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="File Info" /></td>
<td>Open File Info dialog box</td>
<td>File Info...</td>
<td>File</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Control" /></td>
<td>Switch to Control Sequencer mode</td>
<td>Control Sequencer</td>
<td>Windows</td>
<td></td>
</tr>
</tbody>
</table>
Creating an Experiment Setup

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Command</th>
<th>Menu</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Switch to Display Window mode</td>
<td>Display Windows</td>
<td>Windows</td>
<td>F3</td>
</tr>
<tr>
<td></td>
<td>Switch to Worksheet mode</td>
<td>Worksheet</td>
<td>Windows</td>
<td>F3</td>
</tr>
<tr>
<td></td>
<td>Switch to VITool Layout Window mode</td>
<td>Layout</td>
<td>Windows</td>
<td>F4</td>
</tr>
<tr>
<td></td>
<td>Cut the marked object and copy it to the Windows clipboard</td>
<td>Cut</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Copies selected Worksheet part or Layout object to clipboard</td>
<td>Copy</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Inserts contents of clipboard into Worksheet or Layout Window</td>
<td>Paste</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hide all the display windows</td>
<td>Make Invisible</td>
<td>View</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Show all the display windows</td>
<td>Make Visible</td>
<td>View</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Minimize all the display windows</td>
<td>Minimize</td>
<td>View</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Restore all the display windows</td>
<td>Restore</td>
<td>View</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Leave the Black Box, return to preceding worksheet level (or to the main chart). To enter a Black Box, double-click its module in the worksheet.</td>
<td>To Preceding Black Box Level or Back to Main Chart</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>(list)</td>
<td>Re-arrange display windows into one of the ways you have saved</td>
<td>Select Window Arrangement</td>
<td>View</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Display DASYLab Online Help options</td>
<td>Help</td>
<td>Help</td>
<td></td>
</tr>
</tbody>
</table>

Removing the Function Bar

To enlarge the display area for your worksheet, you can remove the Function Bar from the screen. The visible worksheet then extends to the Menu Bar of the DASYLab window.
The Function Bar command from the View menu enables you to hide and to re-display the Function Bar. A check mark (✓) indicates that the Function Bar is displayed.

After you have removed the Function Bar, you can still use any function by selecting it from the menu. To start an experiment, for example, choose Start from the Experiment menu, or press the ALT, X, S keys, or press F5.

2.10. Status Bar

The Status Bar at the bottom of the DASYLab window provides the following information:

- On the left of the display you will find an explanation of the menu function you have selected on the Menu Bar.
- The status bar on the right displays the progress of operations, for example, of the Autorouter function arranging data channels, or, during experiments, the driver buffer status.

If the bar turns red, this indicates that the acquisition rate is too fast to collect data continuously. Left of the driver buffer indicator there is a small indicator for lost samples. Many drivers acquire data using interrupts. Some boards allow DASYLab to check whether the program has processed all interrupts. A yellow flashing light indicates that some interrupts have been missed. For more detailed information see the hardware help.

- The current time is displayed on the far right.

2.11. Display Windows

Display Windows of the Display modules show data samples in various graphical ways. You can choose X/Y, Y/t Chart, Chart Recorder, Bar Graph, Digital or Analog Meter. You can customize the appearance of Display Windows in many ways.

Hiding and Showing Display Windows

The modules from the Display module group consist of two parts: the module symbol in the worksheet, and a display window where the incoming data is visualized. When a display module is inserted into the worksheet, the display window initially appears minimized.

You can restore each of the display windows contained in your worksheet individually by double-clicking its icon at the bottom of the computer screen, or by choosing Select Windows/Restore from the View Menu.

You can restore all the minimized display windows contained in your worksheet simultaneously by choosing All Windows/Restore from the View menu, or by clicking this Function Bar icon.
You can minimize each of the display windows individually by clicking its Minimize button (in the upper right-hand corner of the display window).

You can minimize all the display windows contained in your worksheet simultaneously by choosing All Windows/Minimize from the View menu, or by clicking this Function Bar icon.

You can hide a display window without minimizing it. Use the View menu command Select Windows/Make Invisible. You can hide minimized display windows to make your work area easier to read.

You can hide all display windows, including minimized windows, by clicking on the Hide button or choosing All Windows/Make Invisible from the View menu.

You can show (un-hide) a hidden display window by choosing the Select Windows/Make Visible from the View menu.

You can show (un-hide) all hidden display windows by clicking on this Function Bar icon, or by choosing the All Windows/Make Visible command from the View menu.

**Window Arrangement**

This field shows the number and name of the current Window Arrangement. **DASYLab** allows you to save up to eight different Display Configurations to be used by the experiment: Switch to another arrangement by choosing the name displayed in the list. The Window Arrangement can also be switched using the Action module.

While observing an experiment, with data being displayed on several instruments, you may find it useful to save certain arrangements of these display windows (i.e., their sizes and positions on the screen). You can then easily restore any of these arrangements when it seems most suitable, and you can even switch between various window setups to compare different display modes.

For these purposes, **DASYLab** provides the following menu commands:

- Save Window Arrangement
- Select Window Arrangement
- Delete current Window Arrangement
3. Module Groups Overview

DASYLab module functions are divided into ten Module Groups, each containing modules that perform related functions.

The Module menu provides all the available module groups. Choose a module group from the Module menu to open a submenu with the list of the modules that belong to that group. You can select any of the modules listed by clicking on it. It is then placed on the worksheet as a module symbol.

- The Input/Output and the Files modules provide data input and output functions, including data archiving using the new Backup module.
- The Trigger Functions and the Control modules perform control tasks.
- The Mathematics, the Statistics, the Signal Analysis, the Data Reduction and Add-On modules offer a large number of analysis, evaluation and calculation operations.
- The Display modules provide several ways of displaying data.
- The Black Box module allows you to store complete worksheet segments in one module as ready-to-use units.

Input/Output Module Group

This group provides all the function modules necessary to communicate with the data acquisition hardware, external devices and other programs. The modules Analog Input, Analog Output, Digital Input, Digital Output and Counter Input represent different functions of the data acquisition hardware, while DDE Input and Output implements DDE communication with other Windows applications. Serial Input and Output and the IEEE488 Interface modules represent the interfaces to the corresponding devices.

Files Module Group

This module group provides file reading and writing functions. It consists of Read Data, Write Data, Backup and FlexPro modules.

Trigger Functions Module Group

This module group contains the Start/Stop Trigger and the Pre/Post Trigger modules, which are used to control data flow in the worksheet depending on the acquired signal. The Combi Trigger allows you to detect a wide combination of signal changes. The Relay module is used in conjunction with the trigger modules to control the flow of data.

Control Module Group

This module group contains two different types of modules. There are four signal generating modules: the Generator can generate periodic or random signals; the Switch allows manual input of TTL low and high levels; the Slider is used to manually define an analog signal; and the TTL Pulse Generator will generate a
Creating an Experiment Setup

pulse of specific duration. The PID Control, Stop, Latch, and Time Delay modules may be used to control data flow within the worksheet.

**Mathematics Module Group**
This module group provides basic mathematical functions including Arithmetic and Trigonometry, Logic Operations, Linear Scaling, Thermocouple Linearization, Interpolation, Differentiation/Integration and the general purpose Formula Interpreter.

**Statistics Module Group**
This module group provides several statistical calculations including standard deviation, min/max, mean values, and variance in the module Statistical Values. It also contains function modules for Histogram calculation, Counting and the calculation of Regression.

**Signal Analysis Module Group**
This module group contains several modules for signal analysis applications. It implements digital (IIR) Filters of different types, the calculation of FFTs, frequency spectrum, amplitude and phase spectrum, Correlation functions and cepstrum. Another module provides a number of different Window functions. Polar/Cartesian coordinate transformation is now part of this module group.

**Data Reduction Module Group**
This module group contains different algorithms for data reduction including Averaging and Block Average, the selection of samples and blocks, and modules that allow you to combine and separate signals from different channels, including Time Slice, Merge/Expand and Cut Block.

**Display Module Group**
This module group contains all the display modules. It includes the scope display (Y/t Chart), Chart Recorder, X/Y Chart, Analog and Digital Meters, Bar Graph, and List modules.

**Network Module Group**
The high-speed, TCP/IP network capable modules are available in this optional module group.

**Special Module Group**
This module group contains Black Box modules to be “filled” with worksheet segments and with Export/Import modules which establish connections for data transfer between the main worksheet and the Black Box worksheet embedded in it. It also provides the Black Boxes that were saved to disk. Additionally, it includes modules that provide special functions, including the Action, Message and Time Base modules, as well as the Signal Adaptation module.

**Add-On Module Group**
When installed, the Add-On modules appear in the module menu. The following modules are available: Weighting, Transfer Function and Convolution. See Module Reference Guide for details.
Chapter 4: Main Menu

1. Worksheet Window Menu

1.1. File Menu

The commands of the File menu enable you to save, open and print worksheets, to manage your worksheet files, and to exit the program. Some of these functions can also be chosen by clicking on the corresponding icons on the Function Bar. The ellipsis (…) following a menu command indicates that a dialog box or submenu will appear when the command is selected.

- **New**
- **Open…**
- **Save**
- **Save As…**
- **File Info…**
- **Print…**
- **Printer Setup…**
- **Page Format…**
- **Exit**

### 1.1.1 New

*Choose the New command from the File menu, or click this Function Bar icon to create a new worksheet.*

This command will open a new worksheet. If you have a worksheet open and have not saved it, you will be asked to:

- save that worksheet before beginning work on the new one,
- or to reject those changes,
- or to recall the New command.
After creating the new worksheet you can save it to a file by selecting the Save or the Save As... command from the File menu.
You can also click on the Save icon in the Function Bar to save the current file.

1.1.2 Open...

Choose the Open command from the File menu, or click this Function Bar icon to open a previously saved worksheet.

If you have a worksheet open and have not saved it, you will be asked to save that worksheet before beginning work on the new one.

After choosing the Open command you can select from a list of files using standard Windows dialog boxes. The default file extension for DASYLab worksheet files is .DSB.

You can ...

- Open one of the files from the list directly by double-clicking the file name,
- Select a different directory by double-clicking the directory name,
- Select a different file format for the file display, or
- Select a different drive.

To use your keyboard, press the TAB or the SHIFT+TAB keys to move from one field to another; select items from the lists by pressing ↑, ↓, SPACE and the ENTER key.

In the File Name box you can define the filter for the file list. The default setting for the filter (*.DSB) will create a list of DASYLab worksheet files, which usually have the extension .DSB. DASYLab can also load files with the extension *.DSA (DASYLab ASCII file). This format is used to exchange worksheet files between the 16 and 32 bit DASYLab versions. These files may have also other extensions such as *.txt, but to be interpreted correctly, the contents MUST follow the conventions of the DASYLab ASCII file type.

You can type a different extension, or use wildcards (like *.*), to get lists of different groups of files. For example, you may do this if you have saved DASYLab worksheets with extensions other than .DSB.

DASYLab can only open files in its own .DSB or .DSA format, no matter what extension the files have.

If Password Protection is active, you will first be asked to enter the password unless you have already entered it. Without the correct password, the file will not be opened.
When you save a worksheet, the current Module Bar configuration is saved with it. When you open a worksheet file, its Module Bar configuration will replace the current one on your screen. If you prefer to retain the current configuration, disable the Replace Module Bar option in the Options menu.

You can specify a standard directory for DASYLab worksheet files in the Options menu.

To create a new worksheet, select the New command from the File menu, or click the New icon in the Function Bar.

1.1.3 Save

Choose the Save command from the File menu, or click this Function Bar icon to save a worksheet.

If you have created a worksheet without saving it to a file, the Save command will act like Save As... If this were a previously saved worksheet, the existing file will be replaced without further messages.

The following settings are saved with the worksheet:

- The current Module Bar configuration
- All the entries in the File Info dialog box
- All the entries in the Page Format dialog box
- The settings for Display Window Arrangement
- Text strings, with locations of where they were placed in the display window

The following settings are not saved with the worksheet.

- The settings for the Start/Stop at Time functions (Experiment menu)
- The settings for the Auto Start function (Experiment menu)
- The settings for the display of the Module Bar, the Function Bar and the Animation function (View menu)
- The Options Menu settings for the Window Setup, Colors, the Auto-router functions

You can specify a standard directory for DASYLab worksheet files (Options menu command).

To save the worksheet with a new file name, select the Save As... command from the File menu.
If Password Protection is active (Options menu, see page 4-47), the worksheet will be protected using the specified password. If a password has not yet been defined, you will be asked to specify it when the worksheet is saved.

To save the worksheet with a different file name, select the Save As... command from the File menu.

1.1.4 Save As...

Choose the Save As command from the File menu to save a worksheet under a new file name, in a different directory, or on a different drive.

See the previous section for a list of the settings and parameters that will be saved together with the worksheet.

After you have chosen the Save As... command from the File menu you can select the file name, the directory and the disk drive where the file is to be stored.

- Type the file name in the File Name box. Note that the file name must be chosen in accordance with MS-DOS conventions.
- If you do not type an extension, DASYLab will automatically add the standard extension (.DSB). DASYLab always saves worksheet files in its own format, even if you select an extension other than .DSB.
- You can...
  - Select one of the file names in the list by double-clicking the file name. The file that was originally saved under that name will be replaced with the new worksheet. A warning message will first appear, asking you to either confirm the procedure or to cancel it.
  - Select a different directory by double-clicking the directory name.
  - Select a different drive for the new file.
  - In the List Files of Type box you can select the type of files (defined by their extension) to be listed.
  - Save the file as DASYLab binary file (.DSB) or DASYLab ASCII format for interchange (.DSA).
  - Save the file as DASYLab worksheet documentation (.TXT or .HTML)

To use your keyboard, press the TAB or the SHIFT+TAB keys to move from one field to another; select items from the lists by pressing ↑, ↓, SPACE and the ENTER key.

You can specify a standard directory for DASYLab worksheet files (Options menu command).
To save the worksheet under its current file name, use the Save command from the File menu.

To quickly save the current file, click the Save icon on the Function Bar.

If password protection is active (from the Options menu), the worksheet will be protected by a specified password. If the password has not yet been defined, you will be asked to specify it when the worksheet is saved.

DASYLab always saves worksheet files in its own format, even if you select an extension other than .DSB.

1.1.5 File Info...

Choose the File Info command from the File menu, or click this Function Bar icon to display, enter, or modify information about the open worksheet.

DASYLab will automatically provide the following fields. The user cannot modify these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet</td>
<td>The file name of the current worksheet</td>
</tr>
<tr>
<td>Created</td>
<td>The date and time the worksheet was created</td>
</tr>
<tr>
<td>Modified</td>
<td>The date and time the worksheet was last saved to file</td>
</tr>
</tbody>
</table>

You can add the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Information</th>
<th>Max. Number of Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author</td>
<td>Your name</td>
<td>50</td>
</tr>
<tr>
<td>Company</td>
<td>Your company</td>
<td>50</td>
</tr>
<tr>
<td>Department</td>
<td>Your department</td>
<td>50</td>
</tr>
<tr>
<td>Title</td>
<td>A descriptive worksheet title</td>
<td>80</td>
</tr>
<tr>
<td>Info Text</td>
<td>Additional informative text</td>
<td>4000</td>
</tr>
</tbody>
</table>

To begin a new line in the Worksheet Info Text field, press CTRL+ENTER.

To move from one field to the other, either use your mouse, or press the TAB or SHIFT+TAB keys.

Click on the Clipboard button to copy all of the information to the Windows Clipboard.

All the File Info entries will be saved with the worksheet when you choose Save or Save as... from the File menu. The Author, Company, and Department information is also stored in the DASYLAB.INI file.
When you print a worksheet or the display of a module from the Display module group, you can include the information about Author, Company, Department, Title, and Worksheet file name from the File Info dialog box. Choose Page Format from the File menu to select the information you wish to include in the printing.

### 1.1.6 Print...

Choose the Print command from the File menu.

Choose Page Format from the File menu to select additional worksheet information you wish to include on the printout, and to specify the page layout and page frames.

Choose Printer Setup from the File menu to select paper size and paper source, orientation, printer resolution, and other specific settings for your active printer model.

**DASYLab** only prints to the default Windows printer. To use a different printer connected to your system, or to install and configure a new printer, choose the Printers option in the Windows Control Panel. Refer to your Windows documentation for further information.

### 1.1.7 Printer Setup...

Choose the Printer Setup command from the File menu to select paper size and paper source, orientation, printer resolution, and other specific settings for your active printer model.

These settings are also valid when printing Layout Windows. You should pay attention to the settings of the Layout Window, especially the page orientation.

The options vary, depending on the printer you are using.

- Change the specifications as needed.
- To set options specific to your printer driver, choose the Options button, set the options as needed, and then choose the OK button.
- For information about the printer-driver options, choose the Help button or press F1 while using the dialog box.
- Choose the OK button.

Some Printer-Drivers allow you to choose user defined page formats. If the minimum useable size (depending on the printer type) is under run, the printer will not print. So if your printer will not work, check the settings in printer dialog box and enlarge the size of page or use one of the preset page formats (e.g. A4, letter...).
### 1.1.8 Page Format...

Choose the **Page Format** command from the **File** menu to format printing. The settings affect the following print commands:

<table>
<thead>
<tr>
<th>Printout of...</th>
<th>Source module</th>
<th>Print command from module menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet</td>
<td>(Work area)</td>
<td>File (Main Menu Option)</td>
</tr>
<tr>
<td>Y/t chart</td>
<td>Y/t Chart</td>
<td>Display</td>
</tr>
<tr>
<td>X/Y chart</td>
<td>X/Y Chart</td>
<td>Display</td>
</tr>
<tr>
<td>Diagram</td>
<td>Chart Recorder</td>
<td>Display</td>
</tr>
<tr>
<td>List of values</td>
<td>List Display</td>
<td>Edit</td>
</tr>
</tbody>
</table>

You can select additional information to include in the printout, and you can specify the page layout and page frames.

The upper part of the dialog box mirrors the basic layout of the printed page.

**View port**

The actual information or display that is to be printed is indicated in the center of this area. Depending on the source module from which the printing will be activated, the worksheet, the graphic display, or the list of values will be positioned here.

The final size of this area on the printed page is defined by the paper size, minus the selected paper frames, and minus the space required for any additional information. The actual display will occupy the entire page if you select no additional information. The more information you select, the smaller the space remaining for the actual display.

**Additional Information**

- In the text box and the check boxes above the **View port** area you can select the information that will be printed above the display at the top of the page.

- In the text box and the check boxes below the **View port** area you can select the information that will be printed below the display at the bottom of the page.

You can enter one text line of up to 80 characters in the text boxes.

Select information already entered and saved elsewhere.

- The **Experiment Title**, **Author**, **Company**, and **Department** will be printed as entered in the corresponding text boxes of the **File Info** dialog box from the **File** menu (see page 4-5). Commas will separate the printed information about Author, Company, and Department.

- The date and the time of the printing will be printed at the position indicated by the **Date/Time** check box.

- The **Worksheet Name** to be printed is the file name of the current worksheet.
When you select Description the worksheet file name will be printed when you print the worksheet itself. The Worksheet Info Text from the File Info dialog box will not be included in the printout.

When you wish to print a graphic display or a list of values, the module description printed will be the Description text box of the source module’s configuration dialog box. This dialog box appears when you double-click that module symbol on the worksheet.

Page Frame

Set the margins for the printed page. These are the distances between the paper edge and the printed area of the paper. The measurement system is always centimeters. The default settings are 2.54 cm (one inch) or the values last saved with a worksheet.

Printer...

Click this button to select paper size, source, orientation, printer resolution, and other specific settings for your active printer model. This function is the same as the Printer Setup command from the File menu.

All the Page Format entries will be saved with the worksheet when you choose Save or Save as... from the File menu.

1.1.9 Exit

Choose the Exit command from the File menu to close DASYLab.

You can also exit DASYLab by double-clicking the system control button in the upper left hand corner of the DASYLab window, or by pressing ALT-F4.

If you have not saved or have changed the worksheet in the work area, you will be asked whether you want to save the changes or not, or cancel the exit request.

The following settings are saved when you close DASYLab:

- Size and position of the DASYLab window on your screen
- The Module Bar configuration
- The information about Author, Company, and Department from the File Info dialog box
- The Autostart option (Experiment menu)
- The Animation option (View menu)
- The display settings of the Module Bar and the Function Bar
- The Window Setup (Options menu)
- The Color settings (Options menu)
- The Autorouter option (Options menu)
- The Password Protection option (Options menu)
If there is a worksheet on the screen which you have changed since you last saved it, you will be asked to either save that worksheet now before exiting DASYLab, or to reject those changes or to recall the Exit command (Cancel).

You can also exit DASYLab by double-clicking the system control button in the upper left hand corner of the DASYLab window, or by pressing ALT+F4.

1.1.10 Recently Used File List

The worksheets displayed as numbers 1 to 5 in the File menu contain the five worksheets worked on last. The list is automatically rebuilt when loading any worksheet and is stored when the program is closed.

1.2. Edit Menu

The commands of this menu allow you to copy the DASYLab worksheet displayed on the screen to the Windows Clipboard and to configure the Module Bar according to your specific requirements. It also provides the functions necessary to organize Black Box files.

Worksheet to Clipboard

Black Box Module
  Save As…
  Load…
  Black Box Info
  Back to Main Chart / To Next Higher Black Box Level

Layout to Clipboard

Layout
  Save As…
  Load…

Module Bar

New
Open…
Save As…
Set to Default

Undo

Cut

Copy

Paste
1.2.1 Worksheet to Clipboard

Use the **Worksheet to Clipboard** command from the **Edit** menu, or click this icon on the Function Bar to create a Windows Metafile image (WMF/CLP) of the worksheet on the Clipboard.

The worksheet is always copied to the Clipboard as displayed on screen, including any changes you have made since last saving it.

The worksheet background is not copied, even if you have selected a color and a grid for it. For further information on these options, see Customizing the DASYLab Screen.

The image on the Clipboard is automatically scaled to the size of the DASYLab worksheet. If the worksheet consists of only a few modules these will appear larger on the Clipboard than if you have used a large number of modules all over the worksheet.

Use the **Paste** function provided in any Windows application (usually in the **Edit** menu) to transfer the metafile from the Clipboard to applications such as Paintbrush or Word for Windows for further use.

1.2.2 Black Box Module

Use the **Black Box** module to create worksheet elements frequently required in your experiments, integrate them into one module (the Black Box) and insert them into future worksheets as ready-to-use units. Similar to an integrated circuit, a Black Box module contains a portion of the worksheet.

Use Black Box modules to implement standardized modules that perform customized algorithms not provided by DASYLab. These menu commands provide all the functions necessary to organize Black Box files.

For further information on the modules themselves, on how to create and edit Black Box worksheets, and on the corresponding **Module** menu commands refer to Module Reference Guide.

**Save As...**

To save a Black Box:

- First, open the Black Box you wish to save. You cannot save a Black Box while the DASYLab main chart is active.
- Make sure you have entered a Module Name and an ID Tag in the Black Box Info dialog box.
- DASYLab can only list a Black Box file on the Module menu if a Module Name has been entered for that Black Box before saving it.
- DASYLab can only install a Black Box icon on the Module Bar if an ID Tag was entered for that Black Box before saving it.
The Black Box Info dialog box will appear when you try to save the Black Box if the identifying tag is missing.

- Then choose Save As... from the Black Box Module submenu of the Edit menu. Specify the Name, Directory, and Drive of the file to be saved. DASYLab automatically adds its standard extension for Black Box files (*DBB).

If you save a worksheet containing a Black Box, a complete copy of the Black Box will be included with the worksheet.

If you modify the original Black Box file independently, the Black Box saved with the worksheet will not be updated. To insert the new version first delete the previous Black Box version from the worksheet.

The advantage to this system is that if you modify or delete the Black Box file, it will not cause errors in the worksheets incorporating (and possibly based on) the functions and settings of the original Black Box.

**Black Box Info**

Enter descriptive texts and identifying tags for the Black Box module.

- The Module Name identifies the module symbol in the worksheet.
  - The Black Box module symbol in the main chart (or the preceding worksheet level) displays its name in its Title Bar.
  - The first 20 Black Box files in the DASYLab directory (not the Worksheet directory!) automatically appear as menu items on the Black Box module submenu of the Module menu after the program has been started. Their Module Names appear as menu commands.

- Enter a short comment in the Description box to describe the functions implemented by the Black Box.

- The ID Tag is a string of up to 3 characters that is used to identify the Black Box module in the Module Bar. The Module Bar icon representing that Black Box displays that tag.

A Black Box can only be saved if the ID Tag has been entered. The Black Box Info dialog box will appear when you try to save the Black Box if the identifying tag is missing.

**Back to Main Chart / To Next Higher Black Box Level**

You can insert another Black Box module in a Black Box worksheet. The module can then contain a Black Box module, and so forth, down to any level. Thus, the worksheet becomes three-dimensional, with the Main Chart (the actual DASYLab work area) and several subordinate Black Box levels, each one embedded into the preceding level.
You can open any Black Box by clicking its module symbol on the worksheet; you can leave it again to return to the next higher worksheet by clicking this Function Bar icon, or by choosing the command from the Black Box Module submenu on the Edit menu.

The command can have two names: either Back to the Main Chart (if the current Black Box is an element of the Main Chart), or To Next Higher Black Box Level (if the current Black Box is itself an element of another Black Box worksheet).

After a Black Box has been closed, the worksheet on the next higher level is displayed.

If you start an experiment from a Black Box worksheet, the program will first return to the Main Chart before acquisition begins.

You can enter a Black Box and activate its worksheet for editing by double-clicking its module symbol on the worksheet.

By default the worksheet of a new Black Box has a blue background. Color settings can be selected individually for each Black Box. Choose the Colors command from the Options menu to do so.

Background color can be used as an indicator of the Black Box level. It will be easier to find your way through several worksheet levels without losing orientation by attributing a different background color to each of these levels.

### 1.2.3 Layout to Clipboard

Use this command to copy the Layout Window as a Windows Metafile (WMF/CLP) to the Clipboard.

The layout is always copied to the Clipboard as displayed on screen, including all the changes made since last saving it. The Layout will not be modified.

The size of the Layout Window in the Clipboard is automatically matched to the size of the area used on the DASYLab worksheet. If you arrange only a few small elements they will appear larger on the clipboard.

Use the Paste function in any Windows application (usually in the Edit menu) to copy the metafile from the Clipboard to applications such as Paintbrush or Word for Windows.

### 1.2.4 Layout

Save as...

Use this command to save a Layout Window with a new name or to place it into another directory.

You can select the file name, the directory and the disk drive where the file is to be stored.
Type the file name in the File Name box. (Note that the file name must be chosen in accordance with MS-DOS conventions.)

If you do not type an extension, DASYLab automatically adds its standard extension for Layout file names (*.LAY). (DASYLab always saves Layout files in a specific format, even if you select an extension other than *.LAY.)

You can...

... Select one of the file names offered on the list by double-clicking on the file name. The file will be replaced with the Layout.

... Select a different directory (double-click the directory name)

... Select a different drive for the new file

... You can select the type of files in the List Files of Type box (defined by their extension) to be listed in the box above.

If you wish to use your keyboard, press the TAB or the SHIFT+TAB keys to move from one field to another; select items from the lists by pressing ↑, ↓, SPACE and the ENTER key.

You can specify a standard directory for Module Bar files (Options menu command).

Load...

Choose this command to load a Layout previously saved to a file.

Type the file name in the File Name box. (Note that the file name must be chosen in accordance with MS-DOS conventions.)

You can...

... Select one of the file names presented in the list by double-clicking on the file name.

... Select a different directory (double-click the directory name),

... Select a different drive for the new file.

... You can select the type of files in the List Files of Type box (defined by their extension) to be listed in the box above.

If you wish to use your keyboard, press the TAB or the SHIFT+TAB keys to move from one field to another; select items from the lists by pressing ↑, ↓, SPACE and the ENTER key.
1.2.5 Module Bar

The Module Bar, at the left of the DASYLab window, displays a selection of frequently used modules in icon form.

Use the left mouse button to click the icon for the module you want to add to your worksheet or select the module from the Modules menu. Since there are only a limited number of spaces on the Module Bar, not every module can be displayed.

You can customize the Module Bar by clicking on a square in the Module Bar with the right mouse button to assign any of the modules available in DASYLab to that button. You can customize a Module Bar for individual experiments.

The menu commands provide the functions necessary to modify the Module Bar for your requirements and to organize the Module Bar files.

- **New** provides a blank Module Bar to be configured
- **Open…** opens a saved Module Bar
- **Save As…** saves the current Module Bar configuration to a file under a name of your choice
- **Set to Default** opens the default Module Bar

To enlarge the work area for your worksheet, Remove the Module Bar from the screen. The visible work area will extend to the left border of the DASYLab window. Use the Module Bar command on the View menu to remove and to re-display the Module Bar (see page 4-38).

After you have removed the Module Bar, you can still use all the modules by choosing the Module menu commands.

All of the Module Bar settings are automatically saved with information about the window size and position when you exit the program and when you choose the Save or Save As… commands from the File menu.
New

Choose this command to create a new Module Bar. The current Module Bar on the DASYLab screen will be cleared and you can assign the module of your choice to each button.

Click on a square in the Module Bar with the right mouse button to assign any of the modules available in DASYLab to that button. A dialog box appears presenting the complete list of modules including their Module Bar icons.

- To select a module in this list, type the first letter of its name to move to the first matching module. Type the letter again to move to the next module that starts with that letter.
- Click the Help button to obtain information on the selected module.
- Choose OK, or press ENTER, to install the selected module on the Module Bar. The Module Bar will now display the new icon.

The Module Bar settings are automatically saved when you exit the program.

Open...

Choose this command to open a saved Module Bar.

You can select the Module Bar file from a list of files presented in a dialog box, using the standard Windows conventions. The default file extension (.DML) will be used to create a list of DASYLab Module Bar files.

Type a different extension here if you have saved DASYLab Module Bars with extensions other than .DML.

DASYLab can only open Module Bar files in its own DML format, no matter what extensions the files have.

When you open a Module Bar file, any modifications of the current Module Bar on the screen are lost, unless you have saved them using the Save As… command from the Edit / Module Bar menu.

You can specify a standard directory for Module Bar files (Options menu command).
Save As…

Choose this command to save the current Module Bar on the DASYLab screen to a file.

You can select the file name, the directory and the disk drive where the file is to be stored. If you do not type an extension, DASYLab will add the standard extension for Module Bar file names (.DML).

You can specify a standard directory for Module Bar files (Options menu command).

Set to Default

Choose this command to open the default Module Bar configuration onto the DASYLab screen.

The default Module Bar will be installed without further dialog. Any modifications of the current Module Bar on the screen will be lost, unless you have previously saved them.

The default Module Bar is not saved in a DML file but is saved internal to the program. Therefore, you cannot change its setup.

The DASYLAB.DML file always contains the Module Bar configuration that was active when you last exited the program.

1.2.6 Undo

Choose this command to undo the last autorouter operation (moving or connecting modules).

Other worksheet changes like changing module settings, adding or deleting module input or output channels cannot be restored. Choose this function using the menu or by the ALT+Backspace key combination.

1.2.7 Cut, Copy, Paste or Delete Flow Chart Parts

Modules and module groups with connections can be deleted, moved or duplicated.

Selection: First select the modules: click and hold the left mouse button inside the worksheet and select the area by dragging the cursor across the area. When you release the mouse button, the selected modules are highlighted. You can select or deselect single modules by clicking the left mouse button on the module while pressing the SHIFT or CTRL key.

Cut: To move modules around the worksheet, choose the Edit/Cut menu command or the SHIFT+DEL or CTRL–X key combinations. All connections to unselected modules are deleted.
Copy: Choose the Edit/Copy menu command or the CTRL-INSERT or CTRL-C key combinations. The selected modules will be inserted onto the worksheet with their channel settings intact.

Paste: Paste the stored worksheet part by choosing the Edit/Paste menu command or by pressing SHIFT+INSERT or CTRL-V at any position on the worksheet. After activating the insert mode, the mouse cursor changes. Choose the position where the selection should appear. The entire worksheet can be used. The window is scrolled automatically when the mouse cursor moves outside the window border. Once the mouse cursor is at the destination press the left mouse button to paste the cut chart modules into the worksheet, if there is enough room for the operation. The paste operation can be repeated.

You can use the cut and paste function to integrate worksheet parts into a black box, but references to those modules in Actions will need to be edited to reflect the new name.

You cannot cut or copy hardware modules, including analog/digital inputs, outputs, counter modules or black boxes.

1.2.8 Delete

Choose the Delete menu command or the Delete key to delete the selected modules.

1.2.9 Search for Module

This function offers you an easy way to find each module used in complex worksheets. This menu item opens a list box, in which all used modules are listed (including their position in black boxes). Double mouse click on one of the listed modules to move to the module and mark it. This function is also available in the popup menu that will be open with a left mouse click on any empty area of the worksheet.

The modules may be sorted by name, module type or by Black Box.

Double click on one of the listed modules to move to the module and mark it. This function is also available in the popup menu that will be open with a left mouse click on any empty area of the worksheet.

The Open Button at the bottom of the list window opens the Properties dialog box for the selected module.

1.3. Module Menu

Full details for each module are in the DASYLab Module Reference Guide, published as a separate volume.
1.3.1 Module Groups

Use the Module menu functions to select any of the modules provided by DASYLab to insert into your worksheet.

Within the Module menu, select a Module Group. A Module Group is made up of a number of modules providing similar functions. The Module menu provides the following module groups:

- Input/Output
- Trigger Functions
- Mathematics
- Statistics
- Signal Analysis
- Control
- Display
- Files
- Data Reduction
- Network*
- Special
- Add-On**

1.3.2 Modules

Choose a module group to display a submenu with the individual modules belonging to that group. Modules that are available in the DASYLab basic version or the full (+) version are indicated by the ⊗ or the ⊙ symbols as described in Chapter 1.

Module Symbols

A module represents a functional element in the DASYLab experiment setup (worksheet). A worksheet can contain up to 256 modules. Each Black Box module can also contain up to 256 modules, including other Black Box modules. The functions symbolized by the modules provide all the operations required for an experiment,

⊙ From data acquisition (by a data acquisition board) or signal generation (simulated by a virtual generator)

* This Module Group is available only with DASYLab-Net
** This Module Group is available only with the purchase of the Optional modules.
To data analysis, evaluation and processing (mathematics, statistics, control, trigger and other functions)

Up to their presentation on screen (display instruments) or export for documentation purposes (printer, metafile, etc.).

Each of the available modules in DASYLab is shown in two forms, both indicating the module’s function: Module Bar icons and worksheet symbols.

A limited number of module icons can be installed on the Module Bar. They can be placed on the worksheet by a single mouse click on the Module Bar icon. Any module can be installed on the Module Bar, including Black Boxes that you have previously saved.

You can configure the Module Bar according to your specific requirements. You can save various configurations to files for later use. For details, please refer to Chapter 4 of this manual.

Installing Modules

A module can be installed on the worksheet either by choosing it from the Module menu or by clicking its icon on the Module Bar. Either way, the module will be placed on the worksheet as a module symbol. For modules that provide more than one basic operation, you must also select the function type.

Choose a Module Group from the Modules menu to display a submenu with the individual modules that belong to that group. The submenus list all the modules currently available. You can select any of the modules by clicking on its name. If a module is not available in your version of the software it will be gray, and you will be unable to select it.

A worksheet can contain up to 256 modules, including Black Box modules.

Configuring Modules

Use the left mouse button to double-click on the module’s worksheet symbol to open the Properties dialog box to configure the module. The following parameters can generally be specified in the dialog box:

- The Module Name,
- A short Description,
- The number of inputs/outputs (up to 16 for most modules).

Once you have activated more than one channel, you can select each of them to display and define specific channel parameters.

Use the F7/F8 function keys to easily configure several channels for one module.

For specific module settings, please refer to the individual module descriptions. The general parameters are described in the Module Reference Guide. The specific module settings are described in the sections for each module.
Connecting Modules

A data channel is the connection between the output of a module and the input of another module. Data is transferred between modules via these connections. In the DASYLab work area, lines like the ones shown below show connections, which always connect the output and input symbols of the module symbols. By creating junction points and branches, you can connect each module output to up to 16 inputs of other modules.

For details on how to create, delete and rearrange data channels and branches, refer to Chapter 3 of this User’s Guide.

While the experiment is running, you can hold the CTRL Key while you left click on the data channel to get further information about the connected modules.

Moving Modules

A module can be moved to any position on the worksheet by dragging and dropping its worksheet symbol. Click on the worksheet symbol with the left mouse button and, while holding the mouse button down, drag it to any position. When the mouse button is released, the module symbol will automatically be aligned based on the spacing value entered in the Window Setup box of the Options menu.

Select Modules

Click on the worksheet symbol with the left mouse button or draw a box around the module (or modules) while holding the mouse button down. All modules within the frame will be selected.

Copy Modules

Selected modules can be copied using the Main Menu command Edit: Copy.

Paste Modules

Selected modules can be pasted into the worksheet using the Main Menu command Edit: Paste.

Deleting Modules

Modules can be deleted by double-clicking the worksheet symbol with the right mouse button. This opens a dialog box allowing you to remove the module or to delete its input or output connections. Modules also can be deleted using the Edit command of the Main Menu.
Search for Modules

You can search for installed modules with the Search for Modules command. You can select the command from the Edit menu or from the dialog box that appears when you double-click on the worksheet symbol with the right mouse button. The Search for Modules command opens a list box with all installed modules and black boxes. When you double click with the left mouse button on the desired module, DASYLab jumps to the module icon in the worksheet.
1.4. **Experiment Menu**

The most frequently required commands from this menu can also be chosen by clicking the corresponding icons on the Function Bar or by using keyboard shortcuts (Hotkeys).

- **Start** \[F5\]  
  *Start experiment*

- **Stop** \[CTRL+F5\]  
  *Stop experiment*

- **Pause/Resume** \[CTRL+F6\]  
  *Pause or resume paused experiment*

- **Start/Stop at Time…**

- **Remote Control**  
  *(DASYLab-Net only)*

- **Auto Start**

- **Select Driver…**

- **Hardware Setup…**

- **Experiment Setup…**

- **Time Base Setup**

- **Serial Devices**

1.4.1 **Start**

*Choose the Start command from the Experiment menu or click this Function Bar icon, or press F5, to start an experiment.***

1.4.2 **Stop**

*Choose the Stop command from the Experiment menu or click this Function Bar icon, or press CTRL+F5, to stop an experiment completely. All pipes will be cleared of data.*
1.4.3  Pause/Resume Experiment

Choose the Pause command from the Experiment menu or click this Function Bar icon, or press CTRL+F6, to pause the running experiment. (√ indicates that the experiment has been interrupted.)

This command stops the acquisition of new data, for example from a signal generator module, an A/D or digital input module, a PID or manual control. Data already acquired and still in the pipes will be retained, however, and processed completely.

The Pause/resume command is available only if the worksheet does not contain any module accessing the data acquisition hardware. The reason is that DASYLab derives its own clock from the board's master clock. This is not available if the measurement is paused. To pause a running experiment, use the Stop module.

1.4.4  Start/Stop Experiment at Time...

Choose this command to start, stop, and repeat an experiment at a specified time.

The dialog box that appears provides three fields where you can specify the time at which an experiment is to start, the duration of that experiment, and the interval after which that experiment is to be repeated.

Select the function by clicking its option button: Start Experiment at Time, and/or Stop Experiment after Time, and/or Restart Experiment after Time. A check mark (√) next to the option button indicates that the function has been activated.

Then enter the time specifications:

- **Start Experiment at Time/after delay**: Specify the time at which the experiment is to begin. The default setting is the current date and time plus five minutes. You may either type the values for the date, the hour, the minutes, and the seconds, or press the UP ARROW (↑) or DOWN ARROW (↓) keys to scroll, or choose the values from the dropdown list.

- **Stop Experiment after Time**: Specify the duration of the experiment. The default setting is five minutes.

- **Restart Experiment after Time**: Specify the interval after which the experiment is to be repeated. There is no default setting for this interval. When this function has been activated, the experiment will be repeated according to the specified data until you:
  - Stop the experiment, or
  - Deactivate this function by clearing the option button in this dialog box, or
  - Modify the current worksheet, or
Open or create another worksheet.

While any of the **Start/Stop by Time** functions are active, a message is displayed on the status bar reminding you of the time at which an experiment is due to start or stop.

*The settings specified here are not saved when you exit the program nor with the worksheet when you choose the *Save or Save As...* commands from the File menu.*

### 1.4.5 Remote Control (DASYLab-Net only)

The **Remote Control** Dialog box allows you to define whether this computer acts as a **Client** or a **Server**. In **Client** mode (default) you can list all controlled servers by name. This option won’t appear in **Server** mode. See DASYLab-Net: Communication with Other DASYLab Programs on page 5-11.

### 1.4.6 Auto Start

Choose **Auto Start**, indicated by a check mark (✔️), to prepare the experiment setup for an automatic start later on. Enter the DASYLab command followed by the worksheet file name (for example, in the DOS Command Line box of the Program Item Properties dialog box of the Windows Program Manager) to start the experiment directly.

See Automatic Experiment Start in Chapter 6 for further details.

*This setting is automatically saved with information about the window size and position when you exit the program. The same configuration will appear the next time you start DASYLab.*

*These settings are not saved with the worksheet when you choose the *Save or Save As...* commands from the File menu.*

### 1.4.7 Select Driver...

DASYLab supports a wide range of data acquisition hardware from different vendors. You will typically need a different hardware driver for each manufacturer’s data acquisition hardware. If you have more than one hardware driver installed on your system you may switch between them using the **Select Driver** function.

Note that only one driver can be used at a time.

The **Select Driver** dialog box lets you select one out of the installed hardware drivers. The change only occurs after exiting and restarting DASYLab.

If you do not see your hardware driver in the list, ensure that you have correctly installed the driver.
1.4.8 Hardware Setup…

*If you have installed a data acquisition device in your system, you must set its parameters in this box.*

*The values entered here must correspond exactly to the configuration of your data acquisition hardware to ensure correct data processing by DASYLab.*

Choose the Help button, or press F1, or choose Hardware from the Help menu, to obtain help on the settings.

If you have to exchange worksheets between several PC’s (as in runtime applications), you must guarantee that the selection and sequence of measurement in DASYLab is exactly the same as in your target PC.

*Read the Hardware Installation Manual for further information concerning installation and operation of your data acquisition device.*

1.4.9 Experiment Setup…

*Use this command to set the general parameters for data acquisition and measurement control.*

Together with the resources provided by your system and the size of the worksheet you have designed, these settings determine the overall data processing performance as well as the response time of the individual functions. Available settings are:

- The Sampling Rate per Channel
- The Global Block Size
  
  You can use Global Variables to define the sampling rate and block size settings. The variables are read once at the start of the experiment. You **CANNOT** use variables to change these settings while the experiment is running.

- The global settings for Analog Output and Digital Output
- The Synchronization mode that determines the clock source for all internal data sources of DASYLab (Generator, Slider, etc.). The two modes available are PC Clock and Data Acquisition hardware.
- Disk Streaming options
- The Driver Settings, which contain - depending on the installed hardware - the driver buffer size, the acquisition mode and the connected parameters Blocks per Series and Delay.
To internally equalize measurement time and system time in the analog input, digital input and counter hardware modules, use the following settings:

- Synchronization: PC clock
- Sampling rate: \( \leq 5 \text{ Hz} \)
- Block size: = 1

**Sampling Rate per Channel**

If you operate channels at differing sampling rates, enter the highest sampling rate here. The value entered here always defines the sampling rate for all the channels. You can specify whether this value represents Hertz, Kilohertz or Megahertz or minutes, seconds or milliseconds respectively.

You can also use Global Variables to define the sampling rate and block size settings. The variables are read once at the start of the experiment. You CANNOT use variables to change these settings while the experiment is running.

If you wish to operate some channels at lower rates, you must reduce the data rate by using the Separate or Average modules. This procedure yields channel rates that are true divisors of the fastest rate (the global rate).

If you set a sampling rate which is too high for the data acquisition board type in your system, or if the overall sampling rate is too high because you have too many channels at high sampling rates, you will be alerted by DASYLab, either before exiting this box, or before exiting the Analog Channel selection box. The sampling rate will automatically be rounded up or down to the nearest acceptable value.

With many of the data acquisition boards supported by DASYLab, the board itself generates the sampling rate. It is possible to enter a value not supported by the hardware. However, DASYLab will automatically adjust the value.

If you use interrupt-driven boards at acquisition speeds too high for the system, some interrupts and the corresponding samples may be missed. The indicator at the bottom left of the DASYLab window right to the buffer indicator shows whether DASYLab has detected such a situation. If this indicator flashes in yellow, interrupts have been lost, If the amount of lost samples is greater than 2\%, the experiment is aborted.

Some boards are not able to indicate lost interrupts by a hardware flag. In this case, DASYLab tries to look for lost interrupts by software. This software solution does not guarantee that all lost samples are detected. With these boards it is possible that samples are lost without any indication.
**Driver Buffer**

*Use this option to specify the temporary driver buffer memory size for the hardware driver to use to store data.*

The hardware Driver Buffer temporarily stores data coming in from the data acquisition hardware before the software processes it. The driver first stores the acquired data to this buffer, and then DASYLab reads the data from the buffer. During time-consuming operations, such as moving windows on the screen, the driver continues writing data to the buffer, so that no data is lost. Data acquisition will be stopped when the buffer memory is full. You may see the error **Sampling Rate too Fast** when this happens.

You can enter a driver buffer size between 4 Kbytes and 16,384 Kbytes. The default setting is 64 Kbytes. If the on-board memory resources of your computer are limited, enter a smaller value. You will be warned if the value you have entered is not valid.

The board driver will use the memory buffer selected; neither DASYLab nor Windows can use it.

The buffer size should be increased if you use a high global acquisition rate. Note that the driver buffer setting should not exceed 50 to 75% of the total available physical memory.

**Block Size**

*Use the Block Size to set the number of samples that will be processed by worksheet modules during a single processing cycle.*

Any value from 1 to 32768 can be entered here; powers of 2 are preferred. The input modules collect the specified number of samples before passing them on to other modules.

You can also use **Global Variables** to define the sampling rate and block size settings. The variables are read once at the start of the experiment. You **CANNOT** use variables to change these settings while the experiment is running.

Computing the data in blocks increases the speed of the measuring process considerably; but it strongly influences the real-time performance of the system. Therefore, the block size should be selected carefully, taking the following principles into account:

- For a high data transfer rate, but a long latency period where the response time of subsequent modules, like control modules, is slower, use a large block size.
- For a short latency period, where the response time of subsequent modules is faster, but the data transfer rate is lower, use a small block size.
The actual data transfer capacity of a system depends upon many factors, therefore, a general formula for how to determine the ideal block size cannot be provided.

Generally, fast data acquisition operations require large block sizes, while small block sizes work well for slow data acquisition and control operations.

We suggest that you initially set the block size to half the sampling rate (the default setting), and then try out various other values to determine the best value for your individual task.

**Acquisition Mode**

*The available Acquisition modes depend on the installed hardware and the modes supported by the driver.*

- **Continuous mode:** When continuous mode has been activated, indicated by a check mark (✓), the data will be acquired without interruption at the specified *sampling rate* and processed by DASYLab.

- **One Series:** After the experiment start, the data will be acquired without interruption at the specified *sampling rate* the amount of data defined by the parameter *Blocks per Series* setting has been reached.

- **Running Series:** This mode is a repeated one series mode. After the specified number of blocks the acquisition is interrupted for at least the time specified by delay. If the delay is too short for DASYLab to process the data, the acquisition is delayed for a longer time.

  The display modules do not recognize the delays. That means that in this mode there is no correspondence of time of day for the data samples. They are treated as continuous in DASYLab.

  This mode is especially useful for fast scope applications.

- **Isolated Series:** This is the same mode as the Running Series, except that DASYLab recognizes the gaps. The resulting data stream is not continuous.

  Quite obviously, this method leads to *acquisition gaps* between the blocks. Their size depends on the number of active channels, on the block size, on the complexity of the ensuing processing arrangement, and on the hardware resources.

  This mode may be useful in cases where a high sampling rate is essential, while continuous high-speed data acquisition and processing cannot be realized, e.g. due to limited hardware resources.

  If you wish the acquisition to stop after a certain time, enter the corresponding number of values in the *Count* field. (This value can be freely specified for each channel.) After that number of data has been acquired, the acquisition will be stopped automatically. (The default setting for this field - zero - means that the acquisition process is not supposed to be aborted when a certain number of values have been acquired.)
Analog Output and Digital Output

Set the general output parameters for analog and digital output individually.

Output Mode: The output mode determines whether the data samples are sent out synchronously with the acquisition rate or asynchronously, which means as fast as possible but in undetermined intervals.

- In the **synchronous** mode, data samples are sent out according to the acquisition rate specified for each output channel.
- In the **asynchronous** mode, data is sent out as fast as possible. The maximum rate depends on your hardware, the speed of your PC and the complexity of the worksheet. You should experiment with these rates to find out the best combination for your individual task.

Output Buffer

- If the Fill once option is selected, the output buffer will be filled only once, with the first block of data coming in after the experiment start. When the buffer is full, that first block of data will be sent out repeatedly, always beginning with the first data again. Any further values coming in from the worksheet will be ignored.
- If Continuous refill is chosen, the output buffer will continuously be filled with the data samples coming in from the worksheet, and these samples will then be sent out.
- Output Rate: The output frequency defined in this list box only takes effect when the synchronous mode is selected. Only frequencies that are an integer divider of the global acquisition rate are allowed. Changing the global acquisition rate also affects the output rate.
- Output Start: The value entered in the Output Start list box defines the number of samples that are to be collected before the analog output actually starts. This value must be the same as the global block size, or a multiple of it. This feature can be used for a defined delay or to synchronize the values that come from the worksheet.

Disk Streaming

This option enables or disables the fast storage of measurement data samples as they are acquired.

Disk Streaming provides the ability to write DASYLab data onto a mass storage media. Unlike the Save Data module that writes data of the data stream of up to 16 data channels into a file, Disk Streaming stores the data of all channels in a highly compressed 2-byte integer format. The amount of required mass storage space is reduced and the time to write the data procedure is much faster since only a fractional part of the data is produced. Additionally, the conversion of the integer data of the driver into the floating-point data of DASYLab is skipped. This is the main reason why Disk Streaming can write data sampled at high Acquisition rates to the mass storage device.
No other channels should be connected to the A/D, Digital or Counter input modules, since this would significantly reduce the time advantage.

Disk Streaming settings are made in the Experiment Setup dialog box. Disk Streaming can be enabled or disabled by checking the Active box.

Select the File Name button to change the name of the streaming file. Then, a file selection window opens to enter a file name.

You can set the Default Directory for Disk Streaming files in the Options menu.

Data samples are stored in the DASYLab data format (Universal Format 0). You can find a description of the data format in Chapter 6 of this manual.

Options

- Warning if Channels are Connected: If this option is enabled, a warning message will be issued and the measurement is immediately stopped if channels are connected to the Analog, Digital or Counter Inputs.

- Don't Overwrite Existing Files: This option prevents overwriting an existing Disk Streaming file. The measurement is stopped immediately after starting. A message is displayed if a file with the specified name exists and would be overwritten.

- Circular Buffer: This option implements an in-memory buffer, containing the last n Blocks per Channel.

Disk streaming files are read (as other data files) using the Read Data module. If the file to be loaded is a Disk Streaming file, the information Universal 0 is shown in the Data format text field of the dialog box of the Read data module. DASYLab data files written without Disk Streaming are stored in the Universal 1 data format.

Use the Channel group combo box to select which channels you want from the data stream: Analog 0 identifies the first 16 scanned analog channels, Analog 1 the next 16 scanned analog channels and so on. The same applies to Counter X. For Digital port X the selected port will always be displayed, as it was saved with the original worksheet.

Hints for Optimal Measurement Settings

Block Size/Sampling Rate

The performance of DASYLab depends primarily on the sampling rate and block size.

The sampling rate controls the resolution of the received signal (data bytes). The block size affects the response time of the worksheet. The response time is determined by the ratio of sampling rate and block size (S/B ratio). A poor setting causes data to accumulate in the driver buffer, shown by the Status Bar (the green/red bar lower right in the worksheet main window.) If the driver buffer is
filled, DASYLab displays the “Experiment stopped. Sampling rate too fast!” error message.

**General Hints for Sampling Rate and Block Size**

In the data acquisition program the data is sent as data blocks via the connected data channels between modules. DASYLab works in a block dependent mode. Each module output has a 64 Kbyte buffer to hold the processed data. The module at the end of a branch periodically checks whether a data block is available in the buffer. If the answer is yes, the block is transmitted, processed and placed in the output buffer to be processed by the next module.

Each block contains measurement data, called samples, and a block header. The header contains information about the block, including the data type, the start time of the block and the sample interval. The program calculates a time stamp for each sample. Many modules verify the time stamp and data type to ensure that only samples with the same characteristics are processed together.

Many multi-channel modules start processing data only if all inputs have data with the same time stamp. If there is no data at available one input, the module cannot process data at other inputs, and may start to block the data flow.

The module input buffer will fill until it is full. Because that module is unable to process data, the buffer of the preceding module will be filled up. The end result is that several branches of a worksheet will stop to work.

The first hint will be the “Animation bar” shown at each output in each module symbol. If the animation stops, the module is no longer processing data. Detailed information can be found in the channel debugger. Left click with CTRL key pressed on the data channel (with measurement running!). Important entries are “FIFO blocks” (max. buffer size) and “used” (buffer usage).

If you use different kinds of data in a multi-channel module (sampling rate, block size or type of channel...), the module can't process the different samples together. DASYLab will show a message like “Time information or block size is different. These channels can't be processed together.” and measurement stops.

The response time of DASYLab depends mainly on the ratio of block size and sampling rate.

- The block size defines how many samples are collected as a data packet and are sent as a block to subsequent modules.
- The sampling rate defines how fast the data is generated or acquired by the data acquisition board.

The resulting update interval of the worksheet depends on the fact that a new block will only be released and processed once it is filled with samples.

The following example will show the context:

The following response times are will be expected with different setting for block size and sampling rate.

<table>
<thead>
<tr>
<th>Block size</th>
<th>Sampling rate</th>
<th>Minimum response time</th>
</tr>
</thead>
</table>

4-31
The smaller the ratio of block size to sampling rate, the more frequently the worksheet will refresh (Visualization/Display elements).

If you use too small a block size (e.g. 1) the message ”Measurement stopped. Sampling rate too high” may appear, and the program stops!

Explanation of Response Time

When a new module is placed on the worksheet, it is placed in a module management list. The DASYLab dispatcher manages the distribution of CPU time to each module in that list. There is a physical speed limit that depends on the size of the worksheet (number of modules and data channels) and the hardware configuration of the PC, because the dispatcher has to process all modules during the refresh time. For example, take a worksheet with 100 modules/data channels and a sampling rate/block size ratio (S/B ratio) 1/1000. In this case, the dispatcher has just 1 msec to process 100 modules. Each module gets 10 µsec to process the received data. That time simply is too short, data will start to back up, and eventually the program will be halted!! An accurate examination of your experiment should define the sampling rate (resolution) of your measurement. The dispatcher’s cycle time is defined by the block size and parallels the time to process the acquired data. The block size also defines boundary conditions such as the refresh rate of the visualization elements, range of the FFT and so on.

In our experience it is advisable to select a S/B ratio from 1 to a maximum 10.

DASYLab has the option to show the system capacity usage (ratio of needed CPU time and max. available CPU time). You can see at the start at the measurement whether your system has enough capacities to fulfill the requirements of the measurement.

Hints for the resulting amount of data

The quantity of data to be transferred that loads the system also depends on the S/B ratio and increases with a rising S/B ratio. Each block of data includes a 26 Byte sized Header that has to be transferred with each block. If you use a block size of 1, the block has 4 actual data bytes and 26 bytes Header data, causing the system to transport more overhead information than actual data.

Example:

S/B ratio: 1000

Block size 1; Sampling Rate 1 kHz; 100 Data channels

Useful Bytes:
4 Byte * 1000 Hz * 100 = 400,000 Byte

Header:
26 Byte * 1000 Hz * 100 = 2,600,000 Byte

Sum:
3,000,000 Byte

S/B ratio: about 2

Block Size 512; Sampling Rate 1 kHz; 100 Data Channels

Useful Bytes:
4 Byte * 1000 Hz * 100 = 400,000 Byte

Header:
26 Byte * 1000 Hz / 512 * 100 = 5.078 Byte

Sum:
405,078 Byte

The same principle has to be considered when storing data to hard disk when using the DASYLAB file format. Long duration measurement sessions with small block sizes may create unexpectedly large files. For low speed, long duration files, consider using the ASCII or IEEE32 file formats to minimize file size. You may want to experiment with different settings to determine the optimum configuration.

1.4.10 Time Base Setup

Time Base Global Setting

Use this command to configure the available time bases for your experiment.

You can use different Time Bases to synchronize data flow.

All time base settings can be configured here. Each available Time Base generates a tab on the top of the dialog box, to directly select the corresponding time base setup.

Basically DASYLab offers two time bases:

- **PC Clock:** The standard time base is a free-running timer synchronized with the PC clock. The default setting for the sampling rate is **10Hz**, with a block size of **1**. You can change these settings to meet your specific requirements. Use this time base in modules that don’t have a direct connection to the regular driver based data flow (e.g. Switches to control actions).

- **Driver:** The driver time base is synchronized with the driver interface and is used for data acquisition with the installed hardware. The available settings depend on the installed DAQ Hardware.
There are additional DLL drivers that use their own sampling rates (NI-DAQ, NI-CAN, instruNet, etc.). If one or more of these drivers are installed, the Time Base Setup… will display additional tabs in the dialog box.

**Selecting Time Bases in a Module**

Data generating modules (such as Generator without Modulation, Switch, Slider, Coded Switch, TTL Generator, Time Base without control input, and Sequence Generator without control input) provide a setting to select one of the available time bases allowing you to synchronize the module to a specific data flow. In most cases you don’t need to use a control input or synchronization.

**Tips for using different Time Bases**

If you need a quick reaction to an event, it is recommended that you use small block sizes (1 if possible). If you set up your flowchart with a “useful” relation between sampling rate and block size (~ 1:10), you must set the block size from 100 up to 1000 using a sampling rate of 1 kHz. That block size is too large to get a fast reaction. You can now use the second time base PC Clock with a separate setting of the block size to 1.

(Also see Hints for Optimal Measurement Settings on page 4-30.)

**Time Bases of imported (reloaded) worksheets**

A time base (controlled by hardware), that was used while the worksheet was created, but is not available on the PC at the time that the worksheet is loaded, is still shown, but placed in brackets in the time base dialog.

Example: The worksheet was created on a system using the NI-CAN hardware. Now it is loaded on a PC without the NI-CAN hardware. In the time base dialog you will find the entry for the NI-CAN time base placed into brackets indicating that time base hardware isn’t available.

Regardless, all settings can be made for the unavailable time base and these settings will be stored in the worksheet. If you run the worksheet without the hardware, all modules that use that time base are synchronized to the PC clock. It is likely that they will work correctly with only a small time shift. Please use caution, and ensure that you test the worksheet with the correct hardware to ensure that all timing related functions work correctly. For example, a relay controlled by a PC-clocked switch may work correctly in this mode, but may fail when the actual hardware time base is available.

**1.4.11 Serial Devices**

You can set up multiple Serial Devices using saved configuration files. This dialog links serial devices to a saved configuration file. When you insert a Serial Input or Output module into the flowchart, available linked devices are shown in a selection list. You don’t need to load an additional configuration file.
Please note that any settings made directly in the module properties after saving a configuration file are not automatically stored with the flowchart. To save these changes you must use the Save button in the module dialog box. Please pay attention that you select the correct configuration file name linked to the selected device name.

**Selection of the Type of Serial Module**

You can select one of the available module types:

- Serial In (Master)
- Serial In (Slave)
- Serial Out

**Buttons**

- **OK:** Verifies and saves the changes and closes the dialog box.
- **Cancel:** Closes the dialog box without any changes. Any changes to settings are lost.
- **Help:** Opens the **Name1 Help.**
- **Add:** Adds a new entry to the list of predefined devices. You can name the new configuration and link an existing configuration file to that entry. If you don’t enter a name **Name1** will create a default name by using the name of the assigned configuration file. The file types to link are:
  - for RS232 Input Master module = (*.SIM).
  - for RS232 Input Slave module = (*.SIS).
  - for RS232 Output module = (*.SOU).

Use a descriptive name to save your configuration files to easily identify a specific device. Then you do not need to enter a specific name for configuration because DASYLab creates a suitable name.

- **Remove:** Deletes an entry from the list of devices. You cannot cancel the deletion in the dialog. To restore the entry, leave the dialog using the Cancel button.
- **Change:** You can rename an entry or change the link to the configuration file using that button.
1.5. **View Menu Commands**

The commands of this menu allow you to change the appearance of the DASY-Lab worksheet on the screen. You can click on the corresponding Function Bar icons to choose some of these functions.

- **Overview**
- **Animation (Worksheet View only)**
  - Block State
  - FIFO State
- **Function Bar**
- **Module Bar**
- **Status Bar**
- **All Windows**
  - Make Visible (Show)
  - Make Invisible (Hide)
  - Minimize
  - Restore
- **Select Windows**
  - Make Visible (Show)…
  - Make Invisible (Hide)…
  - Minimize …
  - Restore…
- **Save Window Arrangement**
  - ALT-x
  - Select Window Arrangement (1-8)
  - Delete Current Window Arrangement
1.5.1 Overview

Choose this option to display the complete DASYLab worksheet at a reduced size in a separate window.

The display gives you an overview of your complete worksheet. The display is automatically scaled so that the entire worksheet is shown in the window. A check mark (✓) indicates that this function has been chosen.

You cannot edit or change the worksheet in the overview window.

1.5.2 Animation

Choose these option to visualize the data flow by switching the animation (Block Status and FIFO Status) of the worksheet on or off. A check mark (✓) indicates that the function has been activated.

When Animation is active, small colored indicators in the output symbols of each module will display the data flow and buffer (FIFO) status.

Block Status: Displays the status of data block processing. The bar will toggle from red to green, indicating that the module is processing data.

FIFO Status: Choose this option to switch the animation of the FIFO Status in the worksheet on or off (✓ indicates that this function has been activated.)

When Animation is active, the load of the FIFO buffer of each module will be displayed by a bar indicator replacing the output symbols of the respective modules above the small bar indicator of the Block Status indicator). The size of the bar changes in steps of 10% depending on the load of the buffer.

To guarantee that the worksheet runs smoothly, the bar should not exceed 10%. Larger values point to data flow problems that may cause delayed actions, loss of data and, in the worst case, may force the program to stop.

Data may be processed more slowly when the Animation function is active, since graphics operations use more system resources.

1.5.3 Function Bar

Choose this option to display or remove the Function Bar below the Main Menu Bar of the DASYLab window.

A check mark (✓) indicates that the Function Bar is displayed.

The Function Bar displays a selection of icons that provide easy access to menu functions often used during experiments. Click the icon representing the function. (For a detailed description of the Function Bar configuration, refer to Chapter 3 of this manual.)

To enlarge the work area for your worksheet, remove the Function Bar from the screen. With the Function Bar removed, use the menu commands or hot-keys.
To start an experiment, for example, choose Start from the Experiment menu, or press the ALT, X, S keys, or press F5.

When the mouse pointer is pointing at a Function Bar icon, a QuickInfo tag with the name of that function will appear. You will find such tags in all of the module windows providing a Function Bar, such as the display windows of the Y/t Chart or the List Display modules.

To redisplay the Function Bar, choose this command from the View menu.

1.5.4 Module Bar

Choose this option to display or to remove the Module Bar on the left hand side of the DASYLab window.

A check mark (✓) indicates that the Module Bar is displayed.

The Module Bar displays a selection of frequently used modules in icon form. Use the left mouse button to click on the icon that symbolizes the module you want to add to your worksheet. (For a detailed description of the Module Bar configuration, refer to Chapter 3 of this manual.)

To enlarge the work area for your worksheet, you can remove the Module Bar from the screen. With the Module Bar removed, use the Module menu commands to add modules to the worksheet. For example, choose Display from the Module menu, and then choose Chart Recorder.

To redisplay the Module Bar, choose this command from the View menu.

1.5.5 All Windows

You can use the View Menu to control the state of the Display Windows. There are two mode: Visible/Invisible, and Restored/Minimized. Invisible windows are hidden from view, whether restored or minimized. Invisible windows cannot be restored or minimized. The follow commands apply to All Windows. To change one or more windows, use the Select Windows command of the View menu.

All Windows: Make Visible

Choose this function, or click the icon on the Function Bar, to show all the hidden display windows and icons contained in the worksheet as restored windows or in icon form. This command does not restore iconized windows.

To show only selected hidden display windows, see the Select Windows: Make Visible function.

All Windows: Make Invisible

Choose this function or click on the icon on the function bar, to hide all display windows contained in the worksheet. Minimized windows (represented by an icon at the bottom of the screen) are also hidden.
To hide selected display windows, see Select Windows: Make Visible function.

**All Windows: Restore**

Choose this function or click on the icon on the function bar, to restore all the minimized display windows contained in the worksheet. This command has no effect on invisible windows or icons.

*When you first activate several display windows of the same type (e.g. Y/t Charts or Bar Graphs) using this function, they will all be automatically opened in the center of the screen, on top of each other. Drag the top window to one side to view the next display window.*

All the minimized display windows will be restored. To restore only one display window, double-click its icon at the bottom of the computer screen or choose Select Windows: Restore from the View Menu.

**All Windows: Minimize**

Choose this function or click on the icon on the function bar, to minimize all activated display windows contained in the worksheet.

To minimize one display window, click its Minimize button (in the upper right-hand corner of the display window).

To re-activate all the display windows contained in your worksheet, choose Normalize Display Windows from the View menu, or click the corresponding Function Bar icon.

### 1.5.6 Select Windows

You can use the View Menu to control the state of the Display Windows. There are two modes: Visible/Invisible, and Restored/Minimized. Invisible windows are hidden from view, whether restored or minimized. Invisible windows cannot be restored or minimized. The follow commands apply to one or more selected Windows. To change all windows, use the All Windows command of the View menu.

To select more than one window at a time, use the standard windows controls: click and drag to select a contiguous range of lines; SHIFT-click to select contiguous lines; or CTRL-click to select any two or more lines.

**Select Windows: Make Visible**

Choose this function to open a list box with all hidden (incredible) display windows or display icons contained in the worksheet. To show one or more display window, select them from the list. Press the OK button to accept the selection and leave the dialog box. The selected will be shown as a restored window or an icon, depending on the state that it was in when hidden.
Select Windows: Make Invisible

Use this function to hide one or more display windows or icons. A list of all visible display windows and icons will be listed. To hide one or more display windows or icons, select them from the list, and press OK to accept the selection and leave the dialog box.

Select Windows: Restore

Use this function to open a list box with all visible iconized windows. To restore one or more display windows, select one or more from the list and press the OK button to accept the selection. The selected windows are restored and shown as windows.

Select Windows: Minimize

Choose this function to open a list box with all visible restored display windows. To minimize one or more display windows to an icon, select them from the list and press the OK button to accept the selection. The selected windows are minimized and shown as icons at the bottom of the Windows Desktop.

1.5.7 Window Arrangements

Save Window Arrangement

Choose this function to save the sizes and positions of all the activated display windows and to define an identifying tag for that arrangement.

Use this function to easily switch between different display window arrangements even while an experiment is running. You can save up to 8 different display window setups.

To activate this function,

- Press ALT+SHIFT+Arrangement Number (1–8) on your keyboard, or
- Choose the Save Window Arrangement command from the View menu.

The Window Arrangement dialog box appears, displaying the Arrangement Number and Text either of the current setup, or, if you have used the keyboard shortcut, of the setup whose number you have typed after ALT+SHIFT.

You can now save the current arrangement under any Arrangement Number from 1 to 8 and add a name or short description of your choice in the Text field. Click OK, or press ENTER, to complete the procedure. If an arrangement has already been saved under this number, you will be warned.

The name or description you have entered in the Text field appears in the list of window setups on the Function Bar.

Choose Select Window Arrangement to re-arrange the display windows in one of the arrangements you have previously saved.

Choose Delete Current Window Arrangement to delete the current setup from the list of saved arrangements.
Select Window Arrangement

Choose this function to re-arrange the activated display windows on the screen in one of the arrangements you have previously saved. Each of the activated display windows appears in the same position and size as previously saved. Additional display windows (not contained in the arrangement when it was saved) remain in their positions while the others return to their defined places on the screen.

To activate this function,
- Click on the list box on the Function Bar (or on the down arrow on its right), or
- Press ALT+0 on your keyboard, or
- Choose the Select Window Arrangement command from the View menu.

In the Function Bar list box, the nametags of all the saved arrangements are listed. Click on the name of the arrangement that you want to restore, or choose that tag by pressing the arrow keys on your keyboard; then press ENTER.

Using a keyboard shortcut, you can select any of the saved arrangements by pressing ALT+Arrangement Number (1–8).

- If you restore one of the saved window arrangements as described, the sizes and positions of the current display windows will be lost, unless you have saved them under another Arrangement Number.
- If you delete one of the display modules contained in the saved window arrangement from the worksheet, its display window is permanently removed from the saved arrangement, too. To restore the original setup, you must re-install the display module in the worksheet, and save the display window arrangement again.

Choose Save Window Arrangement to save the current sizes and positions of all the activated display windows.

Choose Delete Current Window Arrangement to delete the current setup from the list of saved arrangements.

Delete Current Window Arrangement

Choose this function to delete the currently displayed setup of display windows from the list of saved arrangements.

Only the information concerning the sizes and the positions of the display windows are removed; the display windows themselves remain in the worksheet unchanged.

To activate this function, press ALT+CTRL+Arrangement Number (1–8) on your keyboard, or choose the Delete current Window Arrangement command from the View menu. You will be asked to confirm your decision before the information is actually deleted.
Choose Save Window Arrangement to save the current sizes and positions of all the activated display windows.

Choose Select Window Arrangement to re-arrange the display windows in one of the ways you have saved before.

1.6. Options Menu

The commands of this menu allow you to change the display of the DASYLab worksheet and to switch the Autorouter function on and off.

- Global Setup…
- Directories…
- Default Fonts…
- Colors…
- Autorouter
- Password Protection…
- Password Definition
- Screen Locking
- Key Events…
- List of Actions
- Overview of Actions
- Define Global Strings…
- Define Global Variables…
- Copy Channel Names
- Switch to Runtime

1.6.1 Global Setup…

Choose this command to change the DASYLab screen settings and program start options.

The settings are automatically saved when you exit DASYLab. The same window setup will be used the next time DASYLab is started. These settings are not saved with the worksheet when you choose the Save or Save As… commands from the File menu.

Window Type

Select this option to place a background grid on the worksheet.
**Type of Grid**
- Dots  The grid intersections will be marked by dots.
- Lines  A complete grid will be displayed.

**Spacing**
Choose a value between 8 and 48 points to specify the minimum distance between the module symbols in the work area and to specify the size of the screen grid.

After setting the spacing, new modules will be placed using this setting. When the spacing value is changed, it will not affect the layout of existing modules on the worksheet. When you move a module, it will be positioned using the new settings.

The spacing value should be at least 16 points, to ensure that there is enough space for data channels between the module symbols.

**Start Options**
- By default, **DASYLab** copyright information is displayed at program start. In the Show Copyright Information box you can choose if you wish this information to be displayed each time or not.
- When you open a worksheet, the Module Bar settings that were saved with it will be loaded, possibly modifying the current Module Bar settings that you'd rather maintain.
  - Activate the Load Module Bar with Flow Chart box if the current Module Bar configuration is to be replaced with the new one from the worksheet file.
  - Deactivate this box if you wish to retain the current Module Bar configuration whenever you open a worksheet file.

**Common Options**
- Choose Open dialog box when Module is created to automatically open the module properties dialog box when the module is added to the worksheet.
- Choose Show File Information with Flow Chart to display the **File Info** each time the experiment starts.
- Choose Show Warning if Data Stream stops to cause the program to display a message if one module isn’t able to process the incoming stream of data.
- In all write data operations, the Create Directory if Necessary option causes **DASYLab** to create the named directory when it does not exist.

**Example:**
Bad entry in Edit field:
Default Directory: C:\DASYLAB\DATA
New Directory: C:\DASYLAB\DATA\NEW-DIR
Correct entry in Edit field:
Default Directory: C:\DASYLAB\DATA
New Directory:  C:\DASYLAB\DATA\${STRING_001}

Where \{STRING_001\} contains the advanced path and file name, such as <NEW-DIR\FILE1>.

The full path of the newly created directory and file will be: C:\DASYLAB\DATA\NEW-DIR\FILE1.DDF

For example, creating new directories is useful when writing files into subdirectories with a time stamp, such as creating day, month or year to store the files into them using an event driven action.

To create the time stamp, don’t use the global string \${DATE}\, because the punctuation marks (dots) in this string may be incompatible with the Windows file structure. Instead, combine the \${DAY}\-\${MONTH}\-\${YEAR} strings and use another punctuation mark.

☑️ The Hide Flowchart Load Progress Bar option turns off the progress bar when the elements of the worksheet are loaded.

☑️ Choose Create Module via Drag & Drop to insert new modules onto your selected location on the worksheet under user control. The modules are not inserted at default places, but DASYLab first shows an insert cursor to allow you select the position the new module will be placed.

☑️ If the Release CPU time if idle Option is active DASYLab releases the reserved CPU time to other programs

Start/Stop Options

☑️ If the Save Backup Flow Chart setting is active, the current worksheet is saved under the file name LAST.DSB when the DASYLab worksheet is started.

☑️ The Copy Channel Names at Start of Experiment option enables or disables the DASYLab default setting to Copy The Channel Names of the connected modules into newly connected modules

☑️ The Switch to Displays at Start of Experiment option allows you to specify that the Worksheet view will be hidden, and the Display Window view will be activated when the experiment starts.

☑️ The Switch to Worksheet at Stop of Experiment option allows you to specify that the Worksheet view will be restored when the experiment stops.

1.6.2 Default Directories

Use this menu item to set and modify the locations of drives and directories that DASYLab uses by default for loading or saving files. Different directories can be set up for various file types.
When you select this menu item, a dialog box is opened, displaying each file type with the currently valid directory. Clicking on the respective switches can change the setup.

Default drives and default directories can be specified for the following file types:

<table>
<thead>
<tr>
<th>Item</th>
<th>File type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet</td>
<td>DASYLab worksheet files (extension *.DSB)</td>
</tr>
<tr>
<td>Streaming</td>
<td>data files for fast disk streaming</td>
</tr>
<tr>
<td>Data</td>
<td>data files of the Write Data module</td>
</tr>
<tr>
<td>Devices</td>
<td>configuration files for the serial interface and the IEEE interface</td>
</tr>
<tr>
<td>Other</td>
<td>Module Bar, Interpolation and other files</td>
</tr>
</tbody>
</table>

By clicking on a switch a dialog window opens allowing the selection of a drive and a directory. New directories can also be created here.

The drives and directories specified here are only used as defaults. If a file name must be assigned while working with DASYLab, these pre-set locations are shown in the input window for the respective file type. If required, a different drive and directory can be selected.

After the initial installation, the DASYLab installation directory is used for all default settings.

The settings made here are saved in the DASYLAB.INI file in the Windows directory.

### 1.6.3 Fonts

This option allows you to define the module display windows font style and size. Choose from the following 4 options:

- **One Font, Fixed Size**
  
  If this option is used, all text elements of the display windows use the same type of fonts. The size is fixed and is always used even if the display window is stretched or compressed. Use the Font... button to select type and size.

- **One Font, Variable Size**
  
  If this option is used, all text elements of the display windows use the same type of fonts, but the size is adapted to the proportions of the text areas of the display window if the window is stretched or compressed.

- **Variable Font, Fixed Size**
  
  This setting allows you to select several types of fonts for the elements of the display window. Use the buttons on the bottom of the dialog box to select individual font styles and sizes for these elements. The
selected fonts size is always used even if the display window is stretched or compressed.

- **Variable Font, Variable Size**
  
  This setting allows you to select several types of fonts for the elements of the display window. Use the buttons on the bottom of the dialog box to select individual font styles for these elements. The size of fonts is adapted to the proportions of the text areas of the display window if the window is stretched or compressed.

The buttons to select the different text elements in display windows depend on the kind of display window module. For example the buttons names for the Digital Display module are Channel Name..., Value... and Scale..., or while the Status Lamp module only shows Channel Name... and Status text....

If you activate these functions from the Options menu, the setting is applied to all newly created modules on the worksheet; but existing modules are not affected. You can change this default setting by opening the individual text dialog box of the modules.

- **Apply Button**
  
  Use this button to change the font of all text elements to the chosen default type. All existing modules are changed.

### 1.6.4 Colors

*Use this command to choose the colors for the DASYLab worksheet display. You can specify colors for the background, the grid and the data channels wire core and sleeve.*

The settings are automatically saved with information about the window size and position when you exit DASYLab. The settings are not saved with the worksheet when you choose the Save or Save As... commands from the File menu.

- **Standard Colors**
  
  - Select the item you want to change. The Windows color selection dialog box appears.
  
  - Click on the color of your choice in the Standard Colors palette using the left mouse button.
  
  - If you prefer to create your own custom color, click Edit Colors.

- **Edit Colors**
  
  You can create custom colors for the background, the grid and the data channels, wire cores and sleeves.

  - Select the item you want to change. The Windows color selection dialog box appears.
  
  - Click on the color you want to edit using the left mouse button.
Choose the Edit Colors button.

To increase or decrease the amount of primary color, brightness and/or saturation used in a color, drag the crosshairs and/or the vertical scroll bar keeping the left mouse button depressed.

You can also type numbers from 0 to 255 in the corresponding boxes. The resulting color is displayed in the Custom box.

To reset all the values for the standard color that comes nearest to the custom color you have just defined, double-click the Standard box.

Choose the OK button to change the color of the selected screen element to the custom color.

To save the custom color you have defined:

- Click any of the boxes in the Custom Colors palette first.
- Then modify its color as described above.
- Click Add Color to Palette.
- Specify further colors from the Custom Colors palette and modify them.
- Choose the OK button to change the color of the selected screen element to the custom color.
- To return to the color originally displayed on the screen, choose the Cancel button.

1.6.5 Autorouter

Choose this option to switch the Autorouter function on or off. A check mark (✓) indicates this function has been activated.

When the Autorouter is active, DASYLab automatically finds the correct paths for your data channels. DASYLab ensures that the data channels do not run across modules or hide other data channels. The Status Bar displays the progress of the autorouting operation.

When the Autorouter is not active, you can determine the paths of your data channels.

The Autorouter function cannot automatically rearrange existing data channels to take the shortest or most direct way between modules. You must manually rearrange a data channel or move a junction point to a different position to improve the clarity of your worksheet structure.

1.6.6 Password Protection/Password Definition

Use a password to protect a worksheet against unauthorized use or modification. A check mark (✓) indicates that this function is active.

Password protection is activated by
Clicking the Password Protection command,
Specifying the password itself by using the Password Definition command,
And then saving the worksheet.

Password protection applies to the entire worksheet. Black Boxes may also be protected via Passwords. The settings are made in an active Black Box in the Edit: Black Box Properties.

If Password Protection is activated without entering a password at the same time, you will be prompted to specify the password when the worksheet is saved.

Once Password Protection has been activated and the worksheet has been stored, it can only be opened again by entering the correct password.

This function is only relevant when you save a worksheet or use the Screen Locking function. It does not affect any other function or module.

If you have forgotten or do not know the password of a worksheet, you will not be able to open the worksheet. Take this into consideration when you choose a password, and take adequate precautions so that you will always remember your passwords.

A password must contain at least 4 and up to 10 alphanumeric characters. If the number of entered characters is less than 4, a warning message will appear when you close the dialog box.

For security reasons, the password must be entered twice. If the two passwords are not identical, you must reenter the password.

While you type the password, the characters are not echoed, but appear as asterisks (*). Password recognition is case-sensitive; the same combination of upper and lower case characters must be specified.

A correctly entered password is valid
Until you exit DASYLab, or
Until a different password is entered, or
Until you open a different worksheet requiring a different password, and you enter that new password correctly.

1.6.7 Screen Locking

Activate Screen Locking to disable all keyboard and mouse inputs after starting measurement.

To unlock, use the ESC key. If Password Protection is active, the password will be requested. You must enter the correct password to Unlock.

Screen locking also can be activated and deactivated via Event Driven Actions.

When Screen Locking is activated, Key Events, as defined in the Options Menu, are available.
1.6.8 Key Events

*Use Key Combinations to cause actions on the worksheet.*

It is possible to cause all Actions of modules that are used in a worksheet by using an Action module or using key or key combination (1 or 2 Special key + one normal key for example `CTRL+SHIFT+S`).

Select the option menu command key events. If the Show Window with defined Key Events switch is set, the window shows all defined key actions. You can hide single key events in the dialog box define key events.

The New button opens a key events dialog box where you can define parameters used by the key actions.

To change existing Key Events, choose the line and click the Change button. The dialog box will show the active parameters. Click in the parameter field to change them.

The Delete button deletes selected key action.

The Reset button deletes all defined key events.

To use Key Events you need:

- The key or key combination,
- The Receiver for the action,
- The Action itself and
- The Action-dependent Parameters

**Receiver**

The Receiver entry specifies the module that is to execute the initiated action.

- In the Module pull-down list box, all the modules in the worksheet (which can perform actions) are listed together with the DASYLab main window.

- Use Channel to specify which channel(s) of the selected module is to perform the actions. Individual channels can be separated with spaces or commas. Channel groups are entered with hyphens.

Example: To use the channels 1, 3, 7 and 9 up to 12 of the Receiver module for the event, enter: `1 3 7 9−12` or `1, 3, 7, 9−12`.

This setting does not influence actions relating to the entire module.

**Parameters**

You can define Parameter values to be used by the action (Worksheet name, Layout number, Global String, etc.).

**Screen Lock mode**

You can allow key events while Screen Locking is active. The default setting is Do Not Execute Action.
Description

While the Show Window With Defined Key Events option is active, key actions will be displayed in an overview window. The default is Display. You can insert a descriptive text string in the entry field that will be shown in the window. If the string is empty, the Action text will be displayed.

1.6.9 List of Actions

The List Actions ... item opens a dialog box that allows you to copy a description of any actions and their parameters, as defined in the worksheet, into the clipboard or to store it into a text file.

You can select one of the defined action modules from the list window. The parameters of the selected action module are shown in the display area.

You can also select one of the actions defined in the selected module. The parameters of the selected action are shown at Event Parameter, Receiver Channel and Parameter of action (Number, Value).

Buttons

- **Copy**: This button opens a dialog box to copy the data into the clipboard. You can select whether the parameters of the selected or all defined action modules are copied. Click on OK to start the copy.

- **Save**: This button opens a dialog box to save the data into a text file. You can select whether the parameters of the selected or all defined action modules are stored. The **File name** button opens the file menu to select/create the file the data become stored. Click on OK to start saving data.

The text file has the following format:

```
Module name: Action00
Channel: 0
Channel name: Action 0
Event: Rising Edge
Receiver: <DASYLAB>
Receiver Channels: All Channels
Action: Activate Layout
Layout: 1
Asynchronous action

Channel: 1
Channel name: Action 1
Event: Falling Edge
Receiver: Generator00
Receiver Channels: All Channels
Action: Change Amplitude
To: 2,0000
Asynchronous action
...
Module name: Action01
Channel: 0
```
Channel name: Action 0
Event: Rising Edge
Receiver: <DASYLAB>
Receiver Channels: All Channels
Action: Activate Layout
Layout: 2
Asynchronous action
And so on.

1.6.10 Overview of Actions

The Overview of Actions... command opens a list box, showing all Event Driven Actions defined in the actual flowchart.

The four columns show the name of the action module, the defined condition, and the event such as the receiver of the action. You can choose each of these four items to be displayed in each column. The entries in the list will be ordered alphabetically.

- **Copy**: This button opens a dialog box to copy the data into the clipboard. You can select whether the data of the selected or all defined actions are copied.
- **OK** button starts copying the information
- **Save**: This button opens a dialog box to save the data into a text file. You can select whether the parameters of the selected or all defined actions are stored.
- **File Name** opens the file menu to select/create the file where the data will be stored.
- **OK** button starts saving data.

To get more detailed information about the defined actions you can use the List of Actions... command. There you can select each action module defined in worksheet and display all of its settings and parameters.
1.6.11 Define Global Strings

Global Strings allow you to define and modify ASCII text strings used in DASYLab while a measurement is running. You can pass text strings to DASYLab worksheets running in succession (See the Working Example below). You can define up to 999 Global Strings. When the measurement is running a Global String can be defined or modified using the menu command Define Global Strings. Defined strings are stored with the worksheet.

You can display Global Strings as text objects in Layout Windows. Use the placeholder ${STRING_xxx} in the line text object. Replace xxx with the number of the string.

Several System/Program Information strings and variables (such as Free Memory, System Resources, Author, Company, etc.) are implemented in DASYLab as fixed placeholder strings/variables. If an Edit field will accept placeholders, right mouse click in the Edit field to open a Popup menu with the Global Strings displayed as a menu item. This Item opens a list with all available strings. Double-Click on the requested placeholder to insert it into the Edit field.

You can use the RS232 Input module to receive strings instead of measurement values and then assign them to a Global String.

Optionally, you can load a Global String after starting a worksheet or save a string into the DASYLAB.INI file when you stop. Other applications are able to modify strings via DDE. And, you can define, load or save a Global String using Event Driven Actions or key events.

Each Global String consists of a number, text (max. 255 char.) and options. The Reset button sets all strings in the list to the default settings. The Reset all button deletes all strings.

You can select and modify more than one string simultaneously using the SHIFT and CTRL keys to select the strings.

You can define the following Options to handle Global Strings:

- Read from INI file at start of experiment
- Write to INI file at stop of experiment
- No DDE access to Global String
- Write to data file (DASYLab or ASCII) Header
- Show Global String in window
- Type In at start of experiment
- Input is required to close dialog box
- File Name Dialog

You can also define a short description.

Extended…

Click on the Extended button to make additional settings for Global Strings.
Name: You can define a name to be used with variables and strings. You can refer to the String/Variable using the defined name: \${\text{NAME}} or by its number \${\text{VAR_xxx}} or \${\text{STRxxx}}.

Expressions: If the Calculate Expression automatically option is activated you can define a mathematical expression similar to the Formula Interpreter. The expression is allocated to the variable or string. If one of the parts in the expression is changed, the variable or string is automatically recalculated.

Each expression is a special type of data (numeric <variable> or alphanumeric <string>). You only can link string expressions with strings and numerical expressions with variables; otherwise the program generates an error message.

The numerical expressions are the same as in the Formula Interpreter.

**Mathematical functions:**

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Addition</td>
</tr>
<tr>
<td>-</td>
<td>Subtraction</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication</td>
</tr>
<tr>
<td>/</td>
<td>Division</td>
</tr>
<tr>
<td>&gt;</td>
<td>greater</td>
</tr>
<tr>
<td>&gt;=</td>
<td>greater than or equal</td>
</tr>
<tr>
<td>&lt;</td>
<td>less than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>less than or equal</td>
</tr>
<tr>
<td>=</td>
<td>equal</td>
</tr>
<tr>
<td>^</td>
<td>raise to a power</td>
</tr>
<tr>
<td>^</td>
<td>MOD</td>
</tr>
</tbody>
</table>

**Trigonometric functions:**

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \sin )</td>
<td>Sine</td>
</tr>
<tr>
<td>( \arcsin )</td>
<td>ArcSine</td>
</tr>
<tr>
<td>( \cosh )</td>
<td>Hyperbolic Cosine</td>
</tr>
<tr>
<td>( \arcosh )</td>
<td>Arc Cosine</td>
</tr>
<tr>
<td>( \tan )</td>
<td>Tangent</td>
</tr>
<tr>
<td>( \arctan )</td>
<td>ArcTangent</td>
</tr>
<tr>
<td>( \sqrt )</td>
<td>Square root</td>
</tr>
<tr>
<td>( \sqrt[x]{} )</td>
<td>Fractions</td>
</tr>
<tr>
<td>( \text{trunc} )</td>
<td>Truncate</td>
</tr>
<tr>
<td>( \text{abs} )</td>
<td>Absolute value</td>
</tr>
<tr>
<td>( \exp )</td>
<td>Exponential function</td>
</tr>
<tr>
<td>( \log )</td>
<td>Logarithm, base ten</td>
</tr>
</tbody>
</table>

**String functions: Relational Operators**

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Link/concatenate</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater or equal</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal</td>
</tr>
<tr>
<td>=</td>
<td>Equal</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Not equal</td>
</tr>
</tbody>
</table>

Results are: true=1; false=0

For comparison operations with strings, the characters of the strings are weighted corresponding to the value in the ASCII Table, shown in the ASCII Table on page C-1. The strings are checked character by character and sorted by priority.
Additional String Operations

<table>
<thead>
<tr>
<th>Operation</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>strlen</td>
<td>(String)</td>
<td>Length of strings (numerical result)</td>
</tr>
<tr>
<td>strind</td>
<td>(String, Search-string)</td>
<td>Position of the search-string in a string (numerical result)</td>
</tr>
<tr>
<td>strval</td>
<td>(String)</td>
<td>String-value, Numerical value of the strings.</td>
</tr>
<tr>
<td>substr</td>
<td>(String, Start, Length)</td>
<td>Substring, Result is a substring with defined length and start position (Start and Length are numerical and also may be expressions!).</td>
</tr>
<tr>
<td>upper</td>
<td>(String)</td>
<td>Convert characters of string to upper case</td>
</tr>
<tr>
<td>lower</td>
<td>(String)</td>
<td>Convert characters of string to lower case</td>
</tr>
<tr>
<td>strsel</td>
<td>(Condition, TrueString, FalseString)</td>
<td>Select string depending on a special condition</td>
</tr>
</tbody>
</table>

Constants

<table>
<thead>
<tr>
<th>Pi</th>
<th>e</th>
<th>Pi (π) e function</th>
</tr>
</thead>
<tbody>
<tr>
<td>True</td>
<td>Is true (=1)</td>
<td>False Is false (=0)</td>
</tr>
<tr>
<td>(</td>
<td>Open parenthesis</td>
<td>) Close parenthesis</td>
</tr>
</tbody>
</table>

Priority of Strings

<table>
<thead>
<tr>
<th>Sort =&gt;</th>
<th>1st Step</th>
<th>2nd Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>sand</td>
<td>Position 1</td>
<td>Sand(1)</td>
</tr>
<tr>
<td>Sand</td>
<td>Position 2</td>
<td>SAND(1)</td>
</tr>
<tr>
<td>sAnd</td>
<td>Position 3</td>
<td>sand(2)</td>
</tr>
<tr>
<td>SAND</td>
<td>Position 4</td>
<td>sAnd(2)</td>
</tr>
</tbody>
</table>

SAND > Sand > sAnd > sand

<table>
<thead>
<tr>
<th>Sort =&gt;</th>
<th>1st Step</th>
<th>2nd Step</th>
<th>3rd Step</th>
<th>4th Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sund</td>
<td>Position 1</td>
<td>Sund(1)</td>
<td>Sand(1.1)</td>
<td>Sand(1.1.1)</td>
</tr>
<tr>
<td>sOnd</td>
<td>Position 2</td>
<td>Sand(1)</td>
<td>Sund(1.2)</td>
<td>Sund(1.2.1)</td>
</tr>
<tr>
<td>Sand</td>
<td>Position 3</td>
<td>sOnd(2)</td>
<td>sOnd(2.1)</td>
<td>sOnd(2.1.1)</td>
</tr>
<tr>
<td>sOna</td>
<td>Position 4</td>
<td>sOna(2)</td>
<td>sOna(2.1)</td>
<td>sOnd(2.1.1)</td>
</tr>
</tbody>
</table>

Sand > Sund > sOnd > sOnd

Characters that influence the sort are bold! The priority after each step is shown in the brackets. If all strings have a different priority, the operation is aborted because the resulting step is reached.

Value of Strings

The string has to start with a numerical character or decimal point (point or comma); otherwise the string value is 0. Leading blanks are ignored. If there is a blank within a numerical string it is interpreted as an alphanumerical character. Any following numerical characters are lost.

<table>
<thead>
<tr>
<th>String</th>
<th>Value</th>
<th>String</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>1</td>
<td>.2</td>
<td>0.2</td>
</tr>
<tr>
<td>1,05</td>
<td>1,05</td>
<td>12, 35DM</td>
<td>12</td>
</tr>
</tbody>
</table>
Global Strings used in Modules

Most modules can process Global Strings. DASYLab is constantly improving, and adding places where you can use Global Strings. One way to determine if a parameter box permits a Global String is to right click in the parameter box. If the popup menu shows Global String... then you can use a string successfully in that location.

Predefined Global Strings

The global strings in the following list are predefined and are offered in selection list for quick insert:

Strings with System Information:

<table>
<thead>
<tr>
<th>String</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>${DATE}</td>
<td>Current Date</td>
</tr>
<tr>
<td>${TIME}</td>
<td>Current Time</td>
</tr>
<tr>
<td>${DAY}</td>
<td>Day of current date (numeric, 1-31)</td>
</tr>
<tr>
<td>${MONTH}</td>
<td>Month of current date (numeric, 1-12)</td>
</tr>
<tr>
<td>${YEAR}</td>
<td>Year of current date (e.g. 2001)</td>
</tr>
<tr>
<td>${HOUR}</td>
<td>Hour of current time</td>
</tr>
<tr>
<td>${MINUTE}</td>
<td>Minute of current time</td>
</tr>
<tr>
<td>${SECO}D}</td>
<td>Second of current time</td>
</tr>
<tr>
<td>${DAY_LZ}</td>
<td>Current day with leading zero (e.g. 07)</td>
</tr>
<tr>
<td>${MONTH_LZ}</td>
<td>Current month with leading zero</td>
</tr>
<tr>
<td>${YEAR_2}</td>
<td>Current year with last two digits (e.g. 01)</td>
</tr>
</tbody>
</table>

Worksheet specific Strings

<table>
<thead>
<tr>
<th>String</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>${FLOWCHART}</td>
<td>Name of Flowchart without path</td>
</tr>
<tr>
<td>${FULL_FLOWCHART}</td>
<td>Name of Flowchart with full path</td>
</tr>
<tr>
<td>${CREATION_DATE}</td>
<td>Date of Worksheet Creation</td>
</tr>
<tr>
<td>${CREATION_TIME}</td>
<td>Time of Worksheet Creation</td>
</tr>
<tr>
<td>${MODIFY_DATE}</td>
<td>Date when Worksheet was last changed</td>
</tr>
<tr>
<td>${MODIFY_TIME}</td>
<td>Time when Worksheet was last changed</td>
</tr>
<tr>
<td>${START_DATE}</td>
<td>Measurement Start Date</td>
</tr>
<tr>
<td>${START_TIME}</td>
<td>Measurement Start Time</td>
</tr>
</tbody>
</table>
${AUTHOR}$  Author, as defined in DASYLab File Info
${COMPANY}$  Company, as defined in DASYLab File Info
${DEPARTMENT}$  Department, as defined in DASYLab File Info
${TITLE}$  Title, as defined in DASYLab File Info
${DRIVER\_MESSAGE}$  Driver specific message
1.6.12 Define Global Variables

You can define and modify Global Variables while a measurement is running. You can pass variables to subsequent worksheets running in succession (see the Working Example below). You can define up to 999 Global Variables. When the measurement is running a Global Variable can be defined or modified using the menu command Define Global Variables.

Defined variables are stored with the worksheet.

Optionally, you can load a Global Variable after starting a worksheet or save a variable into the DASYLAB.INI file when you stop. Other applications are able to modify variables via DDE. And you can define, load or save a Global Variable using Event Driven Actions or Key Events. You can display Global Variable as text objects in Layout Windows. Use the placeholder ${VAR_xxx} in the line text object. Replace xxx with the number of the variable.

Several System/Program Information strings and variables (such as Free Memory, System Resources, etc. /Author, Company, etc.) are implemented in DASYLab as fixed placeholder strings/variables. If an Edit field will accept placeholders, right mouse click in the Edit field to open a Popup menu with the additional menu item Global Variable.... This Item opens a list with all available variables. Double-Click on the requested placeholder to insert it into the Edit field.

Use the Action module to save the variable to the INI file while the experiment is running

Each Global Variable is composed of a number, numerical value (max. 255 char.) and one or more Options. The Reset button sets all variables in the list to the default settings. The Reset all button deletes all variables.

You can select and modify more than one variable simultaneously using the mouse to select a range, using the SHIFT key to select a contiguous range and the CTRL key to select non-contiguous variables.

You can define the following Options to handle Global Variables.

- Read from INI file at start of experiment
- Write to INI file at stop of experiment
- No DDE access to Global Variable
- Write to DASYLab Header
- Show Global Variable in window
- Type In at start of experiment

You can also define a short description.

Extended…

Click on the Extended button to make additional settings for Global Strings.
Name: You can define a name to be used with variables and strings. You can refer to the String/Variable using the defined name: ${NAME} or by its number {$VAR_xxx} or {$STRxxx}.

Expressions: If the Calculate Expression automatically option is activated you can define a mathematical expression similar to the Formula Interpreter. The expression is allocated to the variable or string. If one of the parts in the expression is changed, the variable or string is automatically recalculated.

The settings made in the Extended… dialog box are not permanent until the main Define Global Variables... dialog is closed using the OK Button.

See Define Global Strings Extended… on page 4-52 for details of the settings and features.

Global Variables used in Modules

The following list shows you the modules that can process Global Strings. DA-SYLab is constantly improving, and adding places where you can use Global Variables. One way to determine if a parameter box permits a Global Variable is to right click in the parameter box. If the short menu shows Global Variable… then you can use a variable successfully in that location.

Predefined Global Variables

The global variables in the following list are predefined and are offered in the selection list for quick insert:

Variables with system information:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>${SYS_RES}</td>
<td>Free System Resources: This variable shows the load of the Windows system resources. If the value decreases (in %), the load increases.</td>
</tr>
<tr>
<td>${GDI_RES}</td>
<td>Free GDI Resources: This variable shows the load of the resources of the Windows Graphic Device Interface. If the value decreases (in %), the load increases.</td>
</tr>
<tr>
<td>${USER_RES}</td>
<td>Free User Resources: This variable shows the load of the Windows user resources. If the value decreases (in %), the load increases.</td>
</tr>
<tr>
<td>ACTUAL_YEAR</td>
<td>Actual Year: shows actual year as numerical value, shown in 4-digit format (yyyy).</td>
</tr>
<tr>
<td>${ACTUAL_MONTH}</td>
<td>Actual Month: shows actual month as numerical value.</td>
</tr>
</tbody>
</table>
Actual Day: shows the actual day as numerical values.

Actual Hour: shows the actual hour as numerical values.

Actual Minute: These Variables show the actual time (Year, Month, Day, Hour, Minute or Second) as numerical values.

Actual Second: actual time (Second) as numerical value.

Actual Day of the week: This Variable shows the day of the week as numerical value. The order starts with Sunday (value=0) end ends with Saturday (value=6).

Variable Description

$\{\text{BLOCK\_SIZE}\}$ Global Block Size: This value shows the preset global block size

$\{\text{SAMPLE\_RATE}\}$ Sampling Rate: This value shows the preset global sampling rate

Total Program Load in percent: This variable shows the loading of the data acquisition program. Values of 100% and higher are displayed if the program is fully loaded or overloaded. In this case, it threatens to interrupt the running measurement by the program. To reduce the load, decrease the sampling rate, increase the block size, disable the animation and so on.

The displayed value isn’t very precisely calculated because the time base used is 55 msec. So fluctuations in display are normal.

Total Program Load in milliseconds

Time delay shows the time a sample needs to pass all modules in worksheet. This may give an impression of the processing time that is needed to perform all operations defined by the function modules. The displayed value isn’t very precisely calculated because the time base used is 55 msec. Fluctuations in the display are normal.

Used Driver Buffer: This value (in %) shows the usage of the driver buffer of the program. If the
buffer is completely filled (100%), the measurement stops with an error message *Sampling rate too high.*

First check your flowchart and optimize it as much as possible (see also Tips & Tricks in the User Guide). Then check the buffer settings in *Experiment setup* and increase if possible. Also check whether other applications are running in the background, which may delay data processing in the program. Decrease the sampling rate and/or increase the block size.

Free Memory on DAP Boards $x$ ($x=1 \ldots 8$): This value (in %) shows the usage of the driver buffer of the Microstar DAP board. If the buffer is completely filled (100%), the measurement stops with an error message *Sampling rate too high.*

First check your flowchart and optimize it as much as possible (see also Tips & Tricks in the User Guide). Also check whether other applications are running in the background, which may delay data processing in the program. Decrease the sampling rate and/or increase the block size.

Driver specific: shows the number of values lost in the driver since the start of measurement. May indicate performance problems with the driver’s ability to capture data at the specified sampling rate.

Elapsed time of measurement in seconds from the start of measurement

**Options for Global Strings and Variables**

**Read from INI File at start of experiment**

If this option is chosen, entries in the INI file will be read and imported as actual settings. *DASYLab* will start the experiment with these Global Strings and Variables.

**Write to INI File at stop of experiment**

If this option is chosen, all defined Variables or Strings are written to the INI file when the experiment stops. These Global Strings/Variables are available in INI File the next time you start the experiment.

**No DDE access to Global String/Variable**

If this option is chosen, there is no DDE access to Variables or Strings. The Default setting is DDE access allowed.
Write to DASYLab Header

When this option is chosen, this Variable/String is written into the file header when you save data using the DASYLab or ASCII format file formats. When using the ASCII format you must define whether the strings/variables should be written as readable entries or just as information in the Write Data module. This information can be read back using the Read Data module.

If Take variables or Take strings option in the Read Data module is active, previously defined strings or variables will be overwritten.

Type In at start of experiment

When this option is chosen, a dialog box will open when the experiment starts. All defined Strings or Variables are listed in the input area. Up to 10 Strings and Variables are displayed on each page. If there are more than 10 entries, you can select the next page. You can change each String or Variable before starting measurement.

If the Read from INI File at start of experiment option is also chosen, all entries in the INI file are read and displayed in the dialog box.

Click the Start button to start measurement with the defined parameters. If you choose Cancel, measurement will not start and the program will switch to the DASYLab worksheet window.

Show Global String/Variable in Window

Choose this option to open a display window showing the contents of selected Global Strings and Global Strings. The display will update when the values change. The description and the contents are displayed, but not the number of the Variable or String. Use this option to display the current file name when the File Name -> Global String option is selected in the Read Data or Write Data modules.

Input is required to close dialog box

With this option activated, the input dialog box will not close unless at least one character is entered into the entry field. This option affects the input of global strings at start of measurement or using event driven actions.

File Name Dialog

Select this option to specify that the string will be used as a file name. At the start of the experiment or via an Event Driven Action, an Explorer window will be opened to select an existing file name. Double click on the file name to copy it directly into the string window. In the Pull down window you can select the type of file to be loaded. Choose whether the selected file will be used to load data (Read Data) or to write it (Write Data).
Working Examples of Global Strings And Variables

Global Strings and Global Strings are useful in several modules. To use Global Strings, an identifier $\{STR_{xxx}\}$ is inserted into an arbitrary alphanumeric string, where xxx is a numeric character from 1 to 999 ($\{STR_{0001}\}$ to $\{STR_{999}\}$). Spelling is not case sensitive. You cannot have blanks between the $ character and the curly bracket. Terms that are not recognized return an empty string. Global Strings are specified by the identifier $\{VAR_{0001}\}$ to $\{VAR_{999}\}$. DASYLab automatically recognizes whether it should be used as text or as a numerical value. The preset format is used for text. Maximum number of characters in Strings or Variables is 256.

To manipulate Global Strings or variables via DDE, there are 4 new DDE items available to the Menu topic: SetGlobalString, GetGlobalString, SetGlobalVar and GetGlobalVar. With both Get functions, only the number is transferred as an ASCII value (in which case DASYLab acts as a DDE Server. The connection is a Cold Link). The result is sent back by DASYLab as an ASCII value. When there is no result (wrong number, etc.) DASYLab answers with a string containing “Parameter Error.” To set Strings or Variables (DASYLab acts as a DDE Server. Connection has to be a DDE Poke) the number and the defined character string or the numerical value is sent separated by a semicolon. DASYLab doesn’t send an answer message.

Input strings/variables using actions

The Action Module has two global (DASYLab) actions: Set Variable and Set String which allow you to enter strings and variables. In the Action Module parameter settings you can define any string that will then be displayed as the title of the input window.

These entries are only accepted if each global string With Input Required ... contains at least one character.

To access the variable/string No 1, the entry in channel 1 has to be 0, for No 2 use 1, in No 3 use 2 and so on. Only first 16 variables or strings can be accessed (channel = 0 ... 15)

Automatic Creation of directories with time stamp

To store data files automatically into separate directories with names containing the actual month and day in their name, and with the hour of storing in the file name, use the following entry in the Write Data module:

C:\DASYLAB\DATA\${MONTH}-${DAY}\${HOUR}h

Additionally, the worksheet has to contain an Action module with the Close/open worksheet action with the Global String has changed event on two channels. The event parameter for the first channel is the $\{DAY\}$ string and on the second it is the $\{HOUR\}$ string. On the third channel, the Save Data action must be initialized on the $\{HOUR\}$ event.
After measurement has started the following actions will happen:
(Starting date and time of measurement: May, 28th, 1998, 13:30)
Reaching the next full hour, a new directory
\texttt{C:\DASYLAB\DATA\05-28} is created and the file \texttt{14h.ddf} is stored in
that directory.
When starting the next full hour, a new the file \texttt{15h.ddf} is written into the
same directory and so on, until midnight is reached.
Now the new sub-directory \texttt{05-29} is created in ..\DATA\ and the first file
\texttt{00h.ddf}. Until the next change of date is reached, each hour a new file is writ-
ten into the sub-directory.
This cycle repeats until measurement stops. The following file structure is cre-
ted:

1.6.13 Copy Channel Names
This function causes DASYLab to copy the channel names from each module to
connected modules. By default, the option is activated in the module dialog box

1.6.14 Switch to Runtime
Choose this function or click on the icon on the function bar, to reduce the
DASYLab worksheet window to its Runtime size. In its place, a minimized con-
trol panel appears which contains only the status bar (displaying the current
time and the buffer status) and the control icons from the function bar which
allow you to start, stop, pause and continue the experiment.
Additionally, all active display windows (analog/digital meters, scopes etc.) are
displayed on screen.
This option allows you to determine how your worksheet will appear when
loaded with the DASYLab Runtime version; you can concentrate on those ele-
ments that are essential for the control and evaluation of the actual experiment.

1.7. Window Menu
Use the commands of this menu to switch between Worksheet, Display and
Layout windows or to create new VITool Layout pages.
New Layout
DASYLab lists the names of all created windows, starting with the display and followed by name of the worksheet. Then all Layout windows are listed. Click on the name to activate a window. The Menu Bar will change depending on the type of the activated window (Control Sequencer, Display, Worksheet or Layout).

You can also switch between display modes by clicking on the function bar icon.

1.7.1 New Layout

Use this command to create a new Layout Window. The name of worksheet and the first nine Layout Windows are displayed below the menu commands. If there are more than ten windows you can use the More command to see them.

1.7.2 Control Sequencer

Use this command or click on the function bar icon to switch to the Control Sequencer View.

1.7.3 Display Windows

Use this command or click on the function bar icon to switch to the Display Tree View.

1.7.4 Layout

Use this command, or click on the function bar icon, to switch to the Layout View.

1.7.5 Worksheet

Use this command, or click on the function bar icon, to switch to the Worksheet View.

2. Control Sequencer Menus

The commands of the Control Sequencer File menu enable you to save and open Control Sequence files, to print worksheets, to manage your worksheet files, and to exit the program.
Control Sequencer File
To control a multi-step application consisting of more than one DASYLab worksheets calling each other, DASYLab offers a new tool, shown as new display window (analogous to the worksheet, display and VITool windows), called the Control Sequencer Window. The contents of the window is stored in a new type of file, the Control Sequencer file (saved with the suffix *.DSQ.)
The window shows a tree display of the control sequence. You can add any number of worksheets into the Control Sequencer File, whose name is shown as root of the tree.
You can also multiple actions for each inserted worksheet to control the flow of the worksheets.
In the Control Sequencer window you can load and save *.DSQ files using the main menu file commands: New, Open, Save and Save As....
To insert flowcharts or actions you need to use the pop-up context menu that appears when you right mouse click on one of the junction points on the screen. Depending on the junction (flowchart or action) the pop-up menu offers several commands to add, delete or to edit the object.

*The Sequence file is a binary file type. You cannot edit it with ASCII Editor programs such as Notepad.*

2.1. File Menu
See Worksheet Window Menu: File Menu (page 4-1).

2.1.1 New
Choose this command to create a new Control Sequence file. The DASYLab Control Sequencer work area will be cleared completely.
If there is already a Control Sequencer file loaded on the screen that has changed since you last saved it, you will be asked to
- save that file before beginning work on the new one,
- or to reject those changes,
- or to recall the New command.
After creating the new Control Sequencer file you can save it to a file by selecting the Save or the Save As... commands from the File menu.
Click on the Save icon in the function bar to save the current file.

2.1.2 Open...
Choose the Open command, or click the function bar icon, to open a Control Sequence file that has been previously saved. The DASYLab Control Sequence work area will be cleared completely.
If there is already a Control Sequencer file loaded on the screen that has changed since you last saved it, you will be asked to

- save that file before beginning work on the new one,
- or to reject those changes,
- or to recall the Open command.

After choosing the Open command you can select the file on which you want to work from a list of files.

You can...

- open one of the files from the list directly by double-clicking the file name,
- select a different directory by double-clicking the directory name,
- select a different file format for the file display, or
- select a different drive.

To use your keyboard, press the TAB or the SHIFT+TAB keys to move from one field to another; select items from the lists by pressing -, _, SPACE and the ENTER key.

In the File Name box you can define the filter for the file list. The default setting for the filter (*.DSQ) will create a list of DASYLab Control Sequencer files, which usually have the extension *.DSQ.

Type a different extension, or use wildcards (like *, *), to display lists of different groups of files. For example, if you have saved DASYLab Control Sequencer files with extensions other than *.DSQ (using the Save As... command from the File menu).

However, DASYLab can only open files in the special own DSQ format no matter what extension the files have.

2.1.3 Save...

Choose the Save command, or click the function bar icon, to save a Control Sequence file.

If you have created a new Control Sequence file (New from the File menu) without saving it to a file (untitled is displayed in the DASYLab window title bar), you can select the file name, the directory and the disk drive where the file is to be stored:

- Type the file name in the File Name box.
- If you do not type an extension, DASYLab will automatically add the standard extension (*.DSQ). **Name1 always saves worksheet files in its own format, even if you select an extension other than *.DSQ.
- You can...
  - select one of the file names in the list by double-clicking the file name. The file that was originally saved under that name will then
be replaced with the new worksheet. A warning message will first appear, asking you to either confirm the procedure or to cancel it.

- select a different directory by double-clicking the directory name, or
- select a different drive for the new file.

(To use your keyboard, press the TAB or the SHIFT+TAB keys to move from one field to another; select items from the lists by pressing - , SPACE and the ENTER key.)

If you have previously saved the Control Sequence to a file (using the Save As... or Save commands from the File menu), or if you have opened an existing file (command Open... from the File menu), its name is displayed in the DASYLab window title bar.

Select the Save command, or click the function bar icon, to save the current Control Sequence file. The existing file will be replaced without further messages.

2.1.4 Save As...

Choose the Save As command to save a Control Sequence with a new file name, in a different directory, or on a different drive.

After you have chosen the Save As... command from the File menu you can select the file name, the directory and the disk drive where the file is to be stored.

- Type the file name in the File Name box.
- If you do not type an extension, DASYLab will automatically add the standard extension (*.DSQ). DASYLab always saves Control Sequence files in its own binary format, even if you select an extension other than *.DSQ.

- You can...

  - select one of the file names in the list by double-clicking the file name. The file that was originally saved under that name will then be replaced with the new Control Sequence. A warning message will first appear, asking you to either confirm the procedure or to cancel it.
  - select a different directory by double-clicking the directory name, or
  - select a different drive for the new file.
  - (To use your keyboard, press the TAB or the SHIFT+TAB keys to move from one field to another; select items from the lists by pressing - , SPACE and the ENTER key.)
2.2. Edit Menu
This view does not include an Edit Menu.

2.3. Experiment Menu
See Worksheet Window Menu: Experiment Menu (page 4-22).

2.4. View Menu
See Worksheet: View Menu (page 4-36).

2.5. Options Menu
See Worksheet: Options Menu (page 4-78).

3. Tree View Menus

3.1. File Menu
See Worksheet Window Menu: File Menu (page 4-1).

3.2. Edit Menu
This view does not include an Edit Menu.

3.3. Experiment Menu
See Worksheet Window Menu: Experiment Menu (page 4-22).

3.4. View Menu
See Worksheet: View Menu (page 4-36).

3.5. Options Menu
See Worksheet: Options Menu (page 4-78).

3.5.1 Tree Display Setup
Use the menu command to change the properties of the Display Window.

Display:

- Normal: In the 32-bit version, this setting shows the measurement setup as a structured tree similar to the Windows Explorer. Click onto the elements of the tree to open the next branch or an accompanying dialog box.
  In the 16-bit version, the window is empty.
Bitmap: Choose this option to insert any picture in BMP or WMF format into the Window. Use the Bitmap... button to select the bitmap file.

The bitmap is not stored with the worksheet, but only a link to that file is stored. The specified bitmap file has to exist in the named directory to be displayed.

Sorting (not available in 16 bit version): Select the order the modules are displayed in the tree:
- Alphabetically: All modules are listed in alphabetic order.
- Alphabetically, Black Boxes separately: All modules are listed alphabetically, but the modules inserted into Black Boxes are listed separately.
- Class of modules: Modules are assigned to the several module groups and then are listed in alphabetic order.
- Creating order: Modules are listed in the order they were inserted into the worksheet.

Bitmap Display: The Original Size of Bitmap option shows the inserted bitmap scaled 1 / 1 (Pixels) centered in window. The background of the window is colored as selected in the Option Menu of the Worksheet Window.

The Stretch Bitmap switch adapts the Bitmap to the window frame. Proportions of picture may be distorted.

The Tiled setting fills the complete frame with pictures of the bitmap (sized 1/1).

Background: Click on this button to choose a color for the background.

3.6. Window Menu

The options of this menu are described in Worksheet: Window Menu (page 4-4-63).

4. Layout Window Menus

4.1. File Menu

See Worksheet Window Menu: File Menu (page 4-1).
4.2. Edit Menu

The commands of the Edit menu allow you to copy, paste and delete the DA-SYLab Layout Elements displayed on the screen.

- Layout to Clipboard
- Layout...
- Select
- Undo
- Cut
- Copy
- Paste
- Delete

4.2.1 Layout to Clipboard

*Use this command to copy the Layout Window as a Windows Metafile (WMF/CLP) to the Clipboard.*

See Worksheet Window Menu: Worksheet to Clipboard (page 4-12).

4.2.2 Layout...

*Use this command to save or load Layout Windows onto the worksheet. See Worksheet Window Menu: Layout (page 4-12).*

4.2.3 Select Layout Window

Use the menu function to activate the toolbox selection tool.

4.2.4 Undo

Use this command to undo the last operation. All changes to Layout Objects (like modifying colors, size or other properties) are canceled. Choose this function using the Undo menu command or by using the ALT+Backspace or CTRL-Z key combinations.

4.2.5 Object Cut, Copy, Paste and Delete

You can copy and paste objects of the Layout Window including their properties:
Selection: First select the objects: click and hold the left mouse button inside the worksheet and select the area by dragging the cursor. When you release the mouse button, the selected modules are highlighted. You can select or deselect single objects by clicking the left mouse button on the module while pressing the SHIFT or CTRL key.

Copy: Choose the Edit/Copy menu command or the CTRL-INSERT or CTRL-V key combinations. The selected objects are inserted onto the worksheet with their properties settings intact.

Cut: To move modules around the worksheet, choose the Edit/Cut menu command or the SHIFT+DEL or CTRL-X key combinations to remove the objects from the worksheet and to save them for a Paste operation.

Paste: Now paste the stored objects by choosing the Edit/Paste menu command or pressing SHIFT+INSERT or CTRL-V. After activating the insert mode, the mouse cursor changes. Choose the position where the selection should appear. The window is scrolled automatically when the mouse cursor moves outside the window border. Once the mouse cursor is at the destination, press the left mouse button to paste the objects into the Layout Window. The paste operation can be repeated.

Delete: Choose the Delete menu command or the Delete key to delete the selected objects.
4.3. Object Menu

Choose the objects you want to insert into the Layout Window. You can also choose objects using the Layout Window Toolbox. The Properties command allows you to change the characteristics of the selected object.

- Drawing Elements
- Visualization
- Text Elements
- Properties
- Placement

4.3.1 Drawing Elements

Choose this command to select Drawing Elements to be inserted into the Layout:

- Line
- Bitmapped Graphics
- Ellipse – filled or not filled (outline)
- Rectangle – filled or not filled (outline)

You can also choose an element by using the Tool Box buttons.

Click the left mouse button inside the Layout Window to define the start position of the Element. Click and hold the mouse button to draw a frame that defines the size of the element. Release the left mouse button to complete the command. To set properties of an element, select it with a left mouse click. Display the Properties Dialog Box by double clicking on the frame.

Properties (all objects)

Placement: Units for Position and Size are set in Centimeters or Inches depending on the settings in Main Menu File: Page Format.

Color: Use the Color button to select the color in the Windows Color Menu Box. The object will be drawn in the selected color.

Bitmapped Graphics Properties

File Name: This entry shows the name of the Bitmapped Graphics File that will be displayed. You cannot edit this entry. To change the File you must use the File... Button.

The left window of the dialog box shows all available files in directory, the right window shows the directory file structure. The File Format command selects the Bitmapped Graphics File Format (*.BMP, *.WMF). The Drive command selects the drive you want to read from.
External Bitmapped Graphics are not stored in the worksheet. Only the name and path of the files will be stored. To display the specified bitmap, the file must be available in the specified directory. Bitmapped Graphics inserted by using the clipboard are stored with the worksheet.

4.3.2 Visualization

Choose this command to select a Visualization Element to be inserted into the Layout. These elements are linked with the Display Modules of the worksheet. You can create a maximum of 512 linked elements in the VITool Layout Windows.

- **Text**
  This Visualization Element shows the contents of the alphanumerical displays such as List module or Digital Meter module as dynamic text elements on the Layout page. Only the alphanumerical characters are displayed but not window elements such as borders or window caption.

- **Graph**
  This Visualization Element shows the contents of the display modules on the Layout page. Only the contents of the display area are displayed but not window elements such as borders or window caption.

You can also choose an element by using the Tool Box buttons.

Click the left mouse button inside the Layout Window to define the start position of the Element. Click and hold the mouse button to draw a frame that defines the size of the element. Release the left mouse button to complete the command. To set properties of an element, select it with a left mouse click. Display the Properties Dialog Box by double clicking on the frame.

**Properties (all objects)**

**Placement:** Units for Position and Size are set in Centimeters or Inches depending on the settings in Main Menu File: Page Format.

**Linked Text Properties**

**Link:** Choose the name of the module that will send the strings.

**Text:** Insert the text that should be shown in front of (pre) and after (post) the linked string.

**Options**

**Alignment:** Text can be aligned right, left or centered.

**90° Rotation:** The text Frame will be rotated 90° counter clockwise.

**Font:** Use the Font button to select font and size in the Text Menu Box.
Use only TrueType fonts with rotated Linked Text Objects to prevent problems.

Linked Graph Properties

Link: Choose the name of the module that will send the graphical information.

Auto Update: If this option is turned off, the display of linked graphical objects is not updated when new data is received. To update manually, use Key Events or Event Driven Actions.

Sync Event Handling: Use this function with synchronous Event Driven Actions to synchronize the Layout display with an event driven action. While this function is disabled, there may be incorrect or inconsistent data when printing a Layout Window (premature or late blocks).

Fast Draw Function: While this Option is active, only the dynamic Elements of the Graphical Object are updated. You will get a better screen view, with less “flashing” as the data is updated.

Display:

- **Background**: While this option is active, the background in the object frame will not be transparent but will be opaque and colored. To select the color, use the Color... button.
- **With frame**: While this option is chosen, the object frame will not be transparent but will be visible and colored. To select the frame color, use the button Color....
- **Frame as shadow**: While this option is chosen, a shadow is displayed on the object frame.
- **Width**: This entry defines the thickness of the drawn object frame.

Setup: This button opens the Display window Setup dialog of the module linked to that graphic object.

4.3.3 Text Elements

Choose this command to select between two types of Text Elements that can be inserted into the Layout.

- **Text Line**
- **Text Block**
- **Text Grid**

Also you can choose the Elements by using the Tool Box buttons.

Click the left mouse button inside the Layout Window to define the start position of the Element. Click and hold the mouse button to draw a frame that defines the size of the Element. Release the left mouse button to complete the command. To set properties of an Element; select it with a left mouse click. Display the Properties Dialog Box by double clicking on the frame.
Text Line / Block Properties

Placement: Units for Position and Size are set in Centimeters or Inches depending on the settings in Main Menu File: Page Format.

Text: Insert the text that will be shown on Layout.

- A Text Line is always shown in one line. It will be cut (truncated) at the end of the line. The text of a Text Block will be broken at the end of the line and continued in the next line.

- A Text block is always shown in one complete block. It will be broken at the end of line and continued on the next line.

- You can use placeholders to insert special system information including the date, time, file name, or global variables and strings.

Grid Text Properties

Select the following Properties:

- Placement: Units for Position and Size are set in Millimeter or Inches depending on the Main Menu File: Page Format settings. Depending on the number of columns, the List is split into columns of the same width. The height of rows depends on the selected font size.

- Setup: The list is shown with the defined number rows and columns.

- Text Setup: The input of row and column number selects the cell to be edited. The text has to be inserted into the edit field below. You can use placeholders to insert special system information (e.g. data, time...).

- Text in the cells will not be wrapped at the cell border but written above the text of the next cell

- Alignment: You can set the alignment to left, right or centered.

- Font: Use the Font button to select the font and color in the Text Menu Box. The font size takes effect to the height of the rows of the list on the layout.

- Display

  Background: when this option is active, the background in the object frame will not be transparent but will be opaque and colored. To select the color, use the Color... button.

  With frame: when this option is chosen, the object frame will not be transparent but will be visible and colored. To select the frame color, use the button Color....

  Frame as shadow: when this option is chosen, a shadow is displayed on the object frame.

  Width: This entry defines the thickness of the drawn object frame.
Options
Alignment: Text can be aligned right, left or centered.
90° Rotation: The Text Frame will be rotated 90° counter clockwise.
Font: Use the Font button to select the font and size in the Text Menu Box.

Use only TrueType fonts with rotated Linked Text Objects to prevent problems.

Placeholders in Text Objects

You can use placeholders to insert special system information including the date, time, file name, or Global Strings and Strings. The following placeholders are available:

<table>
<thead>
<tr>
<th>Placeholder</th>
<th>Information Inserted</th>
<th>Available in</th>
</tr>
</thead>
<tbody>
<tr>
<td>${DEPARTMENT}</td>
<td>Department from File Info</td>
<td>Text line</td>
</tr>
<tr>
<td>${AUTHOR}</td>
<td>Name of Author from File Info</td>
<td>Text line</td>
</tr>
<tr>
<td>${DATE}</td>
<td>Actual System Date</td>
<td>Text line</td>
</tr>
<tr>
<td>${COMPANY}</td>
<td>Name of Company from File Info</td>
<td>Text line</td>
</tr>
<tr>
<td>${TIME}</td>
<td>Actual System Time</td>
<td>Text line</td>
</tr>
<tr>
<td>${KEY_ACTIONS}</td>
<td>List of defined Key Actions</td>
<td>Block text</td>
</tr>
<tr>
<td>${STRING_[No]}</td>
<td>String No X, defined in Options Menu</td>
<td>Text line</td>
</tr>
<tr>
<td>${STR_[No]}</td>
<td>String No X, defined in Options Menu</td>
<td>Text line</td>
</tr>
<tr>
<td>${VAR_[No]}</td>
<td>Variable No X, defined in Options Menu</td>
<td>Text line</td>
</tr>
</tbody>
</table>

Insert Strings and Variables Number without the square bracket inside the curly brackets, for example, ${STRING_33} will insert the Global String number 33.

Right-click on the text entry box to see a pop-up menu that allows you to choose from available Global Strings or Variables, including system variables.
4.3.4 Properties

This command opens the Properties Dialog Box for the Layout page or for the selected Layout object.

4.3.5 Placement

Choose this command to change the position of layered elements. You can move the selected element one layer Up or Down or move them into the Front or Background.

4.4. Experiment Menu

See Main Menu: Worksheet Window Menu: Experiment (page 4-22).

4.5. View Menu

The commands of this menu allow you to change the appearance of the DASYLab layout on the screen. Some of these functions can be chosen by clicking the corresponding icons on the Function Bar.

Function Bar
Module Bar
Status Bar

The above options of the menu are described in the Worksheet: View Menu (page 4-36).

Zoom / View
Full Screen

Zoom / View Layout Window

Use this command to zoom the Layout Window (25% to 200%). Use command Fit to Screen and Fit to Page to adapt the Layout Window format of the screen or the page.

Full Screen

Use this command to show the Layout Window in Full Screen Mode. Its size will be adapted to show the whole Layout Window. All elements such as Function Bar, Menu Bar and so on are hidden. Use the ESC key to change to normal mode.

To get best results for Full Screen Display use the screen Page Format. You can select it using the properties command of the Object Menu.
4.6. Options Menu

The commands of this menu allow you to change the display of the DASYLab Layout window.

Global Layout Properties
Layout Page Properties
Default Directories
Default Fonts
Colors
Autorouter
Password Protection
Password Definition
Screen Locking
Key Events
Define Global Strings
Define Global Variables

The above options of the menu are described in Worksheet Window Menu: Options Menu (page 4-42).

Layout Window…
Layout Page…

4.6.1 Global Layout Properties

This option allows you to define the starting options of all defined Layout Windows. These options apply to all layouts of the open worksheet. The following settings are available:

- **Mouse**: While Mouse To Interact With Instruments is active, you can only operate elements like switches or push buttons. You are not able to create objects or modify them.
  
  To create or modify elements in the Layout Window, you have to switch to the Mouse to interact with Layout Window option.

- **View**: Choose the Load As Full Screen option to load the first Layout Window into the foreground when DASYLab is next started. If the worksheet window was active when DASYLab was closed, it will be placed in the foreground.
4.6.2 Layout Page Setup

Use this menu command, or double click anywhere on the Layout Window to open the Properties dialog box. You can change the following:

- **Format**: Select between DIN or US page formats (Landscape or Portrait) or choose Screen format.

- **Name**: In the edit field below the format you can define an individual name for this layout window. Instead of the default name, Layout X, the title of the Layout window will be Name X. The layout number is still used by in Action modules to control switching between several layouts.

- **Border**: You can define Borders. All text objects outside the defined border will be cut off. The Visible option allows you to fade out/in lines that mark the defined borders. The Use border switch activates the clip function.

- **Grid**: The Snap to grid option places all objects according to the defined grid. The default Distance of the grid is 5 mm (0.2 inch). To display the grid on the screen, activate the visible option.

The following settings control the display properties of layout objects.

**Object Display**:

- **Show objects only**: Only the origin object is displayed on the layout.

- **Objects with frames**: Objects with their position borders are shown.

- **Only frames**: Only the position borders are shown.

**Objects outside the page**

- **Hide objects**: This selection hides all objects that are placed out of the defined working area.

- **Show objects**: This option shows all objects, regardless of where they are placed.

- **Delete objects automatically**: All objects placed out of the working area are deleted automatically.

**Moving Objects via keyboard**:

This setting defines the steps objects are moved using the arrow keys of keyboard:

- **Pixel Size**: The selected objects are moved pixel by pixel. Absolute movement of object depends on the chosen zoom factor and resolution of screen.

- **Steps of XXX mm**: All objects move in steps of millimeters. Relative width of step on the screen depends on the chosen zoom factor and defined size of page.
4.7. Window Menu

The options of this menu are described in Worksheet: Window Menu (page 4-63).

5. Help Menu

The commands of the Help menu allow you to obtain on-line help for the following program functions and for your data acquisition hardware. It also provides overviews and on-line tutorials.

5.1. Index

This option activates the Help system and displays the index of topics for which help can be obtained.

5.1.1 Instruction

Click this button to display on-line instruction on how to use the DASYLab Help System.

Printed instructions on how to use the Help system are found in Chapter 2 of this manual.

Further information on how to use the Windows Help system can be obtained by pressing the F1 function key while using a Help window, or by choosing Using Help from the Help menu.

5.1.2 References

Alphabetic Index of Help Topics / Alphabetic List of Modules

Choose this menu function to view the alphabetical lists containing all the topics for which help is available. Use the scroll bars or press the ↑, ↓, PgUp or PgDn keys to scroll through the lists then click on the topic for which you want information. You can also select a topic by pressing the TAB key until the topic is highlighted, then press ENTER.

Click the Search button at the top of the Help window or press the S key on your keyboard for information on a specific topic.
Glossary
Choose this menu function to view the alphabetical list of terms with definitions that can be displayed as pop-ups on the screen.

A line indicates the end of each of these definitions. If a line does not appear at the bottom of the text box, your Help window is too small. Enlarge its size by dragging its borders or corners while pressing the left mouse button, and click the term again. Or, you can use the Scroll Bar to move around the window.

Main Menu Options
Choose this menu function to view the Help pages for all of the DASYLab menu options and commands.

Module Selection Menu
Choose this menu function to view the Help pages for all of the module groups and modules.

5.1.3 Step by Step Instructions

The Elements of the DASYLab Screen
Choose this menu function to view the overview of the DASYLab screen elements found in Chapter 3.

Module Configuration and Manipulation
Choose this menu function to view general comments on how to install, configure, connect, move and delete modules. This information can be found in Module Reference Guide.

Creating your First Worksheet
Choose this menu function to view the instructions found in Chapter 2 of this manual.

5.1.4 Surveys

How to Start/Stop an Experiment
Choose this menu function to view the overview of the menu commands and instructions for automatic experiment control methods that can also be found in Chapter 6 of this manual.

Customizing the DASYLab Screen
Choose this menu function to view the information found in Chapter 3 of this manual.

Worksheet Examples
Choose this menu function to view instructions for using the sample worksheets that are installed with DASYLab.
**DASYLab by Keyboard**
Choose this menu function to view the instructions found in Chapter 6 of this manual.

**5.2. Hardware**
If you have installed a data acquisition board in your system, choose this menu function to obtain specific help about that board.

*Read the Hardware Installation Manual for additional information concerning installation and operation of your data acquisition device.*

**5.3. Glossary**
Choose this menu function to view the alphabetical list of terms with definitions that can be displayed as pop-ups on the screen.

**5.4. Using Help**
This option provides help for how to use the online help system.

**5.5. System Information...**
Choose this menu function to view information on your hardware, operating system, Windows version, system resources, etc.

**5.6. About DASYLab...**
Choose this menu function to view information on the current DASYLab version.

*Your own company logo can be displayed in the INFORMATION box (see Chapter 6 for details).*
6. Customizing the Main Menu: External Programs

You can easily insert menu items into DASYLab’s main menu to start external programs directly from within DASYLab.

Use a text editor, such as Notepad, to make the following entries in the DASYLAB.INI file (located in the DASYLab directory):

```
[External Tools]
ToolNumber=number
ToolMenuText1=&name1
ToolMenuText2=&name2
.....Etc.

ToolPathName1=path\programname1
ToolInitialDir1=startingdirectory1
ToolArguments1=startingparameters1
ToolAskArguments1=0

ToolPathName2=path\programname2
ToolInitialDir2=startingdirectory2
ToolArguments2=startingparameters2
ToolAskArguments2=0
.....Etc.
```

Each external program has a separate entry as described above. Items shown in *italic* text must be replaced with the actual name, path, and any parameters necessary to start your program. Up to 16 external programs can be defined.
Chapter 5: Files and File Formats / DDE / Network

1. Files and File Formats

1.1. Worksheet Files (.DSB)

A worksheet file (standard extension .DSB) contains the complete worksheet with its most important settings.

The following worksheet settings will be saved:

- The type and screen position of all the modules,
- The number of inputs and outputs of each module,
- The settings specified in each module configuration dialog box,
- All the data channels, branches and their exact positions,
- Global settings including the acquisition rate and the block size (Experiment menu),
- All the entries in the File Info dialog box (File menu).

The following environment settings will be saved with the worksheet:

- The mode (normal, minimized...), position and size of the main window and the visualization window,
- The Module Bar configuration,
- All the entries in the Page Format dialog box (File menu).

The following settings will not be saved with the worksheet:

- The settings of the Start/Stop at Time functions (Experiment menu),
- The settings of the Auto Start function (Experiment menu),
- The View menu settings for the display of the Module Bar, the Function Bar, and the Animation function,
- The Options menu settings (Window Setup, Colors, and the Autorouter function).

A worksheet file can be viewed in part by using the MS-DOS command TYPE. Some global information like the current time and date, comments, etc., is contained in human readable format at the beginning of the file.

1.1.1 Worksheet Exchange Files (*.DSA)

The file with the extension *.DSA stores a worksheet with the same information as the original DASYLab worksheet file (*.DSB), but formatted in ASCII. This format is used to exchange worksheets between different program versions (16 bit and 32 bit). Saving ASCII format will take a longer time and needs more disk space than storing in DSB format.
In addition to the *.DSA file DASYLab creates a file with the extension DMX, which contains the graphical matrix of the worksheet, such as data channels position of modules and so on. To load a worksheet as ASCII file both files *.DSA and *.DMX has to be available.

1.1.2   Worksheet Text Files (*.TXT)

This file format with the extension *.TXT contains simple text, which describes the modules and settings used in the worksheet. This file is only useful to rebuild worksheets manually. DASYLab is not able to reload these files, because all graphical information, such as position of modules or data channel links, is not stored.

1.1.3   HTML Text Files (*.HTM)

This file format is used to save worksheets as HTML files, using HyperText Markup Language, as used in the Web. These files contain all elements and important settings of a worksheet. The files cannot be reloaded but are a powerful help for documentation and rebuilding your projects.

1.2. Control Sequencer Files (*.DSQ)

To control large application controlled by more than one worksheet calling each other use the Control Sequencer Window. The contents of this window is stored in a binary file, the Control Sequencer file with the suffix *.DSQ.

You can add any number of worksheets into the Control Sequencer File and also you can define several actions for each inserted worksheet to rule the course of the worksheets. The contents of the Control Sequencer File is shown and edited as new display window (in analogy to the worksheet, display and VITool windows).

⇒ The file format type is binary, so you cannot edit it in a standard ASCII Editor.

1.3. Module Bar Files (*.DML)

These files contain configurations of the Module Bar and are used to define DASYLab environments for different application areas. They can be created by choosing the Save As... command from the Module Bar submenu of the Edit menu.

The current configuration of the Module Bar will be saved by DASYLab in the file DASYLAB.DML. This file will by default be used for the next start of DASYLab.
1.4. Layout File ( .LAY)

These files contain configurations of the Layouts and are used to save user defined Layout settings to import into different worksheets. They can be created by choosing the Save As... command from the Edit submenu: Layout...

1.5. Serial Port Settings ( .SIN/ .SOU)

The settings of the serial interface are stored in these files. They can be created by choosing the Save Button in the module dialog box of the serial modules. Load these files to quickly configure the ports with previously defined settings.

1.6. Initialization File (DASYLAB .INI)

DASYLab automatically creates this file in the Windows directory. It contains the current global settings concerning the main windows and parts of the file info. Also in these files defined Global Strings or variables are saved. If necessary DASYLab can read them while measurement is running.

1.7. Files with Reference Points ( .DPF)

These ASCII files contain lists of reference points that are required for Interpolation in the Scaling module. Use an ASCII editor such as Windows Notepad or any other non-formatting text editor to create such a file.

The file can be created as one channel file or multi channel file and must be structured as follows:

Line 1: INTERPOLATION
Line 2: identifier (maximum 40 characters)
Line 3: number of columns (minimum 2)
Line 4: number of pairs of data

The lines containing the data pairs follow. Their total number must correspond exactly to the value specified in line 4.

Last line: EOF

The reference pairs are arranged in one line with the independent value first and the dependent value second. Blanks or Tabs must separate the two columns. The lines must be sorted in increasing order.
Example of an Interpolation file:

```
INTERPOLATION
This is an example file.
2
5
-2000 0
-1500 1.5151
-100 3.7456
10 7.78569
400 0.12
EOF
```

Example of a Multi Channel Interpolation file with 3 channels separated by blanks:

```
INTERPOLATION
This is a 3-channel example file.
3
5
-2000 0.00 1.00
-1500 1.5151 2.50
-100 3.7456 3.5678
10 7.87569 2.222
400 12.587 3.334
EOF
```

1.8. Data Files

**DASYLab** can store data in different formats so that data can be used by other applications. It can read data stored as IEEE-32 or ASCII formats, in addition to its own format. Use the **Read File** and **Write File** modules from the **Files** module to read and write files.

**ASCII Format (.ASC)**

Data is stored as ASCII strings, so that it can be read without an additional converting program.

- **Only continuous time-dependent data can be stored in the ASCII format.**

**IEEE Format (.I32)**

Data is stored as IEEE 32 bit floating point values in the Intel format.

- **Only continuous time-dependent data can be stored in this format.**
### External Formats

DASYLab supports saving data in any of the following formats:

<table>
<thead>
<tr>
<th>Format</th>
<th>Extension</th>
<th>Format</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCII</td>
<td>*.ASC</td>
<td>IEEE-32</td>
<td>*.I32</td>
</tr>
<tr>
<td>DADiSP</td>
<td>*.DSP</td>
<td>Remus</td>
<td>*.DAT</td>
</tr>
<tr>
<td>DIA/DAGO</td>
<td>*.DAT</td>
<td>Signalys</td>
<td>*.VH, *.K??, *.D??</td>
</tr>
<tr>
<td>Famos</td>
<td>*.DAT</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*FFT, Histogram, or Relay data cannot be stored in the DIA/DAGO format. The same block size and sampling rate must be specified for all the channels if data is to be stored in this format.*

There are no restrictions for the Famos or the Signalys formats.

### DASYLab Data Format (.DDF / .DDB)

This format is the DASYLab format that exactly fits the requirements of DASYLab.

Data can be stored and read in this format. All types of data can be saved and the full information is stored together with the raw data.

Please refer to the section 1.9 for further details.

#### 1.9. DASYLab Data Format (.DDF / .DDB)

(Extended Version 1.01 / Oct. 1994)

##### 1.9.1 Basics

The header can either be stored in the same file as the data or in another file with a different extension.

The extension for the main file is .DDF (“DASYLab® Data Format”). If a separate data file is created, its extension will be .DDB (“DASYLab® Data Block”).

The format itself is not fixed completely, but contains options for future development. Any variants of the format that are not described explicitly here are not fully developed and should not be used.

##### 1.9.2 Basic File Structure

Each file consists of four sections, of which the one containing the data may be stored in a separate file:

1. Two global headers,
2. A number of channel headers (one for each channel),
3. One or several series of data blocks,
4. The End of File mark;
Or

1. Two global headers,
2. A number of channel headers (one for each channel),
3. The End of File mark,

Plus an additional file containing only the series of blocks of data.

The current version allows only one series of blocks of data.

1.9.3 Storing Different Types of Data

Binary data are stored following the conventions of the Intel Format. This documentation uses the following identifiers for data types:

- **CHAR** single character
- **CHAR[n]** an array of exactly n characters
- **INT** 2 Byte signed
- **LONG** 4 Byte signed
- **WORD** 2 Byte unsigned
- **DWORD** 4 Byte unsigned
- **DATUM** date and time in the current MS-DOS format
- **FLOAT** 4 Byte real
- **DOUBLE** 8 Byte real
- **STRING** a series of characters with NULL Byte terminator (variable size)

Strings will be encoded according to Windows 3.1 conventions.

1.9.4 The First Global Header

The first global header has the following structure:

- **CHAR[4]** fixed file identifier: 'D', 'T', 'D', 'F'
- **CHAR** fixed file identifier: CTRL-M ($0D)
- **STRING** data source, comments, etc. (see below)
- **CHAR** fixed terminator: CTRL-Z ($1A)
- **CHAR[2]** fixed CPU identifier: 'I', 'N'
- **WORD** size of this header in Bytes
- **WORD** file type (see explanation below)
- **WORD** version number (currently: 1)
- **WORD** size of the second global header in Bytes [*]
  (see explanation below)
- **WORD** size of a channel header in Bytes [*]
- **WORD** size of a block header in Bytes
- **WORD** flag for a separate data file
- **WORD** number of channels
- **DOUBLE** time delay between two samples
- **DATUM** start time
The “Data Source” string is structured by **DASYLab** as follows:

- **DASYLab V 3.00 [APRIL 15, 1993] -- Copyright (c) 1992,93,94,95 by NATIONAL INSTRUMENTS**
- **WORKSHEET = WIND.DSB**
- **AUTHOR = W. Inner**
- **COMPANY = Faster Than Light Inc.**
- **DIVISION = Development**
- **TITLE = Wind channel experiment 4711**
- **SAMPLE RATE = 1000.0 Hz**
- **DATA FORMAT = 1**
- **DATA CHANNELS = 5**
- **START TIME = MAY 25, 1995 11:55**

If data blocks are stored in a separate file, the following line is added:

**DATA FILE = NAME.DDB**

You can view this information using the MS-DOS command **TYPE**.

“**File Type**” may be one of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>streamer format (data are raw data in WORD format, coming directly from the DAQ)</td>
</tr>
<tr>
<td>1</td>
<td>Universal Format 1 (FLOAT)</td>
</tr>
<tr>
<td>2</td>
<td>Universal Format 2 (DOUBLE)</td>
</tr>
<tr>
<td>3 – 1000</td>
<td>reserved</td>
</tr>
<tr>
<td>1001 – 65535</td>
<td>unused</td>
</tr>
</tbody>
</table>

Currently only File Type 1 is supported.

The second global header is dependent on the file type.

For the above sizes marked with an asterisk [*] (and only those), strings are counted as 1 Byte each. Otherwise the real size will be entered. The data block headers cannot contain any strings.

The flag for separate data files may have either of these values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>(FALSE) one file only / header and data are in the same file.</td>
</tr>
<tr>
<td>1</td>
<td>(TRUE) separate file for data blocks. Both files must have the same file names, but the extension of the main file is .DDF (“<strong>DASYLab® Data Format</strong>”), and the extension of the separate data file is .DDB (“<strong>DASYLab® Data Block</strong>”).</td>
</tr>
</tbody>
</table>

### 1.9.5 End of File Mark

The end of file is marked by:

1.9.6  The Universal Format 1

This is the standard format of DASYLab. All the different types of signals can be stored in this format.

Global Header for Universal Format 1

This header has the following structure:

| WORD | size of this header |
| WORD | number of channels |
| WORD | Flag, whether the data are multiplexed (0=\text{no}; 1=\text{yes}) |
| WORD[16] | Array of the channels collected on each input channel |

Channel Header for Universal Format 1

Each channel has its own header:

| WORD | size of this header |
| WORD | channel number |
| WORD | maximum size of a block in samples. The maximum value is 8192. The actual sizes of the blocks may be smaller. |
| DOUBLE | time delay between two samples in this channel |
| WORD | channel type (see explanation below) |
| WORD | channel flags (see explanation below) |
| DOUBLE | unused, must be 0.0 for future extensions |
| DOUBLE | unused, must be 0.0 for future extensions |
| STRING | channel unit |
| STRING | channel name |

The following channel types may be used:

<table>
<thead>
<tr>
<th>Channel Type</th>
<th>Value for a channel containing data of the following type:</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>continuous time dependent signals</td>
</tr>
<tr>
<td>10</td>
<td>frequency dependent data (full block size)</td>
</tr>
<tr>
<td>11</td>
<td>frequency dependent data (half block size)</td>
</tr>
<tr>
<td>20</td>
<td>Histogram values</td>
</tr>
<tr>
<td>21</td>
<td>Histogram values with time information</td>
</tr>
</tbody>
</table>

The channel flags may be used for special properties of a signal or block; currently only one flag is defined:

<table>
<thead>
<tr>
<th>Channel Flag</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>$0001</td>
<td>data in this channel may have gaps</td>
</tr>
<tr>
<td>$0002</td>
<td>this channel may contain shorter blocks</td>
</tr>
</tbody>
</table>

The different channel headers follow one by one without gaps. The first header corresponds to channel 0, the second to channel 1 and so on.
1.9.7 Data Block Header for Universal Format 1

Each series of data blocks is preceded by a small header structured as follows:

- **CHAR[4]** fixed label: 'D', 'A', 'T', 'A'
- **WORD** overall number of bytes in this channel
- **DATUM** start time for the following blocks
- **DWORD** unused, must be 0.0 for future extensions
- **DWORD** unused, must be 0.0 for future extensions

This header is followed by the corresponding series of data blocks, each of which is again introduced by its own separate header.

The individual pairs of headers and blocks directly follow each other. The blocks are not sorted according to channels but according to their start time.

- Channels of types 0, 1, 10, 11 or 12 have headers as follows:
  - **WORD** channel number
  - **DOUBLE** start time
  - **DOUBLE** time delay between samples
  - **WORD** block size

  This header is immediately followed by the data in 4-byte float format.

- Channels of type 20 (Histogram data) have the following header:
  - **WORD** channel number
  - **DOUBLE** position of the first histogram value
  - **DOUBLE** width of the classes
  - **WORD** number of samples

  This header is immediately followed by the data in 4-byte float format.

  These data are not provided with time information.

1.9.8 The Universal Format 0

Universal Format 0 is used for streaming data. It may contain more than 16 channels and it may contain data in raw integer format.

Global Header for Universal Format 0

This header has the following structure:

- **WORD** overall number of bytes in this header
- **WORD** number of analog channels
- **WORD** number of counter channels
- **WORD** number of digital ports
- **WORD** number of bits in each digital port
- **WORD** original block size when data was stored
- **DWORD** sample number of the first sample (when cyclic buffer is not activated, always zero)
- **DWORD** number of samples per channel

Channel Header for Universal Format 0

- **WORD** number of bytes in this header
1.10. **Vector File (*.VEC)**

The vector file (Extension *.VEC) stores information used in the module Convolution.

You can create this file with an ASCII editor such as Windows Notepad or any other non-formatting text editor. The file must be structured as follows:

(Quotation marks are inserted for better view. They are not allowed to be used in original vector file!)

1st line: "VECTOR"

2nd line: Name (free text, max 40 characters)

3rd line: Number of columns; only „1“ is allowed

4th line: Number of data lines

Next lines: Data (number of lines exactly as defined in previous line)

Last line: „EOF“

**Example of Vector file**

VECTOR

Example of vector file name

1 number of columns „1“

5 number of data lines „5“

121 Data line 1

244 Data line 2

305 Data line 3

476 Data line 4

599 Data line 5

EOF

1.11. **FGEN File (*.TXT)**

The FGEN file (Extension *.TXT) stores Coefficients of Filter, which are used in the Convolution module.

It is possible to use the program FGEN for Windows (Version 1.00, 20 October 1995, Microstar Laboratories) to import immediately coefficients of digital filters into the convolution module. Because the FGEN program isn’t able to
store the coefficient matrix you must use the menu item „View...“ to show the coefficient values and copy them into the clipboard.

You can import this data into an ASCII editor such as Windows Notepad or any other non-formatting text editor and store it as a TXT file.

**Example FGEN FILE**

```plaintext
; vector v: Taps = 95, Type = Lowpass, Window = Blackman
; vector v: Actual Taps = 101 (before zero stripping)
; vector v: Edges = 0,09, 0,14
; vector v: Scale = 8
vector v = (-1, -1, -2, -1, 1, 6, 14, 24,
  35, 43, 44, 34, 8, -36, -97, -170,
  -243, -300, -321, -284, -173, 20, 288, 608,
  937, 1214, 1369, 1332, 1045, 479, -356, -1398,
  -2530, -3589, -4372, -4665, -4268, -3023, -848, 2246,
  6140, 10610, 15343, 19968, 24091, 27345, 29429, 30147,
  29429, 27345, 24091, 19968, 15343, 10610, 6140, 2246,
  -848, -3023, -4268, -4665, -4372, -3589, -2530, -1398,
  -356, 479, 1045, 1332, 1369, 1214, 937, 608,
  288, 20, -173, -284, -321, -300, -243, -170,
  -97, -36, 8, 34, 44, 43, 35, 24,
  14, 6, 1, -1, -2, -1, -1)
```

2. **DASYLab-Net: Communication with Other DASYLab Programs**

DASYLab-Net is able to control other DASYLab-Net programs running on connected machines. A typical configuration is a central computer that controls all functions (a master) and many measuring points that are controlled (slaves).

There are always two machines involved in any communications connection. Usually they are called Client/Server. Also we will use the terms Master/Slave or Active/Passive Partner.

The computer that actively builds and controls the connection is the Client, Master or Active Partner. It sends commands and performs supervising functions. It also sends or receives data initiated by itself. The Client or Master computer always has the main control.

The Server, Slave or Passive Partner is the computer that waits for another computer to contact it. It accepts commands, receives data and sends data controlled by the far side. Server or Slave computers are not able to operate without the control inputs of the Server. It only executes commands of the Master unit.
Each DASYLab-Net can be defined as Client (= Master) or Server (= Slave). The DASYLab Server is able to send data to several Clients; the DASYLab Client is able to control several Servers.

The Remote Control Dialog Box allows you to define DASYLab-Net as Client or Server. With Server mode there are no further settings. With Client mode you can define a list of Servers that should be controlled. The settings of each of these Servers can be defined using the Option button or the servers can be ordered to execute immediate instructions.

The Options Dialog Box defines the settings of the remote control operations.

- **Start/Stop simultaneously**
  
  When this option is active, the Server starts and stops each time the measurement starts and stops. Please note that Clients and Servers never start at exactly the same time because the transmission of the start command is dependent on the utilization and capacity of the network. Also network configuration, speed of network boards, etc., will affect the speed of the transfer.

- **The Start, Stop and Load Options are executed immediately.** Start measurement, stop measurement or loading a worksheet will be performed on the remote side “instantly.”

### 2.1. TCP/IP Network Protocol

The TCP/IP Protocol is the basis of DASYLab-Net’s functions. It is not included in the standard Windows or Windows for Workgroups installations. You will need to install the TCP/IP Stack to use the DASYLab-Net functions.

**Availability**

Several manufacturers provide TCP/IP Protocol Stacks as a supplement to Windows 3.1 and/or Windows for Workgroups 3.11. DASYLab-Net only works correctly with TCP/IP Stacks that include a WINSOCK DLL file. This file should meet the Windows Sockets Specification Version 1.1, Jan 20, 1993.

**MS TCP/IP-32**

The TCP/IP-32 Protocol Stack is provided free of charge by Microsoft. This stack (in contrast with others) cannot only be used with Windows 3.1 but also with Windows for Workgroups 3.11. It is very easy to install. New operating systems such as Windows 98 will contain the TCP/IP Protocol in the standard distribution.

The following section refers to the MS TCP/IP-32 Protocol stack.

**Installation**

MS TCP/IP-32 installation is started using the network setup from the Network Group. You can install it as an additional protocol using the driver options.
Typically you would first install the Microsoft Windows Network with an installed Ethernet board. Then install the TCP/IP-32 as an additional protocol. Installation of additional Network protocols (such as Novell Net or others) is not required because each additional protocol running on the network diminishes the overall performance.

**IP-Address**

During the installation of TCP/IP, all mounted computers must have an IP Address (= Internet Address). The string is constructed of 4 numbers divided by decimal points (for example: 192.153.120.3) and has to agree with established declarations (for example, the first number defines the Address Type.)

If you want to connect your local network with the worldwide Internet, you must request the first three numbers from the network provider. The last number will define the local computer.

Also, while the network will work, local Internet conventions must be obeyed. For example, usable addresses are 192.153.120.x in which each local computer gets its station identification defined in the x component (range: 1 up to 255). The first three numbers of all local computers must be identical. Each local machine must be named unambiguously. This name is also used by DASYLab-Net.

### 2.2. Bibliography

Reviewing the literature, there are many books, articles, etc., which discuss TCP/IP, Internet and Windows Sockets.

References with subjects of Ethernet, FDDI, Using IP-Addresses, etc., are interesting if you want to install a TCP/IP Network.

Subjects of FTP, TELNET, NFS, EMAIL, WWW (Worldwide Web), GOPHER, and so on are descriptions of public domain services that are not necessary to run DASYLab-Net.

You won’t need descriptions of Windows Sockets. You only need to know that DASYLab-Net needs Windows Sockets. The software manufacturer has to deliver them with the TCP/IP Stacks.

### 3. DDE: Communication with Other Applications

DDE (Dynamic Data Exchange) is defined as a dynamic data exchange between Windows applications using a defined protocol. Although this conversation is two-way, the role of each program is determined by the protocol. The program asking for data is called the Client. The called program is defined as the Server.

The Client always initiates a DDE conversation. It sends an initialization message (WM_DDE_INITIATE) to all running tasks. The parameters describe the general type of the required data. A program with that data type responds with an acknowledgment and declares itself to be the Server. A DDE conversation is restricted to two partners.
3.1. DASYLab as DDE Input

Using the Windows DDE Interface, external programs are able to initiate DASYLab functions (load file, start measurement...) in a running DASYLab program. Other Windows applications can control DASYLab. In this case DASYLab is the Server, a Visual Basic application, for example, is the Client.

The format of the DDE instructions has to conform to the following rules:

Service: DASYLab
Topic: Menu
Item: Command e.g. Load

The name of the application (service) DASYLAB and the topic Menu starts the DDE conversation. Available items are Command (standard menu command) with start measurement, stop measurement, pause measurement and continue measurement functions and the item Load to load file.

There are 6 additional DDE items to manipulate Global Strings or Variables using DDE:
- SetString
- GetString
- SetVar
- GetVar
- GetData
- SetData

In both GET functions the number is chosen as item and the function as topic (DASYLab is the DDE server. Connection is a Cold Link). DASYLab will send back the result as an ASCII value. If there is no result (wrong number, etc.), DASYLab will send back the string ‘Parameter Error’. To set strings or variables (DASYLab is DDE server, connection is defined as DDE Poke) the number and the defined alphanumeric string or numerical value separated by a semicolon will be sent. DASYLab gives no feedback.

Protocol

Application: DASYLab
- Start measurement, stop measurement, pause measurement, continue measurement:
  Topic: Menu
  Item: Command
  String: START, PAUSE, CONT, STOP
  Communication: Poke
- Load file:
  Topic: Menu
  Item: Load
String: FILEName
Communication: Poke

- **Set Global String:**
  - Topic: Menu
  - Item: SetString
  - String: Number;String
  - Example: 3; test.dfd
  - Communication: Poke

- **Get Global String:**
  - Topic: Menu
  - Item: GetString
  - String: Number
  - Communication: Cold link

- **Set Global Variable:**
  - Topic: Menu
  - Item: SetVar
  - String: Number;(ASCII)Value
  - Example: 2;5.923
  - Communication: Poke

- **Get Global Variable:**
  - Topic: Menu
  - Item: getVAR
  - String: Number
  - Communication: Cold link

- **Get DDE data**
  - Topic: GetData
  - Item: MODULEName
  - String: Line with x channels, (ASCII)
  - Communication: ColdLink or HotLink

- **Set DDE data**
  - Topic: SetData
  - Item: MODULEName
  - Communication: Poke

**Visual Basic - example**

Private Sub cmdPoke_Click()
  txtData.LinkMode = vbLinkNone
  txtData.LinkTopic = "DASYLab" & "|" & "Menu"
  txtData.LinkItem = "Load"
  txtData.LinkMode = vbLinkManual
End Sub
txtData.Text = "c:\DASYLab\last.dsb"
txtData.LinkPoke
End Sub

Private Sub cmdRequest_Click()
    txtData.LinkMode = vbLinkNone
    txtData.LinkTopic = "DASYLab" & "|" & "GetVariable"
    txtData.LinkItem = "1"
    txtData.LinkMode = vbLinkManual
    txtData.Text = 
    txtData.LinkRequest
End Sub

In VisualBasic 5.0 the type of communication is declared as follows:

Initialization: txtdata.Poke

ColdLink: Linkmode: txtdata.Linkmode = vbLinkManual
Initialization: txtdata.Request

HotLink: LinkMode: txtdata.LinkMode = vbAutomatic

When the connection is successful, an acknowledgment signal ("CONNECT") will be sent.

**Net DDE**

It is also possible to exchange data between programs running on different machines using an available network.

You need to ensure the following:

- On the server side there must be one or more DDE shares entries. This authorizes other applications (in the following example Excel) to connect via Net DDE. Shares are inserted in the SYSTEM.INI file section [DDEShares].

Example:

```
[DDEShares]
CHAT$=winchat,chat,,31,,0,,0,0,0
SCHAT$=winchat,chat,,31,,0,,0,0,0
CLPBK$=clipsrv,system,,31,,0,,0,0,0
DL_MENU$=DASYLab,Menu,,15,,0,,0,0,0
DL_DATA$=DASYLab,DdeData,,15,,0,0,0,0
XL_TAB1$=Excel,Tab1,,15,,0,,0,0,0
```

DASYLab requires the last three lines.

You need to restart Windows to initiate the connection.
On the client side the following entries are necessary:

When **DASYLab** and the other application are installed on the same machine:

- **Application**: Excel
- **Topic**: Tab1
- **Item**: R1C2

When **DASYLab** and the other application are connected via Net DDE:

- **Application**: \\ComputerName\NDDE$
- **Topic**: XL_1TAB1
- **Item**: R1C2

Adjustments of the client must match the enabled DDE shares settings.
Chapter 6
Tips & Tricks
Chapter 6: Tips & Tricks

1. Demo Worksheets

When you set up DASYLab on your hard disk, several Sample Worksheets are copied to the DASYLab directory.

You can open these files onto the working area by choosing Open from the File menu or by clicking this Function Bar icon.

These worksheet examples can give you some idea of the wide range of measuring tasks that can be solved by DASYLab.

If you choose the File Info command from the File menu, or click the corresponding icon on the Function Bar, you will find information on that worksheet in the Worksheet Information box.

2. DASYLab by Keyboard

Most Windows applications are designed with mouse operation in mind, but the keyboard may also be used. The following keyboard operations can be used in DASYLab:

Menu Commands

Menu commands can be chosen by pressing ALT to move to the Menu Bar, then typing the underlined letter in the menu name to open the menu, and then typing the underlined letter in the menu command.

Experiment Control

Keyboard shortcuts are provided for commonly used Experiment menu commands. Instead of opening the menu and choosing the command, press the key combination.

These keys are listed to the right of the menu entry. The online help pages also list them.

A list of the commands and their shortcut-key combinations is provided on page 6-2.

Module Manipulation and Configuration

The module symbols in the worksheet can be dragged, connected by data channels, configured, or deleted. The latter two manipulations can also be done with the keyboard.

Only one module in the worksheet can be selected and manipulated. It is identified among the module symbols in the work area by the inverse coloring of its Title Bar, where the module name is displayed.

To select a module, click it once with the left mouse button or press the TAB key on your keyboard until that module is selected.
When you press the ALT+ENTER keys, the module configuration dialog box appears. Press the TAB or the SHIFT+TAB keys to move from one field or button to another; select items by pressing the arrow keys, the SPACE and the ENTER key.

Channel Selection can only be done using the mouse.

To copy settings entered for the selected channel to the other activated channels, use the F7/F8 Function Keys. This procedure can only be performed using keyboard operation.

To delete the selected module from the worksheet, or to delete all the input and/or output channels of that module, press the DEL key. In the dialog box, select the desired option, or choose Cancel, and press ENTER.

3. DASYLab Hotkeys

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Online Help</td>
</tr>
<tr>
<td>F2</td>
<td>Show Display Window</td>
</tr>
<tr>
<td>F3</td>
<td>Show Display Window</td>
</tr>
<tr>
<td>SHIFT-F3</td>
<td>Show Sequence Window</td>
</tr>
<tr>
<td>F4</td>
<td>Show Layout Window</td>
</tr>
<tr>
<td>F5</td>
<td>Start Measurement</td>
</tr>
<tr>
<td>CTRL+F5</td>
<td>Stop Measurement</td>
</tr>
<tr>
<td>CTRL+F6</td>
<td>Pause Measurement</td>
</tr>
<tr>
<td>CTRL+F6</td>
<td>Resume Measurement</td>
</tr>
<tr>
<td>F7</td>
<td>Copy selected channel properties</td>
</tr>
<tr>
<td>F8</td>
<td>Copy all channel properties</td>
</tr>
<tr>
<td>ESC or CTRL+F</td>
<td>Switch Layout from full screen to window mode</td>
</tr>
<tr>
<td>CTRL+F</td>
<td>Switch Layout into full screen mode</td>
</tr>
<tr>
<td>ALT+SHIFT+Number</td>
<td>Save window arrangement</td>
</tr>
<tr>
<td>Alt+Number</td>
<td>Choose window arrangement</td>
</tr>
<tr>
<td>ALT+CTRL+Number</td>
<td>Delete window arrangement</td>
</tr>
</tbody>
</table>

4. How to Start and Stop an Experiment

This section contains

- Some basic information on the options provided by DASYLab to control an experiment or data acquisition process;
- An overview of the manual control options;
And a review of the methods for automatically controlling an experiment.

4.1. Start/Stop/Pause/Resume an Experiment

DASYLab allows you to control your data acquisition procedures in various ways. Besides starting and completely stopping an experiment you can also interrupt it and later resume it at that point.

- When you pause an experiment, the acquisition of new data is stopped (for example, Generator, A/D or Digital Input, PID or Manual Control modules) but data already acquired will be processed completely.
- The acquisition of new data is resumed when the experiment is continued.

4.2. Controlling an Experiment Manually

There are three methods for controlling an experiment manually.

1. Choose the commands from the Experiment menu: click the menu item, or press the ALT, X keys, then type the letter that is underlined in the item name.

2. Click the icons on the Function Bar. Each icon symbolizes a menu commands.

3. Use keyboard shortcuts. When available, shortcut-key combinations are listed to the right of the menu item; to use, press the key combination.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Experiment Menu Command</th>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Start</td>
<td>F5</td>
<td>Start experiment</td>
</tr>
<tr>
<td></td>
<td>Stop</td>
<td>CTRL+F5</td>
<td>Stop experiment</td>
</tr>
<tr>
<td></td>
<td>√Pause</td>
<td>CTRL+F6</td>
<td>Pause experiment / resume experiment</td>
</tr>
</tbody>
</table>

4.3. Automatic Program/Experiment Start

The experiment setup (the worksheet) and/or the computer can be configured so that the experiment will start and stop automatically.

The following describes the menu commands needed and the details on how to automatically set up experiments using batch files and Windows resources.
The concept of Event Driven Actions enlarges the capabilities of DASYLab in the field of automatic measurement control. An Action module can react to detected events with certain activities, such as opening and starting a new worksheet, printing displays, resetting values, etc. See the Module Reference Guide for more information.

4.3.1 Start/Stop via DDE

Other Windows applications with DDE capabilities can be used to start and stop the DASYLab experiment. Refer to the DDE section in Chapter 6 for details on the DDE protocol.

4.3.2 Start/Stop at Time

Choose the Start/Stop at Time option from the Experiment menu to start, stop, and repeat an experiment at specified times. You can specify the time at which an experiment is to start, the duration of that experiment, and the interval after which the experiment is to be repeated. Refer to Chapter 6 for details.

4.3.3 Using the Auto Start Function

Use the Auto Start option from the Experiment menu to set an experiment to start automatically.

- Activate the Auto Start option from the Experiment menu (indicated by a check mark √).
- Choose Save or Save as... from the File menu, or click the Function Bar icon, to save your worksheet. When you exit DASYLab, the setting of the Auto Start option is saved with other window settings.
- To use Auto Start, append the file name of the worksheet to the program file name at the command line. DASYLab opens the worksheet and starts the experiment immediately.

4.3.4 Starting a Worksheet from the Windows Desktop

Drag and drop your worksheet files onto the Windows desktop. To automatically start DASYLab by double clicking on the worksheet, you first have to manually create a link from DASYLab to the file type. First, use the Drag & Drop method to place a worksheet file icon on the desktop. Because there is no defined link to any program, double clicking on this icon will open a dialog box. Windows will ask you what program should be used to open that file. Select the: File always open with ... radio button and select the Others... button. Windows will open an Explorer Window that allows you to select a program. Choose the DASYLab installation path and select the DASYLAB.EXE program. Use the Open button to confirm. Leave the dialog box using the OK button. In the future, DASYLab will automatically start when a worksheet icon is double clicked.
If you have installed several copies of DASYLab on your system, the created link connects only to one version of DASYLab from the Windows Program Manager or File Manager.

4.3.5 Starting Control Sequence Files from the Windows desktop

Using Windows 98 or 2000/NT you can place your Control Sequence files with Drag&Drop onto the Windows desktop. To automatically start DASYLab by double clicking on the Control Sequence file, you first have to manually create a link from DASYLab to the file type. First, use the Drag & Drop method to place a Control Sequence file icon on the desktop. Because there is no defined link to any program, double clicking on this icon will open a dialog box. Windows will ask you what program should be used to open that file. Select the: File always open with... radio button and select the Others... button.

Windows will open an Explorer Window, which allows you to select a program. Choose the DASYLab installation path and select the DASYLab.EXE program. Use the Open button to confirm. Leave the dialog box using the OK button. In the future, DASYLab will automatically start when a worksheet icon is double clicked.

If you have installed several copies of DASYLab on your system, the created link connects only to one version of DASYLab.

4.3.6 Tips for starting worksheets/control sequences if you have more than one DASYLab version on the same computer

If there are several versions (e.g. German and English versions) installed on your system, you can create links to worksheets for each version. Because DASYLab doesn’t use the extension to identify the worksheet file you can rename the worksheets of each version to a special extension (e.g. English worksheets with *.ews). Now you can create a new link in Windows as previously described, and each worksheet will start with the corresponding DASYLab version when you double click on the file. You have to pay attention to previously used extensions, so that you don’t affect other installed software.

4.3.7 Various Application Icons or Batch Files

You can customize the start-up modes described above.

Batch Files

Create a batch file containing the command line described above, including the worksheet file name and save it with a descriptive file name. Set up several batch files, each with an experiment setup.

Any experiment can be then started by typing the corresponding batch file name.
**Application Icons in Windows Program Manager**

Add a new option to the DASYLab application icon displayed in the Windows Program Manager, or create a special icon for an experiment in your DASYLab program group in the Windows Program Manager.

- To keep the current program startup option without a worksheet, copy the DASYLab icon first. Select it, press the F8 function key, or choose Copy from the Program Manager File menu.
- Select the copied DASYLab icon with one mouse click, and press the ALT+ENTER keys, or, choose Properties from the File menu.
- Type the complete worksheet file name including its drive, directory, and extension after the DASYLab command in the Command Line box.

For example: C:\DLAB\DASYLAB.EXE D:\FLCS\FLC1.DSB where FLCS is the directory on drive D: where your worksheet files are saved, and FLC1.DSB is the experiment setup file which is to be automatically started.

- In the Description box, type a description that identifies the worksheet.
- Press ENTER.

Any experiment can be started directly by clicking on the corresponding Program Manager icon.

### 4.3.8 Starting an Experiment at the same time as Windows

Copy one of the experiment icons to the Windows Program Manager AUTOSTART group to start the experiment when Windows is started.

### 4.3.9 Starting an Experiment when your Computer System Restarts

Add the Windows command to the AUTOEXEC.BAT file and the experiment will start when you start your computer system.

## 5. Exchanging Worksheets

### Between Computers

If you have to exchange worksheets between several PCs (for example, when setting up runtime applications), you must guarantee that the selection and sequence of measurement hardware (Experiment: Hardware Setup) in the source DASYLab are exactly the same as in your target PC. If not, there may be problems with hardware specific modules. This is usually only a problem when using more than one DAQ board (multifunctional drivers) or boards with extension boards. The hardware configuration specified in the hardware setup is stored as a list of indices in the worksheet without a board-specific indication. The result of a different sequence is an incorrect setup of hardware modules.

Similarly, the hardware settings, including the base address and/or channel of the single components have to be identical.
The following picture shows parts of the hardware setup of different PCs with the same set of measurement hardware but with a different setup sequence, which causes incorrect hardware assignment.

Between Versions Of The Software
DASYLab worksheet files, *.DSB, are forward compatible with newer versions of the software. Generally, however, a worksheet created with a newer version, such as V6.0, cannot be read by an earlier version, V5.0. This may also be the case between minor revisions, such as V5.00 and V5.02, where the former, due to incompatible changes in the worksheet binary format, cannot read a worksheet created by the latter.

To read a worksheet file with an earlier version, save the file as the worksheet ASCII format (.DSA). You may have to reconfigure some modules, but the older DASYLab is more likely to be able to read the ASCII format worksheet.

From 16-bit version to 32-bit Version
Use the ASCII worksheet format (.DSA) to exchange files between the 16-bit V5.0 and 32-bit Version 5.0 and later.

6. Display Company Logo

The DASYLab logo appears in the Copyright Information dialog box (About DASYLab from the Help menu). You can display your company logo by creating the logo as a Windows Metafile (*.WMF). Copy that file to the DASYLab directory as LOGO.WMF. The next time you start DASYLab, your logo will be displayed in the Copyright Information window. It may be necessary to fine-tune the size and proportions of the picture.
Appendices

A: What’s Included in Your DASYLab Package

The DASYLab package consists of the following parts:

- CD-ROM with the installation files for the DASYLab program files, the setup program files, and the driver files for data acquisition devices
- This printed User Guide and the Module Reference Guide
- Optionally, the Hardware Installation Manual that provides information about the drivers for the data acquisition devices. If you did not receive a Hardware Installation Manual, refer to the Online Help for your driver that was installed in the program group during installation.
- Optionally, the DAP Power DLL Manual, which describes features specific to the optional DAP Power DLL.
- Registration card, license, and miscellaneous enclosures
B: Internal Data Flow and Precision Information

Data values are represented in DASYLab as single precision floating point values. All calculations except the FFT are carried out in double precision (8 Byte floating point).

**Single Precision Format**

<table>
<thead>
<tr>
<th>Data Format:</th>
<th>32 Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1 Bit sign</td>
</tr>
<tr>
<td></td>
<td>8 Bit exponent</td>
</tr>
<tr>
<td></td>
<td>23 Bit mantissa</td>
</tr>
<tr>
<td>Range:</td>
<td>3.4E-38 to 3.4E+38</td>
</tr>
<tr>
<td>Accuracy:</td>
<td>at least 7 decimals</td>
</tr>
</tbody>
</table>

**Double Precision Format**

<table>
<thead>
<tr>
<th>Data Format:</th>
<th>64 Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1 Bit sign</td>
</tr>
<tr>
<td></td>
<td>11 Bit exponent</td>
</tr>
<tr>
<td></td>
<td>52 Bit mantissa</td>
</tr>
<tr>
<td>Range:</td>
<td>1.7E-308 to 1.7E+308</td>
</tr>
<tr>
<td>Accuracy:</td>
<td>at least 15 decimals</td>
</tr>
</tbody>
</table>
# C: ASCII Table

## Control Characters (not printable)

<table>
<thead>
<tr>
<th>Decimal</th>
<th>Octal</th>
<th>Hex</th>
<th>Characters</th>
<th>Code</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>000</td>
<td>0x00</td>
<td>Ctrl-@</td>
<td>NUL</td>
<td>Null prompt</td>
</tr>
<tr>
<td>1</td>
<td>001</td>
<td>0x01</td>
<td>Ctrl-A</td>
<td>SOH</td>
<td>Start of heading</td>
</tr>
<tr>
<td>2</td>
<td>002</td>
<td>0x02</td>
<td>Ctrl-B</td>
<td>STX</td>
<td>Start of text</td>
</tr>
<tr>
<td>3</td>
<td>003</td>
<td>0x03</td>
<td>Ctrl-C</td>
<td>ETX</td>
<td>End of Text</td>
</tr>
<tr>
<td>4</td>
<td>004</td>
<td>0x04</td>
<td>Ctrl-D</td>
<td>EOT</td>
<td>End of transmission</td>
</tr>
<tr>
<td>5</td>
<td>005</td>
<td>0x05</td>
<td>Ctrl-E</td>
<td>ENQ</td>
<td>Enquiry</td>
</tr>
<tr>
<td>6</td>
<td>006</td>
<td>0x06</td>
<td>Ctrl-F</td>
<td>ACK</td>
<td>Acknowledge</td>
</tr>
<tr>
<td>7</td>
<td>007</td>
<td>0x07</td>
<td>Ctrl-G</td>
<td>BEL</td>
<td>Bell</td>
</tr>
<tr>
<td>8</td>
<td>010</td>
<td>0x08</td>
<td>Ctrl-H</td>
<td>BS</td>
<td>Backspace</td>
</tr>
<tr>
<td>9</td>
<td>011</td>
<td>0x09</td>
<td>Ctrl-I</td>
<td>HT</td>
<td>Horizontal tab</td>
</tr>
<tr>
<td>10</td>
<td>012</td>
<td>0x0A</td>
<td>Ctrl-J</td>
<td>LF</td>
<td>Line feed</td>
</tr>
<tr>
<td>11</td>
<td>013</td>
<td>0x0B</td>
<td>Ctrl-K</td>
<td>VT</td>
<td>Vertical tab</td>
</tr>
<tr>
<td>12</td>
<td>014</td>
<td>0x0C</td>
<td>Ctrl-L</td>
<td>FF</td>
<td>Form feed</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>NP</td>
<td>New page</td>
</tr>
<tr>
<td>13</td>
<td>015</td>
<td>0x0D</td>
<td>Ctrl-M</td>
<td>CR</td>
<td>Carriage return</td>
</tr>
<tr>
<td>14</td>
<td>016</td>
<td>0x0E</td>
<td>Ctrl-N</td>
<td>SO</td>
<td>Shift out</td>
</tr>
<tr>
<td>15</td>
<td>017</td>
<td>0x0F</td>
<td>Ctrl-O</td>
<td>SI</td>
<td>Shift in</td>
</tr>
<tr>
<td>16</td>
<td>020</td>
<td>0x10</td>
<td>Ctrl-P</td>
<td>DLE</td>
<td>Data link escape</td>
</tr>
<tr>
<td>17</td>
<td>021</td>
<td>0x11</td>
<td>Ctrl-Q</td>
<td>DC1</td>
<td>X-ON</td>
</tr>
<tr>
<td>18</td>
<td>022</td>
<td>0x12</td>
<td>Ctrl-R</td>
<td>DC2</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>023</td>
<td>0x13</td>
<td>Ctrl-S</td>
<td>DC3</td>
<td>X-Off</td>
</tr>
<tr>
<td>20</td>
<td>024</td>
<td>0x14</td>
<td>Ctrl-T</td>
<td>DC4</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>025</td>
<td>0x15</td>
<td>Ctrl-U</td>
<td>NAK</td>
<td>Not acknowledged</td>
</tr>
<tr>
<td>22</td>
<td>026</td>
<td>0x16</td>
<td>Ctrl-V</td>
<td>SYN</td>
<td>Synchronous idle</td>
</tr>
<tr>
<td>23</td>
<td>027</td>
<td>0x17</td>
<td>Ctrl-W</td>
<td>ETB</td>
<td>End transmission blocks</td>
</tr>
<tr>
<td>24</td>
<td>030</td>
<td>0x18</td>
<td>Ctrl-X</td>
<td>CAN</td>
<td>Cancel</td>
</tr>
<tr>
<td>25</td>
<td>031</td>
<td>0x19</td>
<td>Ctrl-Y</td>
<td>EM</td>
<td>End of medium</td>
</tr>
<tr>
<td>26</td>
<td>032</td>
<td>0x1A</td>
<td>Ctrl-Z</td>
<td>SUB</td>
<td>Substitute</td>
</tr>
<tr>
<td>27</td>
<td>033</td>
<td>0x1B</td>
<td>Ctrl-[</td>
<td>ESC</td>
<td>Escape</td>
</tr>
<tr>
<td>28</td>
<td>034</td>
<td>0x1C</td>
<td>Ctrl-\</td>
<td>FS</td>
<td>File separator</td>
</tr>
<tr>
<td>29</td>
<td>035</td>
<td>0x1D</td>
<td>Ctrl-]</td>
<td>GS</td>
<td>Group separator</td>
</tr>
<tr>
<td>30</td>
<td>036</td>
<td>0x1E</td>
<td>Ctrl-^</td>
<td>RS</td>
<td>Record separator</td>
</tr>
<tr>
<td>31</td>
<td>027</td>
<td>0x1F</td>
<td>Ctrl_-</td>
<td>US</td>
<td>Unit separator</td>
</tr>
<tr>
<td>127</td>
<td>0177</td>
<td>0x7F</td>
<td></td>
<td>DEL</td>
<td>Delete or rubout</td>
</tr>
</tbody>
</table>
### Printable Characters:

<table>
<thead>
<tr>
<th>Decimal</th>
<th>Character</th>
<th>Decimal</th>
<th>Character</th>
<th>Decimal</th>
<th>Character</th>
<th>Decimal</th>
<th>Character</th>
</tr>
</thead>
<tbody>
<tr>
<td>32:</td>
<td>!</td>
<td>33:</td>
<td>!</td>
<td>34:</td>
<td>&quot;</td>
<td>35:</td>
<td>#</td>
</tr>
<tr>
<td>36:</td>
<td>$</td>
<td>37:</td>
<td>%</td>
<td>38:</td>
<td>&amp;</td>
<td>39:</td>
<td>'</td>
</tr>
<tr>
<td>40:</td>
<td>(</td>
<td>41:</td>
<td>)</td>
<td>42:</td>
<td>*</td>
<td>43:</td>
<td>+</td>
</tr>
<tr>
<td>44:</td>
<td>,</td>
<td>45:</td>
<td>-</td>
<td>46:</td>
<td>.</td>
<td>47:</td>
<td>/</td>
</tr>
<tr>
<td>48:</td>
<td>0</td>
<td>49:</td>
<td>1</td>
<td>50:</td>
<td>2</td>
<td>51:</td>
<td>3</td>
</tr>
<tr>
<td>52:</td>
<td>4</td>
<td>53:</td>
<td>5</td>
<td>54:</td>
<td>6</td>
<td>55:</td>
<td>7</td>
</tr>
<tr>
<td>56:</td>
<td>8</td>
<td>57:</td>
<td>9</td>
<td>58:</td>
<td>;</td>
<td>59:</td>
<td>;</td>
</tr>
<tr>
<td>60:</td>
<td>&lt;</td>
<td>61:</td>
<td>=</td>
<td>62:</td>
<td>&gt;</td>
<td>63:</td>
<td>?</td>
</tr>
<tr>
<td>64:</td>
<td>@</td>
<td>65:</td>
<td>A</td>
<td>66:</td>
<td>B</td>
<td>67:</td>
<td>C</td>
</tr>
<tr>
<td>68:</td>
<td>D</td>
<td>69:</td>
<td>E</td>
<td>70:</td>
<td>F</td>
<td>71:</td>
<td>G</td>
</tr>
<tr>
<td>72:</td>
<td>H</td>
<td>73:</td>
<td>I</td>
<td>74:</td>
<td>J</td>
<td>75:</td>
<td>K</td>
</tr>
<tr>
<td>76:</td>
<td>L</td>
<td>77:</td>
<td>M</td>
<td>78:</td>
<td>N</td>
<td>79:</td>
<td>O</td>
</tr>
<tr>
<td>80:</td>
<td>P</td>
<td>81:</td>
<td>Q</td>
<td>82:</td>
<td>R</td>
<td>83:</td>
<td>S</td>
</tr>
<tr>
<td>84:</td>
<td>T</td>
<td>85:</td>
<td>U</td>
<td>86:</td>
<td>V</td>
<td>87:</td>
<td>W</td>
</tr>
<tr>
<td>88:</td>
<td>X</td>
<td>89:</td>
<td>Y</td>
<td>90:</td>
<td>Z</td>
<td>91:</td>
<td>[</td>
</tr>
<tr>
<td>92:</td>
<td>\</td>
<td>93:</td>
<td>]</td>
<td>94:</td>
<td>^</td>
<td>95:</td>
<td>_</td>
</tr>
<tr>
<td>96:</td>
<td>`</td>
<td>97:</td>
<td>a</td>
<td>98:</td>
<td>b</td>
<td>99:</td>
<td>c</td>
</tr>
<tr>
<td>100:</td>
<td>d</td>
<td>101:</td>
<td>e</td>
<td>102:</td>
<td>f</td>
<td>103:</td>
<td>g</td>
</tr>
<tr>
<td>104:</td>
<td>h</td>
<td>105:</td>
<td>i</td>
<td>106:</td>
<td>j</td>
<td>107:</td>
<td>k</td>
</tr>
<tr>
<td>108:</td>
<td>l</td>
<td>109:</td>
<td>m</td>
<td>110:</td>
<td>n</td>
<td>111:</td>
<td>o</td>
</tr>
<tr>
<td>112:</td>
<td>p</td>
<td>113:</td>
<td>q</td>
<td>114:</td>
<td>r</td>
<td>115:</td>
<td>s</td>
</tr>
<tr>
<td>116:</td>
<td>t</td>
<td>117:</td>
<td>u</td>
<td>118:</td>
<td>v</td>
<td>119:</td>
<td>w</td>
</tr>
<tr>
<td>120:</td>
<td>x</td>
<td>121:</td>
<td>y</td>
<td>122:</td>
<td>z</td>
<td>123:</td>
<td>{</td>
</tr>
<tr>
<td>124:</td>
<td></td>
<td></td>
<td>125:</td>
<td>}</td>
<td>126:</td>
<td>~</td>
<td>127:</td>
</tr>
<tr>
<td>128:</td>
<td>€</td>
<td>129:</td>
<td>£</td>
<td>130:</td>
<td>,</td>
<td>131:</td>
<td>f</td>
</tr>
<tr>
<td>132:</td>
<td>„</td>
<td>133:</td>
<td>…</td>
<td>134:</td>
<td>†</td>
<td>135:</td>
<td>§</td>
</tr>
<tr>
<td>136:</td>
<td>^</td>
<td>137:</td>
<td>%</td>
<td>138:</td>
<td>Š</td>
<td>139:</td>
<td>Š</td>
</tr>
<tr>
<td>140:</td>
<td>Ĉ</td>
<td>141:</td>
<td>Ê</td>
<td>142:</td>
<td>Ž</td>
<td>143:</td>
<td></td>
</tr>
<tr>
<td>148:</td>
<td>†</td>
<td>149:</td>
<td>•</td>
<td>150:</td>
<td>–</td>
<td>151:</td>
<td>—</td>
</tr>
<tr>
<td>152:</td>
<td>…</td>
<td>153:</td>
<td>™</td>
<td>154:</td>
<td>š</td>
<td>155:</td>
<td>»</td>
</tr>
<tr>
<td>156:</td>
<td>œ</td>
<td>157:</td>
<td>ņ</td>
<td>158:</td>
<td>ž</td>
<td>159:</td>
<td>Ÿ</td>
</tr>
<tr>
<td>160:</td>
<td>□</td>
<td>161:</td>
<td>i</td>
<td>162:</td>
<td>€</td>
<td>163:</td>
<td>£</td>
</tr>
<tr>
<td>164:</td>
<td>○</td>
<td>165:</td>
<td>¥</td>
<td>166:</td>
<td></td>
<td></td>
<td>167:</td>
</tr>
<tr>
<td>172:</td>
<td>°</td>
<td>173:</td>
<td>–</td>
<td>174:</td>
<td>@</td>
<td>175:</td>
<td>–</td>
</tr>
<tr>
<td>176:</td>
<td>′</td>
<td>177:</td>
<td>±</td>
<td>178:</td>
<td>²</td>
<td>179:</td>
<td>³</td>
</tr>
<tr>
<td>180:</td>
<td>′</td>
<td>181:</td>
<td>µ</td>
<td>182:</td>
<td>″</td>
<td>183:</td>
<td>″</td>
</tr>
<tr>
<td>184:</td>
<td>′</td>
<td>185:</td>
<td>′</td>
<td>186:</td>
<td>o</td>
<td>187:</td>
<td>»</td>
</tr>
<tr>
<td>188:</td>
<td>¼</td>
<td>189:</td>
<td>½</td>
<td>190:</td>
<td>¾</td>
<td>191:</td>
<td>†</td>
</tr>
<tr>
<td>Decimal</td>
<td>Character</td>
<td>Decimal</td>
<td>Character</td>
<td>Decimal</td>
<td>Character</td>
<td>Decimal</td>
<td>Character</td>
</tr>
<tr>
<td>---------</td>
<td>-----------</td>
<td>---------</td>
<td>-----------</td>
<td>---------</td>
<td>-----------</td>
<td>---------</td>
<td>-----------</td>
</tr>
<tr>
<td>196:</td>
<td>Ä</td>
<td>197:</td>
<td>Å</td>
<td>198:</td>
<td>Æ</td>
<td>199:</td>
<td>Ç</td>
</tr>
<tr>
<td>200:</td>
<td>È</td>
<td>201:</td>
<td>É</td>
<td>202:</td>
<td>Ê</td>
<td>203:</td>
<td>Ê</td>
</tr>
<tr>
<td>204:</td>
<td>Ì</td>
<td>205:</td>
<td>Í</td>
<td>206:</td>
<td>Ì</td>
<td>207:</td>
<td>Ï</td>
</tr>
<tr>
<td>208:</td>
<td>Ð</td>
<td>209:</td>
<td>Ñ</td>
<td>210:</td>
<td>Ò</td>
<td>211:</td>
<td>Ó</td>
</tr>
<tr>
<td>212:</td>
<td>Ò</td>
<td>213:</td>
<td>Ô</td>
<td>214:</td>
<td>Õ</td>
<td>215:</td>
<td>×</td>
</tr>
<tr>
<td>216:</td>
<td>Ø</td>
<td>217:</td>
<td>Ù</td>
<td>218:</td>
<td>Ú</td>
<td>219:</td>
<td>Û</td>
</tr>
<tr>
<td>220:</td>
<td>Ü</td>
<td>221:</td>
<td>Ý</td>
<td>222:</td>
<td>Þ</td>
<td>223:</td>
<td>ß</td>
</tr>
<tr>
<td>224:</td>
<td>à</td>
<td>225:</td>
<td>á</td>
<td>226:</td>
<td>â</td>
<td>227:</td>
<td>ã</td>
</tr>
<tr>
<td>228:</td>
<td>ä</td>
<td>229:</td>
<td>å</td>
<td>230:</td>
<td>æ</td>
<td>231:</td>
<td>ç</td>
</tr>
<tr>
<td>232:</td>
<td>è</td>
<td>233:</td>
<td>é</td>
<td>234:</td>
<td>ê</td>
<td>235:</td>
<td>ë</td>
</tr>
<tr>
<td>236:</td>
<td>ì</td>
<td>237:</td>
<td>í</td>
<td>238:</td>
<td>î</td>
<td>239:</td>
<td>ï</td>
</tr>
<tr>
<td>244:</td>
<td>ô</td>
<td>245:</td>
<td>ô</td>
<td>246:</td>
<td>ö</td>
<td>247:</td>
<td>÷</td>
</tr>
<tr>
<td>248:</td>
<td>ø</td>
<td>249:</td>
<td>ù</td>
<td>250:</td>
<td>ú</td>
<td>251:</td>
<td>û</td>
</tr>
<tr>
<td>252:</td>
<td>ü</td>
<td>253:</td>
<td>ý</td>
<td>254:</td>
<td>þ</td>
<td>255:</td>
<td>ÿ</td>
</tr>
</tbody>
</table>
D: Error Messages and Troubleshooting

The following error messages may be encountered while using DASYLab.

**Analog output had to be interrupted**
- **Cause**: the D/A buffer is empty, DASYLab could not generate data to be sent by the D/A module fast enough
- **Correction**: reduce the output rate, or increase the output buffer size

**Cannot create DDE Link**
- **Cause**: the specified server application is not active or the specified Topic or Theme is not available
- **Correction**: start application and make sure that Topic and Theme are defined

**Cannot execute the worksheet at this module - aborted**
- **Cause**: the worksheet contains a loop that means the output of a module is (indirectly) needed for its input
- **Correction**: insert a time delay module or remove the loop completely

**Cannot open COMx**
- **Cause**: the serial port is used by another application under Windows and is not available for DASYLab
- **Correction**: make sure that the specified COM-port is not used by the mouse or by any other Windows application

**DDE Link was interrupted**
- **Cause**: the DDE Link was interrupted by the Server program
- **Correction**: make sure that the Server program is still running

**Digital output had to be interrupted**
- **Cause**: the digital output buffer is empty, DASYLab could not generate data to be sent by the Digital Out module fast enough
- **Correction**: reduce the output rate, or increase the output buffer size

**Error No 15**
- **Cause**: (and meaning) data acquisition could not be started because a hardware conflict (like interrupts) has been detected. This is a driver error code and you should report this message to technical support for more information. Please be prepared to describe the exact situation in which it occurs.
File read error
Cause the data file you want to read is corrupt or has the wrong file format
Correction check for the correct settings in the dialog box and make sure that the file format is correct

Illegal block size STOP
Cause the FFT related module can only handle block sizes that are a power of 2
Correction use the Data Windows module to change the block size at the FFT input to a power of 2

Output rate does not match the channel rate for one channel. STOP
Output rate does not match the input rate at an input. STOP
Cause these messages indicate that the global acquisition rate is not an integer multiple of the defined output rate. Synchronized output can only be realized in a way that one sample is sent to the D/A Card after a certain number of input samples has been acquired. Therefore the input rate divided by the output rate has to be an integer value. In both cases DASYLab does not use the channel rates, but the summed rates.
Correction adjust the analog or digital output rate

The sample frequency is too high for this module
Cause up to version 1.54 of DASYLab the Chart Recorder was limited to 100Hz per channel. From 1.55 it does not check the rate of input signals.
Correction slow down the input rate by separate or average modules

The sampling rate is too fast. The measurement has been stopped
Cause the speed DASYLab can acquire data from an analog input card is limited. The limits depend on the hardware structure and the computer you use as well as on the worksheet you run. There may be different circumstances causing this message. The most common reason is that the driver buffer in DASYLab had an overrun and that the driver did not know where to store the next samples. In this case the measurement is stopped. Usually the bar in the status line indicates how much of the driver buffer is used, there are some situations where there may be no time to update the indicator. Another possible reason is that the interrupt frequency that is needed to acquire data at the desired rate was too high and that DASYLab noticed that interrupts have been lost. This may be caused by extreme bus activities of
the graphics or hard disk controllers. When this happens, the message also appears without having the buffer status indicator filled.

**Correction:** slow down the sampling rate or increase the driver buffer

**You cannot display signals from these input channels together in one scope**

**Cause:** the Y/t Chart module can only display signals of the same type in one display. The same type means that they are all time dependent, all frequency dependent or all histograms. When the signals are time dependent they have to have the same gap structure, that means that they may have gaps, but all at the same time and of the same length.

**Correction:** use the Signal Adaptation module before the Y/t Chart or use different Y/t Charts for the different types

**You cannot display signals from these input channels together in one X/Y chart**

**Cause:** the X/Y Chart module can only display signals of the same type in one display. The same type means that they are all time dependent, all frequency dependent or all histograms. When the signals are time dependent they have to have the same gap structure, that means that they may have gaps, but all at the same time and of the same length

**Correction:** use the Signal Adaptation module before the X/Y Chart or use different X/Y Charts for the different types
E: Product Support

DASYLab™ is an innovative Windows application that has been developed over a period of several years by a team of committed engineers. To ensure that our software product will meet the changing needs of its users, we will continue to develop DASYLab™. If you fill in the registration form included in this package and send it back to us, you will automatically receive the latest information on any updates of the software.

Information about changes or features that were included after this user guide was printed is covered in the README file on your setup disk. Use Windows “Write” (or a similar word processor) to read this file. Read this file to find out about improvements and about conversions that may be necessary before you can use the latest DASYLab™ version.

If you have any questions, suggestions, or requests regarding the DASYLab™ software and documentation, please contact us – we will be glad to help.

DASYLab™ Support
Tel. +49 - 89 - 741 31 30    FAX +49 - 89 - 714 60 35
email: support@dasylab.de
www.DASYLab.de

NATIONAL INSTRUMENTS SERVICES
Postfach 401264,
D - 41182 Mönchengladbach, Germany
Index

*DSQ........................................ 1-16, 3-12, 3-13
*SIM ........................................ 4-36
*SIS ......................................... 4-36
*SOU........................................ 4-36
16-bit program worksheets .......... 1-14
32-bit version......................... 1-13

Acquisition

Mode...................................... 4-28
Rate................................. 4-26
Action Junction ........................ 3-13

Actions

Changed................................. 1-19
Key Events.............................. 4-50
List.......................................... 4-51
New and changed...................... 1-19
Screen Locking......................... 4-50

Actions Overview..................... 1-17
Active/Passive Partner................. 5-11
additions and changes............... 1-16

Advanced Power Management........ 1-17

Alphabetic Index (Help Index)....... 4-82

Analysis Toolkit ..................... 1-13

Animation.............................. 1-17, 4-38
ASC........................................ 5-4
ASCII Data Format................... 5-4

Auto Start

Experiment Menu............... 4-24
Automatic Experiment/Program Start 6-4

Automation

Key Events................................ 4-50
Autorouter............................ 3-5
Options Menu......................... 4-49
Back to Main Chart (Black Box).... 4-12
Background Color.................... 4-48

Basic .................................................................................. 1-13, 1-16

Black Box

Colors................................. 4-12
Edit Menu............................. 4-10
Info......................................... 4-11
Leave ~................................. 4-12
Save....................................... 4-10
Black Box Levels.................... 4-12
block size............................... 2-5
Block Size

Maximum................................ 4-27
New Feature........................... 4-27
Block Size................................ 4-27
Branches............................... 3-3
Create.................................... 3-5

Delete...................................... 3-7
Rearrange.............................. 3-6
BSI DISC PD-2000-1 .................. ii

Buffer

Driver...................................... 4-27
Calculate Expression............... 4-55
Channel Status......................... 3-4
Channels
differing sampling rates........... 4-26

Channels Names

Copy....................................... 4-65
Client...................................... 4-24, 5-11

Clipboard, Copy to ~

File Info............................... 4-5
Layout.................................... 4-12
Worksheet............................... 4-10
clocking................................. 2-5

CLP........................................... 4-10

Colors

Background............................ 4-48
Black Box............................... 4-12
Data Channels......................... 4-48
Edit Custom ~.......................... 4-48
Grid....................................... 4-48
Options Menu......................... 4-48
Screen Customization................. 3-9
Worksheet............................... 2-2

Command Line........................ 4-24
Comment Flowchart.................. 2-2, 3-13
Company Logo......................... 6-8

Configuration

Function Bar.......................... 3-24
Module Bar............................. 3-22
Module Bar Menu...................... 4-14

Configure

Module................................. 4-19

Continuous

Acquisition Mode..................... 4-28
Control Sequencer................... 3-12
Control Sequencer file ............... 1-16
Control Sequencer View............... 3-13
Control Sequencer Window ....... 1-16, 3-12
Conventions........................... 2-4

Convert 16-bit program worksheets... 1-14

Copy

Channel Names........................ 4-65
File Info to Clipboard............... 4-5
Layout to Clipboard.................. 4-72
Layout Window......................... 2-3
Module ........................................ 2-2
VITool .......................................... 2-3
Worksheet to Clipboard .......... 4-10

Copy/Paste
Layout Window ......................... 4-73
List Actions ............................. 4-51
VITool ....................................... 4-73

Copyright Information ................. 4-44
Create
Data Channels/Branches ............. 3-5
Create Directory ..................... 4-45
Cut
Layout Window ......................... 2-3
Module ........................................ 2-2
VITool ......................................... 2-3

Cut/Paste
Copy Layout .............................. 4-12
Modules ...................................... 4-16
Worksheet parts ....................... 4-16

DASYLab
Data Format ........................................ 5-5
DASYLab Basic .............................. 1-16
DASYLab Full .................................. 1-16
DASYLab LE ..................................... 1-16
DASYLab Versions ..................... 1-13
DASYLab.DML .............................. 4-16
DASYLab.INI .................................. 5-3
DASYLab+ ...................................... 1-16
DASYLab.Net
Client ...................................... 4-24, 5-11
Master/Slave .............................. 5-11
Remote Control ....................... 4-24, 5-11
Server ........................................ 4-24, 5-11
TCP/IP .................................. 5-12

Data Channels
Autorouter .................................. 4-49
Colors ...................................... 4-48
Create ....................................... 3-5
Delete ....................................... 3-7
Rearrange .................................. 3-6

Data format
Disk Streaming .......................... 4-30

Data Format
ASCII ........................................ 5-4
DASYLab ...................................... 5-5
I32 ........................................... 5-4
Universal 0 ................................. 4-30
DBB .......................................... 4-11
DDB ........................................... 5-5
DDE ........................................... 5-13
DDF ........................................... 5-5
Debugging Aids ......................... 3-4
Default
Module Bar .................................. 4-16

Default Directories ..................... 4-46
Data .......................................... 4-46
Devices ..................................... 4-46
Other files ................................. 4-46
Streaming ................................... 4-46
Worksheet ................................. 4-46

Define
Global Strings ......................... 4-54
Global Variables ....................... 4-59

Delete
Data Channels/Branches ............. 3-7
Layout Window ......................... 2-3
Module ........................................ 2-1, 4-19, 4-21
Modules ....................................... 4-17
Output Channels ....................... 2-1
VITool ........................................ 2-3

Window Arrangement ................... 4-43
Delete Input Channels ............... 2-1

Digital Output Setup ................... 4-29

Directories
Default ...................................... 4-46
Data .......................................... 4-46
Devices ..................................... 4-46
Other files ................................. 4-46
Streaming ................................... 4-46
Worksheet ................................. 4-46

Global Strings/Variables ............. 4-64

Disk Streaming ........................... 2-5, 4-30
Data Format .............................. 4-30
Read Data .................................. 4-30

Display
Function Bar ............................... 4-38
Module Bar .................................. 4-39

Display Window
Dialog Box ................................... 3-11
Display Tree ............................... 3-11
Display Window ......................... 3-11
Display Window Icon .................... 3-11
Fixed Arrangements .................... 3-27
Function Bar ............................... 3-11
Hide ~ ..................................... 4-40
Make Visible ~ ......................... 4-39
Menu Bar ................................... 3-11
Restore ~ ................................... 4-39
Scroll Bar ................................... 3-11
Status Bar ................................... 3-11
Title Bar ................................... 3-11

Display Windows
Saved Arrangements .................. 3-27
DLL drivers ......................... 4-34
DML ........................................ 4-15, 5-2, 5-3
DMX (File Extension) ................. 5-2

Index-4
documentation ........................................... 3-16
Documentation ........................................ 3-10
List Actions ........................................... 4-51
Documentation Properties ........................ 1-17
DOS Prompt ........................................... 4-24
Dots (Grid) ............................................. 4-44
DPF ..................................................... 5-3
Drawing Elements ..................................... 4-74
Layout Windows ....................................... 3-18
VI Tool ................................................ 3-18
driver .................................................. 1-11
Driver ................................................... 4-34
Driver Buffer .......................................... 4-27
Driver Selection ....................................... 4-24
DSA (File Extension) ................................ 5-1
DSB ..................................................... 4-2, 5-1
Dynamic Data Exchange ............................. see DDE
Edit
~ Menu Commands ................................... 4-9
Custom Colors ......................................... 4-48
Edit Action ............................................... 3-13
Embedding (Black Boxes) ......................... 4-12
Ethernet ................................................ 5-13
Event Driven Actions ................................ 1-17
Event Search ........................................... 1-20
Event-Driven Action
Screen Locking ......................................... 4-50
Events
Key ...................................................... 4-50
Examples
Global Strings .......................................... 4-64
Global Variables ....................................... 4-64
Exit
Black Box .............................................. 4-12
Program ................................................ 4-8
Exit Windows .......................................... 1-17
Experiment
~ Menu Commands ................................... 4-22
Auto Start ............................................. 4-24
Automatic ~ Start .................................. 6-4
Pause .................................................... 4-23
Setup .................................................... 4-25
Acquisition Mode .................................. 4-28
Block Size ............................................ 4-27
Driver Buffer .......................................... 4-27
Sampling Rate ....................................... 4-26
Start ..................................................... 4-22
Start/Stop ............................................. 6-3
Stop ..................................................... 4-22
Expressions ............................................. 4-55
Extended .............................................. 4-55
Extension (File-) .................................... 4-55

VEC ..................................................... 5-10
Extensions
ASC .................................................... 5-4
Black Boxes .......................................... 4-11
DBB ..................................................... 4-11
DDB ..................................................... 5-5
DDF ..................................................... 5-5
DML ..................................................... 4-15, 5-2, 5-3
DPF ..................................................... 5-3
DSB ..................................................... 4-2, 5-1
I32 ..................................................... 5-4
INI ..................................................... 5-3
List Module Bar Files ............................... 4-15
Save Module Bar ..................................... 4-16
Extensions (File~)
DSA ..................................................... 5-1
TXT ..................................................... 5-2
Extensions (File~)
DMX ..................................................... 5-2
External Programs ................................. 4-85
FIFO Status .......................................... 1-17, 3-4
File
~ Menu Commands ................................... 4-1
Default Directories ................................. 4-46
Formats
Initialization ......................................... 5-3
Interpolation ......................................... 5-3
Module Bar ............................................. 5-2, 5-3
Open Module Bars ................................ 4-15
Open Worksheets ................................... 4-2
Reference Points .................................... 5-3
Worksheets .......................................... 5-1
Info ..................................................... 4-5
Open
Module Bar .......................................... 4-15
Worksheet ............................................ 4-2
Files
Default Directories ................................ 4-46
Find Modules ........................................ 4-17
Flow Chart ........................................... see Worksheet
flowchart junction .................................. 3-13
Font Sizes
Global Setting ........................................ 4-47
Format .................................................. see File ~s
Page ~ ................................................ 4-7
Worksheet ............................................ 5-2
Worksheet Files ..................................... 5-1, 5-2
Full ..................................................... 1-16
Full version .......................................... 1-13
Function Bar
Configuration ....................................... 3-24
Display/Remove ..................................... 4-38
Screen Element ...................................... 3-24
Window Arrangements ............................. 3-27
Global block size ........................................... 2-5
Global clocking ............................................ 2-5
Global Sampling rate ........................................ 2-5
Global Sampling Rate ..................................... 4-26
Global Setting
  Font Sizes ............................................. 4-47
Global Strings ............................................. 4-54
  Changed ................................................... 1-19
  Directory Example ....................................... 4-64
  Examples ................................................... 4-64
  Module Use .............................................. 4-37
  System .................................................... 4-37
Global Variables ........................................... 4-59
  Changed ................................................... 1-19
  Directory Example ....................................... 4-64
  Examples ................................................... 4-64
  System Information ..................................... 4-60
  Use in Modules ......................................... 4-60
Graph Object
  Properties .............................................. 4-76
Graphic Card .................................................. 1-12
Grid
  ~ Type .................................................... 4-44
  Color ..................................................... 4-48
Grid Element .................................................. 1-18
Hands-On Guide to DASYLab ................................ 2-2
Hardware
  Requirements .......................................... 1-9
Hardware Setup ............................................. 4-25
Hide
  ~ Display Window ....................................... 4-40
  ~ Display Windows ..................................... 4-40
HTML .......................................................... 1-17
HyperText Markup Language .................................. 1-17
.Remote ....................................................... 5-4
Index
  Help Menu ................................................... 4-82
Information
  Black Box ............................................... 4-11
  File ~ ...................................................... 4-5
.INI .......................................................... 5-3
Input Channels
  Delete ..................................................... 2-1
Install
  Module ...................................................... 4-19
Installation
  Setup ...................................................... 1-10
  System Requirements ...................................... 1-9
Instruction
  First Worksheet .......................................... 2-5
  Help Index Option ....................................... 4-82
Interpolation
  File Format .............................................. 5-3

Isolated Series
  Acquisition Mode ......................................... 4-28
  junction .................................................... 3-12
  Junction Points ......................................... 3-3
  Rearrange ................................................. 3-6
  Key events ............................................... 1-18
  Key Events ................................................. 4-50
  Keyboard .................................................... 3-3
  Screen Locking .......................................... 4-50
  Keyboard Operations .................................... 6-1
Layout Object
  Properties ................................................. 2-3
  Layout page .............................................. 4-81
  Layout Window ......................................... 3-17
    Bitmap Objects ........................................ 3-16
    Copy ..................................................... 2-3
    Cut ....................................................... 2-3
    Delete ................................................... 2-3
    Display Objects ....................................... 3-16
    Drawing Object ....................................... 3-16
    Function Bar .......................................... 3-16
    Menu Bar ............................................... 3-16
    Text Objects .......................................... 3-16
    Title Bar ............................................... 3-16
    ToolBox ............................................... 3-16
    View ...................................................... 4-79
    Visualization Objects ................................ 3-16
    Zoom ...................................................... 4-79
Layout Windows
  Active Elements ......................................... 3-19
  Bitmapped Graphics properties 4-74
  Copy ......................................................... 4-72
  Copy Layout to Clipboard 4-12
  Copy/Paste ............................................... 4-73
  Delete ..................................................... 4-73
  Drawing Elements ....................................... 3-18, 4-74
  Linked Graph Properties 4-76
  Linked Text Properties .................................. 4-75
  Load ......................................................... 4-73
  Load from file ........................................... 4-13
  New Layout ................................................. 3-17
  Page Properties ......................................... 4-81
  Passive Properties ...................................... 3-18
  Properties ................................................. 3-17
  Save ......................................................... 4-73
  Save to file ................................................. 4-13
  Text Block ............................................... 4-76
  Text Elements ............................................ 3-18
  Text Grid ................................................. 4-76
  Text Line ................................................. 4-76
  Toolbox ..................................................... 3-20
  Visualization ............................................. 4-75
Index

Module ................................. 4-19
Passive Partner .................... 5-11
Password ................................. 4-49
~ Protection ......................... 4-49
Password Protection  ............................... 4-49
Black Boxes .................................. 4-16
Paste ........................................... 4-16
Worksheet ................................... 4-2
Worksheet Parts .................. 4-16
Pause ........................................... 4-16
Experiment .............................. 4-23
PC Clock ....................................... 4-34
PC Hardware Configuration ...... 1-12
Plus ............................................. 1-16
Power Management ............... 1-12
Preceding Level (Black Box) ....... 4-12
Precision .................................... B-1
Print ........................................... 4-51
List Actions ............................. 4-51
Page Format ......................... 4-7
Viewport ................................... 4-7
Worksheet ................................... 4-6
Printer Setup ............................... 4-6
Processing Cycle ...................... 4-27
Program Automation  KEY EVENTS ............................... 4-50
Program Item Properties ........... 4-24
Program Operation Fundamentals .... 2-1
Properties  Bitmapped Graphics ........ 4-74
Layout Object .................................. 2-3
Layout Objects  ......................... 4-74
Layout Window ....................... 4-79
Module ....................................... 2-2
VITool Objects  ......................... 4-74
Worksheet ................................... 2-2
Protocol TCP/IP .............................. 5-12
Quit ............................................. 4-8 see Exit
RAM ............................................. 1-9
Read ............................................. 4-30 see Open
Read Data  Disk Streaming ........... 4-30
README file .................................. 2-2, 1-16
Rearrange Data Channels ...... 3-6
Reference Points  File Format ............. 5-3
References (Help Index option) .... 4-30
Remote Control ..................... 4-24, 5-12
Remove Display Window ........... 4-40
Display Windows .................. 4-40
Function Bar ......................... 4-38
Module Bar  ....................... 4-39
Requirements Memory ...................... 1-9
Reset Message ....................... 1-19
Resource Conflicts .................. 1-12
Response Time ......................... 4-32
Restart after Edge .................... 1-20
Restart after Time ..................... 4-23
Restore Display Windows ........... 4-39
Right Mouse Button ............... 2-1
Risky Applications ............... iii
Running Series Acquisition Mode .... 4-28
Runtime ....................................... 1-18
S/B ratio ....................................... 4-33
Sampling rate ......................... 2-5
Sampling Rate ............................. 4-31
differing ~ s ........... 4-26
Sampling Rate  sampling rate/block size ratio .... 4-32
Save Black Box ......................... 4-10
Module Bar  ....................... 4-16
Window Arrangement .......... 4-41
Worksheet ................................... 4-3
Save As Module Bar ..................... 4-16
Worksheet ................................... 4-4
Save Data Disk Streaming ........... 4-30
Save worksheet as HTML ........... 1-17
Screen Customization .................... 3-9
Screen Locking ......................... 4-50
Search for Modules .................. 4-17
Security Black Box Passwords .......... 4-49
Editing Passwords .................... 4-49
Screen Locking ......................... 4-50
Worksheet Passwords .............. 4-49
Select Window Arrangement ........ 4-42
self-paced tutorial .................. 2-2
Sequencer  ......................... 3-12
Sequencer Comment .................. 3-15
Serial Devices ......................... 1-21, 4-35
serial number ......................... 1-11
Server ................................. 4-24, 5-11
Set String .............................. 1-19

Index-8
Set Variable........................................ 1-19
Setup
  Analog Output.......................... 4-29
  Digital Output.......................... 4-29
  Disk Streaming.......................... 4-30
  Experiment ~......................... 4-25
  Hardware ~.............................. 4-25
  Output Buffer.......................... 4-29
  Output Rate............................. 4-29
  Output Start............................ 4-29
  Printer ~................................ 4-6
Setup Serial Devices........................ 1-21
Show
  Copyright Information ............ 4-44
  Show Display Windows..............  4-39
  Show File Information............... 4-45
  Signal Analysis Toolkit............ 1-16
  Slave .................................. 5-11
  Sockets ................................ 5-12
  Spacing ................................ 4-44
Start
  Automatic Experiment/Program Start ...... 6-4
  Experiment ......................... 4-22, 6-3
    at Time ................................ 4-23
  Auto Start ............................ 4-24
    Restart after Time ............... 4-23
Start Options .......................... 4-44
  Start/Stop ................................ 5-12
  StartUp
    From Windows ......................... 2-4
  Status Bar............................  2-3, 3-4, 3-26
    step-by-step guide .................. 2-2
Stop
  Experiment ......................... 4-22, 4-25, 6-3
    after Time ......................... 4-23
  Streaming................................ 2-5
Strings
  Examples.............................. 4-64
  New and changed.................... 1-19
System Information
  Global Strings....................... 4-57
  Global Variables.................... 4-60
  System Requirements................ 1-9
  TCP/IP................................. 5-12
Text
  Block .................................. 4-76
  Elements .................................. 4-76
  Grid .................................. 4-76
Text Areas............................. 1-17
Text Block
  Layout Object ......................... 4-77
text boxes ................................ 3-10
Text Elements
  Layout Windows......................... 3-18
  VITool .................................. 3-18
Text Line
  Layout Object .......................... 4-77
Text Object
  Properties ................................ 4-75
Text Objects
  Strings and Variables ............. 4-78
Time
  Restart after ~ ..................... 4-23
  Start at ~ .............................. 4-23
  Stop after ~ ........................... 4-23
Time Base Setup........................ 1-17, 2-5
  Time Bases............................. 1-17, 2-5, 4-34, 4-35
    time format ......................... 1-20
  Time Zone .............................. 1-12
  Title Bar .................................. 3-20
    tutorial ............................... 2-2
  Tutorial ............................... 2-5
    see Instruction
    TXT (File Extension)................ 5-2
Undo........................................ 4-16, 4-73
Universal 0
  Data Format............................. 4-30
Variables
  Examples................................ 4-64
  New and changed.................... 1-19
  VEC (File-Extension)................. 5-10
Vector-File
  Data format ............................ 5-10
  View Menu ................................ 4-79
  View Menu Commands.................. 4-37
  Viewport.................................. 4-7
    virtual device driver .............. 1-11
Visualization
  Layout Window ......................... 4-75
Visualization Elements
  Layout Windows......................... 3-18
  VITool .................................. 3-18
VITool
  Active Elements....................... 3-19
  Bitmaped Graphics properties ...... 4-74
  Copy ..................................... 2-3
  Copy Layout to Clipboard .......... 4-12
  Copy to Clipboard .................. 4-72
  Copy/Paste.................. 2-3, 4-73
  Delete................................. 2-3, 4-73
Drawing Elements ............... 3-18, 4-74
  Layout Window ......................... 3-16, 3-17
  Layout Window Properties ........ 3-17
  Linked Graph Properties .......... 4-76
Linked Text Properties ............. 4-75
Load Layout Window from File 4-73
Load Layout Windows ............ 4-13
Menus ........................................ 4-72
New Layout .............................. 3-17
Page Properties .................... 4-81
Passive Elements .................. 3-18
Save Layout Window .......... 4-13
Save Layout Window to File 4-73
Text Block......................... 4-76
Text Elements ....................... 3-18
Text Grid................................. 4-76
Text Line................................. 4-76
Toolbox ..................................... 3-20
Undo .......................................... 4-73
Visualization ......................... 4-75
Visualization Elements .......... 3-18
Window Arrangement ............ 3-27
Delete ................................. 4-43
Save ............................................ 4-41
Select ........................................ 4-42
Window Menu .......................... 4-66
Window Setup ........................ 4-44
WINSOCK............................... 5-12
WMF/CLP ............................... 4-10
Work Area
    Layout Window ............... 3-17
    Worksheet Window ............ 3-8

Worksheet
    Open ......................................... 4-2

Worksheet
    Colors .................................... 2-2
    Element .................................... 3-1
    File Format ................................ 5-1
    Modules .................................... 3-1
    Print ........................................ 4-6
    Properties ................................ 2-2
    Save ........................................ 4-3
    Save As .................................... 4-4
    Symbols .................................... 3-2

Worksheet Documentation .... 3-10
worksheet settings ........... 2-2
Worksheet to Clipboard .... 4-10

Worksheet Window
    Dialog Box ............................ 3-8
    Display Window Icon ............... 3-8
    Function Bar ................................ 3-8
    Menu Bar ................................ 3-8
    Module Bar ................................ 3-8
    Scroll Bar ................................ 3-8
    Status Bar ................................ 3-8
    Title Bar ................................ 3-8
    Work Area ................................ 3-8
    Worksheet Window .................. 3-8

Year 2000 Compliance ........... ii
*.DSB ..................................... 4-46
Notes: